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About This Manual

This manual is a guide to HDevelop — the graphical user interface for HALCON. HDevelop
facilitates rapid prototyping by offering a highly interactive programming environment for de-
signing and testing image analysis programs. Together with the HALCON library, it is a so-
phisticated image analysis package suitable for product development, research, and education.
HALCON provides operators covering a wide range of applications: Factory automation, qual-
ity control, remote sensing, aerial image interpretation, medical image analysis, and surveil-
lance tasks.

This manual provides all necessary information to understand HDevelop’s basic philosophy and
to use HDevelop.

This manual is intended for all new users of HALCON. It does not assume that you are an
expert in image processing. Regardless of your skills, it is quite easy to work with HDevelop.
Nevertheless, it is helpful to have an idea about the functionalityrabhical user interfaces
(GUI)}, and about some basic image processing aspects.

The manual is divided into the following chapters:

e Introducing HDevelop
This chapter explains the basic concepts of HDevelop and contains a first example that
illustrates how to work with HDevelop.

e Graphical User Interface
This chapter explains the graphical user interface of HDevelop and how to interact with it.

e Language
This chapter explains syntax and semantics of the language used in HDevelop programs.

e Code Generation
This chapter explains the export of a HDevelop program to C, C++, or Visual Basic.

e Program Examples
This chapter contains example programs for typical image processing tasks.

e Miscellaneous
This chapter explains how to start HDevelop and describes keycodes, warning and error
windows, and restrictions.

1Consult your platform’s documentation for general information.



Release Notes

Please note the latest updates of this manual:

e Edition 5b, HALCON 6.0.4 (August 2003)
The manual now also describes the new internal operator break and contains more infor-
mation about the function number and octal/hexadecimal numbers.

e Edition 5a, HALCON 6.0.3 (August 2002)
The manual now describes how to find operators and search and replace variable names
via the menu itemBdit > Find Operator andEdit > Replace Variables, respec-
tively. Furthermore, it shows how to print HDevelop programs, and how to access cus-
tomized software news about the HALCON version that is installed on the user’s com-
puter.

e Edition 5, HALCON 6.0 (October 2000)
The chapter describingode Generatiomas been extended by a section on the export to
C. The structure of the manual has been revised.

e Edition 4, HALCON 5.2 (January 1999)
The manual now also describes the newly introduced keyboard shortcuts, the new
menu entriesFile > Insert and File > Modules, the new menuExecute, and
the new tools for real-time zooming of graphics window contefitss¢alization >
Zooming), for visualizing the gray value histogram of an image and selecting thresholds
(Visualization > Gray Histogram Info), and for shape and gray value features of
regions Visualization > Region Info). Furthermore, it shows how to find the op-
timum parameters of an operator even more quickly using the new bugtary in the
operator window.

e Edition 3, HALCON 5.1 (March 1998)
The chapters ‘About this Manual’, ‘Graphical User Interface’, and ‘Code Generation for
C++’ have been revised. The mefptions has been extended. A visualization of
a frame grabber handle with automatic online grabbing (double click insideable
Window has been introduced. Online inspection of gray values and basic image features
has been introduced in the meWkualization > Image Info....

e Edition 2 (November 1997)
The menwisualization > Set Parameters... has been extended and the descrip-
tion has been revised.
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Chapter 1

Introducing HDevelop

In fact, HDevelop is more than a graphical user interface to HALCON: It is a highly interactive
programming environment for the development of image analysis applications.

There are three basic ways to develop image analysis applications using HDevelop:

e Rapid prototyping in the interactive environment HDevelop.

You can use HDevelop to find the optimal operators or parameters to solve your image
analysis task, and then build the application using the programming languages C, C++, or

COM (Visual Basic).

e Development of an application that runs within HDevelop.

Using HDevelop, you can also develop a complete image analysis application and run it

within the HDevelop environment.

e Export of an application as C, €, or COM source code.

Finally, you can export an application developed in HDevelop as C, C++, or COM source
code. This program can then be compiled and linked with the HALCON library so that it
runs as a stand-alone (console) application. Of course, you can also extend the generated
code or integrate it into existing software.

Let's start with some facts describing the main characteristics of HDevelop, followed by an

example session in sectidn2

1.1 Facts about HDevelop

While developing programs, HDevelop actively supports the user in different ways:

O With the graphical user interface of HDevelop operators and iconic objects can be di-
rectly selected, analyzed, and changed within one environment.

O HDevelop suggests operators for specific tasks. In addition, a thematically structured
operator list helps you to find an appropriate operator quickly.

O An integrated online help contains information about each HALCON operator, such as
a detailed description of the functionality, typical successor and predecessor operators,
complexity of the operator, error handling, and examples of application. The online
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help is based on an internet browser such as Netscape Navigator or Microsoft Internet
Explorer.

O HDevelop comprises a program interpreter with edit and debug functions. It supports
programming features, such as loops and conditions. Parameters can be changed even
while the program is running.

O HDevelopimmediately displays the results of operations. You can try different operators
and/or parameters, and immediately see the effect on the screen. Moreover, you can
preview the results of an operator without changing the program.

O Several graphical tools allow to examine iconic and control data online. For example,
you can extract shape and gray value features by simply clicking onto the objects in the
graphics window, or inspect the histogram of an image interactively and apply real-time
segmentation to select parameters.

O Variables with an automatic garbage collection are used to manage iconic objects or
control values.

1.2 Example Session

To get a first impression how to use HDevelop, you may have a look at the following ex-
ample session. Every important step during the image processing session is explained in de-
tail. Thus, having read this chapter thoroughly, you will understand the main HALCON ideas
and concepts. Furthermore, you will learn the main aspects of HDevelop’s graphical user in-
terface (for more details see chap®r A simple introduction can be found the in manual
Getting Started with HALCON as well.

In this example, the task is to detect circular marks attached to a person’s body in a gray value
image. The program can be found in the file

%HALCONROOT?%\examples\HDevelop\Manuals\HDevelop\marks.dev

You start HDevelop under Windows NT or Windows 2000 by calling
Start > Programs > MVTec HALCON > HDevelop

Under UNIX, HDevelop is started from the shell like any other prodra@ptionally, an appli-
cation name can be specified as a parameter:

hdevelop <File>.dev

This application is then loaded. This is identical to an invocation of HDevelop without any
parameter and a subsequent loading of the application. If you want to run the application im-
mediately after it has been loaded, invoke HDevelop as follows:

hdevelop -run <File>.dev

This is equivalent to starting HDevelop, loading the application, and then premsing the
menu bar of HDevelop.

After starting HDevelop, your first step is to load the imageks.tif from the directory
%HALCONROOT%\images. You may perform this step in three different ways:

1The necessary settings for the operation system are described in the @attirag Started with HALCON .

HDevelop, 2003-08-01
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Figure 1.1: Screen configuration after image loading.

e First, you may specify the operator namad_image in the operator window’s input text
field.

e Secondly, you may select this operator iBperators > File > Images >
read_image.

e The most often used and most convenient way is the third one. Here, you open the image
selection box pressing menu itéhile > Read Image > ... The menwFile > Read
Image contains several predefined directories, one of whickHSL.CONROOT?\ images.
Usually, this directory will beC: \Program Files\MVTec\Halcon\images. Select this
directory by pressing the appropriate menu button. Now you can browse to your target
directory and choose a file name. By clicking the butigpan, a dialog window appears,
in which you may specify a (new) name for the iconic variable which contains the image
you are about to load. The variable will be used later in the program to access this image.

To facilitate the specification process, HDevelop offers you a default variable name, which
is derived from the image’s file name. Pressing the budtotransfers the operator into

the program window and inserts a first program line, similar to the following line, into
your program:

read_image (Marks,’C:\\Program Files\\MVTec\\Halcon\\images\\marks.tif’)

This new program line is executed immediately and the loaded image is displayed in the
active graphics window. Please note the double backslashes, which are necessary since
a single backslash is used to quote special characters (se&g)ada our example we
change the default for the name frofarks to Christof.

Using this selection box, you are able to search images rapidly without knowing their exact file

HALCON 6.0.4



4 CHAPTER 1. INTRODUCING HDEVELOP

names. In contrast to the two other possibilities, the parameters of opesathrimage are
specified automatically. Thus, an explicit input of path and file name is not necessary in this
case. An icon with an appropriate variable name is created in the iconic variable area of the
variable window. Double-clicking on such an icon displays its contents in the currently active
graphics window. Figurd.lshows a complete configuration of HDevelop for the explained
scenario. In addition, a new window is opened — after closing the default window — to display
the image in its original size.

If you look closer at the image in figude1lyou will see the typical temporal offset between two
half images that occurs when taking images with a video camera. This temporal offset is 20 ms
for PAL systems and 16.6 ms for NTSC systems. HALCON offers an algorithm that computes
an interpolated full image from such a video image. The name of the appropriate operator is
fill interlace (see the HALCON Reference Manual). The next step is to specify this name
in the operator window’s operator name field. Ifitis indicated completely, HDevelop shows the
operator immediately in the operator window. Now you have to specify the variable name of
your image. For this you putin the nar@ieristof in the parameter fielimageCamera. To do

so you have two possibilities:

e Direct input via the keyboard.

e Using the combo box that is associated with the parameter text field, you may choose an
appropriate name.

The system’s suggestion for the interpolated imagemisgeFilled. By clicking button0K
you insert this operator into the program and execute it immediately. The computed image is
displayed automatically in the active graphics window.

File  Es ecute Wisuglization Operators  Suggestions  Window  Help
= ENE E R EE E e e e =
B m g

25036256
byte’

768

575

3600

mean_image (0.06s)

Figure 1.2: With the help of the opened combo box you may specify a reasonable filter size for
the operator mean_image.

In the next step you try to separate bright from dark pixels in the image using a threshold-
ing operation. In this case, a segmentation using the simple thresholding op#raiehold

HDevelop, 2003-08-01
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does not result in a satisfying output. Hence you have to use the dynamic thresholding op-
eratordyn_threshold. For execution you need the original image (i.e., the interpolated full
image) and an image to compare (containing the thresholds). You obtain this image by us-
ing the smoothing filter, e.gnean_image. As input image you choose your original image
ImageFilled. After estimating the marks’ size in pixels, you specify a filter size which

is approximately twice the marks’ size (compare the HALCON Reference Manual entry for
dyn_threshold).

To choose the operataean_image, you traverse the menu hierarcyyerators > Filter >
Smoothing > mean_image. It will be displayed in the operator window immediately. Now you
specify the image variable nam@ésageFilled in the text field calledmage and ImageMean

in the output text field. The filter matrix size is chosen by opening the combo boxes of the
corresponding text field¥éskWidth, MaskHeight). These combo boxes contain a selection

of reasonable input values which is offered by HDevelop. In our example the size is set to 29
(see figurel.?).

By clicking the buttonOK you insert the operatatean_image in the program and execute it.
Now you have to search for the name of the dynamic thresholding. For this you specify a
substring that is included in the operator name in the operator window’s operator name text field.
Three letters are already sufficient to produce a result. You will notice the open combo box that
presents all HALCON and/or HDevelop operators containing the first three specified letters.
Now you are able to select the operafigihh threshold and to specify its input parameters.
The valueImageFilled is used forOriginalImage. ImageMean iS used as the component

to compare (her@hresholdImage). For the output paramet@egionDynThresh the variable

name remains unchanged (see figlu®.

File Edt Escoute Visudicalion Operalors Suggestions Window Help
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Type yte’

width: 768
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indowlD: 3600

Kl |

Figure 1.3: The displayed image is the threshold operation result.

Image pixels touching each other and remaining above the given threshold have to be merged
to single regions. The computation of these connected components is realized by operator

HALCON 6.0.4



6 CHAPTER 1. INTRODUCING HDEVELOP

connection (menu itemOperators > Regions > Transformations). The input region
RegionDynThresh is specified in the text fiel#egion. The output variable’s default name
ConnectedRegions IS changed t@onnectedRegionsDynThresh. After the operator’s exe-
cution all resulting regions are stored in this output variable. This shows a great advantage of
HALCON's tuple philosophy: although you have several different results you do not have to
worry how to handle them. This is done transparently by HALCON. HALCON operators rec-
ognize a tuple type variable and process it accordingly. This results in more compact programs
because you may combine several similar operator calls in one operator.

To obtain a better visualization of the results after callitagnection you select the menu
Visualization > Colored. Here you specify the 12 predefined color presentation. Now
every computed region receives one of the 12 colors. This presentation mode is very useful to
indicate each region with a different color. If there are more than 12 regions the system uses
the same color for several different regions. Withv_display of the imageImageFilled

you refresh the graphics window to see the results of next step much better. Select the menu
Operators > Develop > dev_display.

File E: uslizaion Operators Suggestions Window Help

o] 1 lmlelo] mz)w] 295 o) ol
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Regians [Merks. ] resion Jabjecty
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StructureFactar [StructureFactor <] rea

T thw | el | v

768
Height 575
[WindowlD: 3600

Anisome try: (112702204804, 1.11467319487 1 18047551603, 1.12294618312, 1.42797741283, 1.1¢
Bulkiness: [1.00416718505, 1.00426336515, 1.00007240412, 1.00253432078 , 1.00587046647, 1.0(
StructureFactor: [0.131718557464, 0.119425453718, 0180560987328 , 0.125792088964, 0.43636030635 + |
|

Figure 1.4: Region selection based on shape features.

In the next step you have to specify the regions which correspond to the circular marks of the
indicated person in shape and size. For this you have to call the opeeatast _shape in
menulperators > Regions > Features. The first call is used to obtain a preselection with
the estimated object size given in pixels. With an estimated siZé of 15 pixels you will

get approximatel\225 pixels. After choosingselect_shape you specify the parameters as
follows:

1. The input region will b&€onnectedRegionsDynThresh,

2. the output variable name remains unchanged,

HDevelop, 2003-08-01



1.2. EXAMPLE SESSION 7

3. values’area’ and’and’ remain unchanged.
4. The region’s minimum size should b&0 (Min) and
5. the region’s maximum size should not excééd (Max).

6. The mean intensity should be betwden and255.

In figure1.4the extended program can be seen.

Now you have to extract from the remaining regions the regions that match the objects to
look for. As you can see, the regions representing the marks have a circular shape — con-
trary to all others. This is expressed by a compactness value cldse For this you have

to choose the operateklect_shape once again. Use the combo box of the parameter text
field Features to specify the valuecompactness. As a range of values you may spec-

ify the parameterslin and Max with the valuesl.0 and 1.4, respectively. The output re-
gions of the first call felectedRegions) are the input regions for the second call of opera-

tor select_shape. The output parameter’s narselectedRegions is replaced by the name
SelectedRegionsDynThresh.

The last step to make the application stable is to add a selection of regions bageg value
features. This is done by using the operatetect_gray. In this case, the mean gray value is
used to discriminate the objects.

peralors Suggestions Window Help

B[] el ] Bl sl

‘e, [150,1

Chiistof | ImageFilk | Imageble~ | R

Pointer 3232269
Type byte’
Width: 768
Height 575
WindowiD: 3600
Anisometr 112702204804, 111467319467, 1.16047551603, 112294518312, 1.42797741283, 1.182460
[1.00415718505, 100426336515, 100007240412, 1.00263432076, 1.00687046647 , 1.0061 11
ctor. [0.131718557484, 0119425453718, 0180560987328, 0126792086064, 0436360306368, 0.1

| Bl

Figure 1.5: After calling the operator eccentricity the output parameters are displayed in the
variable window in tuple notation.

Finally, we want to obtain some numerical information about the matched marks. For example,
we might want to compute three shape features of the marks. They are derived from the regions’
geometric moments. The calculation is done by the opesatesntricity. The input param-

eters are all regions of the variablerks. The computed valuggiisometry, Bulkiness, and

HALCON 6.0.4



8 CHAPTER 1. INTRODUCING HDEVELOP

StructureFactor are displayed as a list (a tuple in HALCON terminology) in the variable
window. Figurel.5shows the example session’s result.

As you can see in figuré.5 and 1.4 it is possible to combine the two successive calls of
select_shape into one call. This reduces the length of the program and saves runtime.

1.3 Additional Sources of Information

Further information can be found in the following manuals:

e Getting Started with HALCON
An introduction to HALCON in general, including how to install and configure HALCON.

e HALCON/C ++ User’s Manual
How to use the HALCON library in your C++ programs.

e HALCON/C User's Manual
How to use the HALCON library in your C programs.

e HALCON/COM User’'s Manual
How to use the HALCON library in your COM programs, e.g., in Visual Basic.

e Extension Package Programmer’s Manual
How to extend the HALCON system with your own operators.

e Frame Grabber Integration Programmer’s Manual
A guide on how to integrate a new frame grabber in the HALCON system. Note that
in some cases you might define new operators (using the Extension Package Interface)
instead of using the standard HALCON Frame Grabber Integration Interface in order to
exploit specific hardware features of a frame grabber board.

e HALCON/HDevelop, HALCON/C ++ HALCON/C , HALCON/COM
The reference manuals for all HALCON operators (versions for HDeveldg, C, and
COM).

All these manuals are available as PDF documents. The reference manuals are available as
HTML documents as well. For the latest version of the manuals please check

http://www.mvtec.com/halcon/

HDevelop, 2003-08-01



Chapter 2

Graphical User Interface

HDevelop is annteractive toolto create image analysis programs. It comprisesditor, an
interpreterwith debug functions, enanagement unfor variables (iconic and control data) and
extensive possibilities to visualize iconic data. You may use HDevelopafad prototyping

as well as for developing complete programs. You create a program by choosing operators
and specifying their parameters. To do so, you may use default values or values proposed by
HDevelop. After having selected the appropriate parameters, you execute the operator and insert
it into the program text (i.e., the program window). You can modify and verify your generated
program interactively. All intermediate results (variables) are displayed graphically (images,
regions and polygons (XLD)) or textually (numbers and strings).

After starting the tool as described in sectig, the main window, which includes the follow-
ing windows, will appear on your screen (see also figllg

e a program window,

e an operator window,

e avariable window, and
e a graphics window.

In the following you will learn the functionality of these five windows and their effective use
while creating HDevelop programs.

Please note that in the UNIX environment the main window, the program window, and the
operator window are combined into one window. Thus, there aretbrégwindows.

2.1 Interacting with HDevelop

You interact with HDevelop through its graphical user interface. With the mouse you can ma-
nipulate visual controls such as menus or buttons in the HDevelop windows.

2.2 Mouse Handling

You can use the mouse as follows:
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e Clicking the left mouse button once,
you are able tgelectwindow-specific components, such as menu items, iconic variables,
control variables, action buttons, checkboxes, and you give the insertion focus to a specific
text field. Some of these text fields comprise a combo box which you may open in the
same way.

Furthermore, you select (invert) text in certain windows, e.g., in the program window.
With this you are able to perform the general editor functionsdike, copy andpaste
(see section®.3.2.2and2.3.3.

In the program window there is an extended mode to select lines by presskghitite >

or the<Ctrl> key during the mouse click. More than one line can be activated using
the <Shift> key: All lines between the last activation and the new one will become
activated. TheCtrl> key is used to active or deactivate more than one line using single
mouse clicks.

Clicking at an item for the second time (after a short pause) will deactivate it (e.g., linesin
the program window or variables in the variable window). Similarly the activation passes
to another item by clicking at it.

Very important is the possibility to set the program couneep (at the left side of the pro-
gram window (se.4). By combining a mouse click with special keys you can activate
further functions:

— Clicking the left mouse button once while pressing4Baift> key:
This places the insert cursor in the program window &dg

— Clicking the left mouse button once while pressing ¢er1> key:
A break point will bet set in the program window. By performing this action once
more, the break point will disappear (s24).

e Clicking the left mouse button twice
results in an action that will be performed with the activated item. In the program window
the operator corresponding to the program line together with its parameters is displayed
directly in the operator window and can then be modified.

Iconic and control variables are displayed in the graphics window or in specific dialogs.

2.3 Main Window

Themain windowcontains the other four HDevelop windows and possibly additional graphics
windows?! The main window can handle HDevelop programs, manipulate the graphics output,
offer all HALCON and HDevelop operators, give suggestions and help on choosing operators
and manage the HDevelop windows. After starting HDevelop you will see a window configu-
ration similar to figure2.1

The main window comprises five areas:
e atitle bar,

e amenu bar,

In a UNIX environment the main window comprises the program window and the operator window. It has no
special Window manager functionality like, e.g., in Windows NT.

HDevelop, 2003-08-01
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Figure 2.1: The main window.

e atool bar,
e awindow area, and
e a status bar.

In the following chapters you will find all necessary information to interact with this window.

2.3.1 Title Bar

Your HDevelop main window is identified by the titi®evelop in the window’s title bar. After
loading or saving a file, the file name will be displayed in the title bar. Additionally it offers
three buttons on the right hand side to iconify and to maximize the window, and to exit the
HDevelop session.

2.3.2 Menu Bar

In the menu bar of the main window HDevelop functionality is offered. Here you may perform
the important actions to solve your image processing tasks, i.e., to choose any HALCON or
HDevelop operators or to manipulate the graphical output. Every menu item operik a
downmenu (henceforth abbreviated as menu) with optional submenus. You open a menu by

HALCON 6.0.4
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clicking a menu item (inside the appropriate text) or via the keyboard (by pressing the key
<A1t> in combination with the underlined letter of the menu item). All menu items are going
to be explained in the following.

2.3.2.1 The Menu Iltem File

In the menu itenFile you will find all functions to load an image and existing programs and

to save recently created or modified programs, respectively. Furthermore, you may export
HDevelop programs to C, C++, and Visual Basic, and also print them. FiyjRshows all the
functions in this menu item.

M=l B3

i HDevelop - marks_dev
Edit Execute Wisualization Operators  Suggestions  Window  Help

EEEEEEERREOE
.. I -

Insert...
Active  [] |

Save Chrl+5
Save as...

Brint.... Chrl+P
Brint Selection...

Bead Image 3

LCleanup

Options...
Modules...

Quit

1 marks.dev

er, Type, Width, Hei
ight, 'black’, Windoy

il

1)

Create a new program (clear the current program)

Figure 2.2: The menu item File.

File > New (keyboard shortcikCtrl> N)
The menu itenFile > New deletes the current program and all associated variables.
The contents of the variables are deleted before removing them. In addition, all graphics
windows except one are closed. The last window will be cleared. The display parameters
for the remaining graphics window are identical to those when starting HDevelop. The
first four parameters of the memile > Options are reset to their initial state: The
update of windows, variableB¢, and time is on.

A security check prevents you from deleting the current program accidentally if the pro-
gram has not been saved. A dialog box appears and waits for your response, whether you
really want to delete the HDevelop program. Your confirmation only deletes the HDe-
velop program you are working on and not the file associated with it. Now you are ready
to input a new HDevelop program. If you give a negative response, nothing will happen.
You have to press one of the two buttons before you are able to continue interacting with

HDevelop.

File > Open... (keyboard shortcwtCtrl> 0)
By clicking on the menu itenFile > Open... Yyou can load an existing HDe-
velop program. Alternatively, you can seleetle > Insert... to insert a file
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into the current program at the line in which the insert cursor is located. In both
cases, a dialog window pops up and waits for your input (see figie It is called
Load HDevelop Program File. Please note that text, Visual Basic, C, or C++ versions
of a file cannot be loaded.

Load HDevelop Program File

Look in: I A Fa
] adapl_pattem.dev. ] fin2 dev tim2 dev
@ ball.dex holes.dey

4] ballz. dev hul dev

@ bioard. des i e

@ bioard2. dew pattern.dey

@ clip.dev pri_illu.dewy

@ clip2. dew prr_illu_rot, desy
@ fir. e rirn. dey

File name: I*.dev Open I
Files of type: IHDeveIDp *dev) j Cancel |

[ Open as read-only

Figure 2.3: The dialog window to open an HDevelop file.

In the topmost text field you may specify a directory which contains your HDevelop
programs. A combo box at the right hand side helps you browsing your directories. To
move one directory level up, you press the button on the right hand side of this text field.
The next button creates a new folder to store HDevelop programs. By pressing the last
button you can activate or deactivate the option to see more details about your HDevelop
programs, i.e., the program size, the program type, the date when the most recent user
update occurred, and file attributes.

The middle text area displays all available HDevelop files to choose from. By clicking
the left mouse button on a file name you select it. Double-clicking a file name opens the
file immediately and displays it in the program window (see chaht@r

Furthermore, you may specify the file name in the text field below. The combo box for
file type has no effect because only HDevelop programs with the extenseican be
loaded. If you want to open your file with a write protection choose the checkbox at the
bottom of this dialog window. To open your specified file, you pressOgie button.

This action deletes an already loaded HDevelop program and all created variables. The
same actions as wihile > New are performed. Now you can see your new program in
the program window. The file name is displayed in the title bar of the main window. All
its (uninstantiated) variables are shown in the variable window. To indicate that they do
not have any computed values, the system provides the iconic and control variables with a
guestion mark. The program counter is placed on top of your program and you are ready
to execute it. The visualization and options will be reset after loading (sam&lasr

New).

If you want to cancel this task you have to press the corresponding button. By using one
of these two buttongpen or Cancel) the dialog window disappears.

HALCON 6.0.4
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After you have loaded a program the corresponding file name will be appended at the end
of the menwFile (after the menu iterQuit). This allows you to switch between recently
loaded files quickly. The most recently loaded file is always listed first.

File > Save (keyboard shortcikCtrl> S)
The menuitenFile > Save saves the current program to afile. If no file name has been
specified so far, the dialog correspondingide > Save As... will be activated.

File > Save As...
The menuitenFile > Save As... saves the current program to a file. The type of file

(HDevelop, text, Visual Basic, C, or C++) can be selected (see FRydye

Save HDevelop Program File [ 2] x|
Sawve in: |El Fa j i

| adapt_pattern.dew fin2. dew nim2. dev
@ ball.dex holes.dew

34 ballz. dev bl dev

@ bioard. dev ic.dew

@ bioard2. des pattern. dey

@ clip. dew pr_illu, des

@ clip2.dev pri_illu_rat dey
@ fin.dex rim. de

ey SEVE I
Save as type: IHDeveIDp *.des j Cancel |

[T Cpen as read-only

File name:

Figure 2.4: The dialog window to save a program to a file.

A dialog box (similar to the window described in menuitéirie > Open...) is opened

in which you can specify the appropriate settings. You may specify a new file name and
a directory where to locate this file. You may indicate whether the HDevelop program
remains a HDevelop program or is transformed to a C, C++, Visual Basic, or an ASCII
file. This is done by clicking the combo box of the text field calfddes of type.

In UNIX the selection of the file type has to be done by entering the corresponding file
extension manually. For C++ code you have to adpp to the file name, for C++ code

.c, and for ASCII .txt. The extension for Visual Basic isbas. Default type is the
HDevelop type (extensiondev). The details of code generation are described in chapter
4.

Similar to loading, the file name of the program you save is appended at the end of the
menuFile.

File > Print... (keyboard shortcikCtrl> P)
The menu itenFile > Print... enables you to print the current program. Upon se-
lecting the menu item, a dialog appears in which you can configure the printing process.

File > Print Selection...
In contrast to the menu itenfile > Print..., the menu itemFile > Print
Selection. .. prints only the currently selected part of a program.
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File > Read Image
The menwFile > Read Image contains several directories from which images are usu-
ally loaded. The first entry of this menu always is the directory from which the most re-
centimage was loaded. This is useful, when several images from a non-standard directory
must be read. The remaining entries except the last one are the directories contained in the
J%HALCONIMAGESY environment variable. The final directory, denoted.bys the current
working directory of the HDevelop program, which usually will YeALCONROOT?Y, on
Windows systems, and the directory in which HDevelop was started on UNIX systems.

=1 k3

i HDevelop
Edit Execute  Wisualization Operators Sugoestions Window  Help

hen o ] = ] ] ]
l_nsert::: !EIE

5 Clrl+5

E:::QS... " Active Dl

WA curmentibinisEE-ntd
Ywhalzonshalconeunentyimages
D:images

Bead Image

Cleanup

Options. ..
Modules...

it
1 clipZ.dev

Save the current program with a different name

Figure 2.5: The menu item File > Read Image.

When any of the directories is selected, an image file selection box appears. Again, its
functionality is similar to the dialog discribed in menu it€tle > Open.. .. Figure2.6
shows an example of tHead Image File dialog.

Load Image File
Lockin: | SVimages = Bl &l ==
Daulobahn | angio-part. gif | combine. tif | finl . tif o] jic. il
|20 bvlab_2p 8] audiz ti [a8] it [a8] fin i o8] il tt
2 bvlab_hp 8] autabahn tf 8] equnt1 i ] fin3. i ] i1t
2 calib o8] b5 _1.tit =] engraved tf 8] faor i ] ic2 it
2 fants ] bitrat, bt ] Faboik ] farest_air i ] i3 it
2 stamps @ bt tif @ facel tf @ farest_road ki @ letters. ti
] sing @ caltab. tif @ faced tif @ horses. if @ M arks. tif
alpha.ti [a8] clip.tit [a8] facea tif 8] bl tit [#8] meringgs. tit
1] | |
File name: I*.* Open I
Files oftype:  |All Files () | Cancel |

[ Open as read-only

Figure 2.6: The dialog window to load an image.
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After selecting a file name, the name of the variable for the image in the HDevelop pro-
gram has to be selected. To do this, a small dialog appears after pressingr double
clicking a file. For easy handling, HDevelop suggests a name derived from the selected
file name. You may adopt or edit this name. If you want to use a name of an already
created iconic variable, a combo box offers you all iconic variable names. To do so, you
click the button on the right side of the text field. Note that the reuse of a variable name
deletes the old content and replaces it with the new image.

File > Cleanup
The menu itenFile > Cleanup deletes all unused variables (iconic and control data).
These are variables in the variable window that are no longer used in any operator of the
program. This can happen after the deletion of program lines or after editing variable
names, because the corresponding variables are not deleted automatically. You may use
this menu item during a longer editing process to reorganize your variable window (see
also pagé4).

File > Optioms...
The menu itenFile > Options... opens a control window, which you can use to
modify output behavior during runtime (see fig@.@).

¥ Update PC

v Update Yariables

¥ Update Windowe:

[¥ Showe Processing Time
[ Ingert Interactions

[T Show Yarighle Usage
[T Showe Lowe Lewel Errors
[ Automatic Program Save

[T Experienced Programmer

Syrte IHaIcunDevelup vl
DIgI‘tS |12 vI
Cancel |

Figure 2.7: The options window.

e Update PC
The first item (see pagéB) concerns the display of the current position while run-
ning the program. The so call&f (Program Countey always indicates the line
of the currently executing operator or the line before the next operator to execute.
Using thePC in this way is time consuming. Therefore, you may suppress this op-
tion after your test phase or while running a program with a lot of “small” operators
inside a loop.

e Update Variables
This checkbox concerns the execution of a program: Every variable (iconic and con-
trol) is updated by default in the variable window (see pad)e This is very useful
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in the test phase, primarily to examine the values of control data, since iconic data
is also displayed in the graphics window. If you want to save time while excecuting
a program with many operator calls you may suppress this output. Independent of
the selected mode, the display of all variables will be updated after the program has
stopped.

e Update Window
This item concerns the output of iconic data in the graphics window after the exe-
cution of a HALCON operator. With the default setting, all iconic data computed in
theRun mode (see pag2l) is displayed in the current graphics window. You may
want to suppress this automatic output, e.g., because it slows down the performance
time. If the output is suppressed you have the same behavior as exported C, C++, or
Visual Basic code, where automatic output of data is not supported.

e Show Processing Time

This checkbox indicates whether the required runtime of the last operator should be
displayed after the execution has stopped. It is a measurement of the needed time
for the current operator (without output and other management tasks of HDevelop).
Along with the required runtime, the name of the operator is displayed in the status
bar at the bottom of the main window. Please note that the displayed runtime can
vary considerably. This is caused by the inaccuracy of the operating system'’s time
measurement procedure.

e Insert Interactions
Sometimes itis very helpful to record user interactions as a sequence of operators in
the program. To do so, you select this option. From now on interactions are inserted
as a program line in the program window. For example, select the graphic color red
by choosing the appropriate menu inserts the program line

dev_set_color(’red’)

into the program window.

e Show Variable Usage
If you activate a variable (by single-clicking on it) all lines in the program that
contain the variable are marked on the left with a black frame. This works with
iconic and control variables. You can activate one iconic and one control variable
simultaneously. Each activated variable is marked by a black background for the
name in the variable window.

e Show Low Level Errors
Low level errors of HALCON are normally invisible for the user because they are
transferred into more comprehensive error messages or simply ignored. Activating
this item generates a message box each time a low level error occurs.

e Automatic Program Save
If you activate this option, the program is automatically saved before each execution
of the program, i.e., before a Run or Step operation. The file name the program
is saved to is the file name of the current program. Therefore, if you create a new
program you have to seleEtle > Save as... manually first to give the program
a file name.

e Experienced Programmer
This option was introduced to facilitate the development of HDevelop by MV Tec.

HALCON 6.0.4
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It is not suitable for the normal use of HDevelop.

e Syntax
Using a combo box, you may specify the output mode inside the program window.
Depending on the mode, each HALCON or HDevelop operator is shown in a spe-
cific syntax likeHalconDevelop (default syntax) oct.

e Digits
With this checkbox, you can control how many digits of floating point numbers are
displayed in the Variable window. The selected number is the total number of digits
displayed. Therefore, if you have selected four digits, the result of the following
assignment

assign (4xatan(1), PI)

is displayed as 3.142. Note that the changes do not take effect until the values of the
variables are actually updated by running the program, i.e., the the variables are not
redisplayed automatically.

Before continuing your HDevelop session, you have to close the option window by press-
ing the buttorok or by cancelling the action. fnsert Interactions is activated, the
changes applied inside the dialog will result in automatic operator inseftierpressing

OK.

HDevelop saves the current selections for the options “Show Variable Usage”, “Show
Low Level Errors”, “Automatic Program Save”, “Experienced Programmer”, “Syntax”,
and “Digits”, and restores them upon start. Under Windows, the options are stored in
the registry; under UNIX, the options are stored in the subdirectaggvelop of the
directory referenced by the environment varigiieE.

File > Modules...

The menu itenFile > Modules... opens a window, in which the HALCON modules
used by the current program are displayed (see figi@e This window allows you to get

an estimate of how many modules your application would need in a runtime license. Only
calls to the HALCON library are taken into account for the computation of the modules,
and not HDevelop control structures likesign or ifelse, or HDevelop operators like
dev_open_window Or dev_set_color. Therefore, when you export your program to C,
C++, or Visual Basic, the actual number of modules required may be higher than the
modules displayed in the Module window, depending on how many operators you add to
the program, e.g., for visualization purposes.

By clicking Save the modules required by the current program are saved in a file with the
extension.mod in the currently used directory.

File > Quit

The menuitenFile > Quit terminates HDevelop without saving the current program.

File History

At the bottom, the menBile displays the most recently loaded files.

2.3.2.2 The Menu ltem Edit

In this menu item you find all necessary functions to modify a HDevelop program ipréthe
gram window(see chapte2.4). You have the following items to choose from:
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Figure 2.8: The modules window.
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Figure 2.9: Main window’s menu item Edit.
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You may undo your previous activities by clickiigit > Undo. For example, by click-

ing three times this item you cancel the last three user actions.

Edit > Cut (keyboard shortcwtCtrl> Z)
You may use the itemisdit > Cut,Edit > Copy, andEdit > Paste for changing the

program contents. First you have to select the part of the program (at least one program
line) that has to be changed (use the left mouse button). Then you may delete this part by
clicking the itemkdit > Cut. The deleted program part is stored in an internal buffer.

Thus, by using the iterRdit > Paste (keyboard shortcwtCtrl> V) the buffer remains
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Figure 2.10: Searching for an operator.

unchanged.

Edit > Copy (keyboard shortcwtCtrl> C)
By clicking Copy you store the selected program lines directly in an internal buffer.

Edit > Paste (keyboard shortcitCtrl> V)
To insert this buffer in the HDevelop program you place your mouse pointer at the desired
position and then click iteridit > Paste.

Edit > Delete
The menu itenEdit > Delete deletes all selected program lines without storing them
in an internal buffer. The only way to get the deleted lines back in your program is to use
the itemEdit > Undo.

Edit > Find Operator... (keyboard shortctCtrl> F)
The menu itenEdit > Find Operator... allows to search for the appearance of an
operator in the current program. Figu2el0depicts the corresponding dialog: Specify
an operator name in the text field, then find the next appearance by clicking the button
Find, or the previous one by checking the bbxd Backwards. The figure shows the
result of clickingMark Al1l. If you check the boxdit, the Operator Window pops up
and lets you edit the found operator instance.

Edit > Find Again (keyboard shortctCtrl> G)
The menuitenkdit > Find Again repeats the search specified via the menu Eéin
> Find Operator.
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Figure 2.11: Replacing variables.

Edit > Replace Variables... (keyboard shortcltCtrl> H)
The menu itenEdit > Replace Variables... allows to search and replace variable
names. Figur@.11ldepicts the corresponding dialog: After specifying the variable name
to find and the name to replace it by, you can let HDevelop replace all instances of the
variable by clickingreplace All. If you click Find, the next instance of variable is
displayed in the Program Window; you can then replace its name by cligkisitace.

2.3.2.3 The Menu ltem Execute

In this menu item you find all necessary functions to execute a HDevelop programprothe
gram window(see chapte2.4). You have the following items to choose from:
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Figure 2.12: Main window’s menu item Execute.

Execute > Run (keyboard shortclis)
By selectingexecute > Run, HDevelop executes your program depending onPitie
position in the program window. THeC indicates the next program line to execute. All
following program lines are going to be performed until the program end. Notice, that a
break point may interrupt the run of your program.

During the execution of operators the following special behaviour occurs:

e Although the mouse pointer indicates that HDevelop is not ready to handle user in-
put (clock shape of the mouse pointer) you may initiate limited transactions. For
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example if you click variables, they will be visualized; you may modify output
parameters for graphics windows; you may even modify the program. Note that
HDevelop may be slow to react to your actions while the program is running. This
is caused by the fact that HALCON reacts to user input delyveercalls to oper-
ators.

e A variable window update during runtime will only be performed if it has not been
suppressed (see pag). In any case, the values of all variables are shown in the
variable window after the execution’s termination.

While the program is running, the meritsecute > Run andExecute > Step (andthe
toolbar button®un andStep) are grayed out, i.e., you cannot execute them. You have
the following possibilities to stop your HDevelop program:

1. The program runs until the last operator in this program has been calle®CThe
is positioned behind this operator. This is the usual way to terminate a program.

2. The menExecute > Stop (or the toolbar buttolstop) has been pressed.

3. Abreak point has been set (see chaptdy. In this case the last operator that will
be executed is situatdmkforethe break point.

4. MenuitenFile > Quit has been executed (see pd&e

5. A runtime error occurred. An input variable without a value or values outside a
valid range might be typical reasons. In this casePtheemains in the line of the
erroneous operator.

Execute > Step (keyboard shortcui6)

Selectingexecute > Step enables you to execute a program (even if it is not complete)
step by step. HDevelop executes the operator directly to the right of the green arrow,
which is used as the program counte€) (see chapte2.4). The mouse pointer changes

its shape to a clock. This indicates that HDevelop is active and not available for any
user input. After the operator has terminated, all computed values are assigned to their
respective variables that are named in the ouput parameter positions. Their graphical or
textual representation in the variable window is also replaced. If iconic data has been
computed, you will see its presentation in the current graphics window. In the status bar
of the program window the operator runtime is indicated (if the time measurement has
not been deactivated).

The PC is set before the next operator to execute. If the operators are specified in a
sequential order, this is the textual successor. In case of control statementst(e.g.,

endif or for ... endfor), thePC is setonthe end marker (e.gendif or endfor)

after the execution of the last operator inside the statement’s body. &féglor and
endwhile the PC is always set on the beginning of the loop. If a condition {&sor
while) evaluates t&ALSE, thePC is setbehindthe end marker.

Suggestions in the mersuggestions are determined for the recently executed operator.
Finally the mouse pointer’'s shape switches to the arrow shape and HDevelop is available
for further transactions. Any user input which has been made during execution is handled
now.

Execute > Stop (keyboard shortcut9)

You may terminate the execution of a program (m®de) by selectingExecute >
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Stop. If you do so, HDevelop continues processing until the current operator has com-
pleted its computations. This may take a long time if the operator is taking a lot of time to
execute. There is no way of interrupting a HALCON operator. After interrupting a pro-
gram you may continue it by selectiigecute > Run andExecute > Step. You may

even edit the program before restarting it (e.g., by parameter modification, by exchanging
operators with alternatives, or by inserting additional operators).

Execute > Deactivate, Edit > Activate
It is often useful for testing purposes to prevent some lines of the program from being
executed. This can be done by selecting the appropriate lines in the program window and
calling Execute > Deactivate from the menu. With this, an asterisk is placed on the
beginning of the selected lines, and hence appear as comments in the program window.
They have no influence on the program during runtime. The deactivated lines are still
part of the program, i.e., they are stored like all other lines in a file and their variables
are still needed like all other variables. To reverse this action you may presBdtent
Activate.

Note that you can insert a comment into your program by using the operatesnt.

Execute > Set Break Point, Execute > Clear Break Point
These menu items set or clear a break point on the line(s) that are currently selected in
the program. In most cases, however, it is easier to set and clear individual break points
pressing the left mouse button and #&tr1> key in the left column of the Program
Window as described isection 2.4

Execute > Clear All Break Points
With this menu item you can clear all break points in the program.

Execute > Reset Program
With the menu itenExecute > Reset Program you can reset the variables of the cur-
rent program to their initial states, i.e., all variables have undefined values. Furthermore,
the program counter is set to the first executable line of the program. The break points,
however, are not cleared. This menu item is useful for testing and debugging of pro-
grams.

2.3.2.4 The Menu ltem Visualization

All items which can be selected are shown in fig@r&3

With this you are able to open or to close graphics windows and to clear their displays. Further-
more, you may specify their output behavior during runtime.

Visualization > Open Window...
By using this menu item, you open additiohgtaphics windows.

For this, a dialog window pops up (see fig@.é¢4). Here you may specify some graphics
windows attributes. The position, size and background color of the new graphics window
can be specified. For example, it is more convenient to have a white background while
building graphics for slides or reports (see the HALCON operatiap window). If the

2Normally upon starting, HDevelop automatically opens one graphics window.
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Figure 2.13: Submenu Shape of menu Visualization.

Ok |

R IU
Calumn IU
Width |-1
Height |-1
Backaround Ibla-:k ,l

Cancel |

Figure 2.14: Dialog window of menu item Visualization > Open Window. ...

window height and width are set to -1, the window obtains the same size as the largest
image in the current session. A position value of -1 specifies that the window position is
determined by the window manager (UNIX). If you have not already created an image,
the sizeb12 x 512 is used. The handling of graphics windows is described in ch2pter

at pageb6.

Visualization > Reset Parameters
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Here, the display parameters of all graphics windows are set to their initial state (the state
after starting the program). The only exception is the history of previously displayed
objects and the size of each window. To clear the history you camisselization >

Clear Window, to set the size you can ugésualization > Size Window.

Visualization > Close Window
Selecting this item closes the active graphics window.

Visualization > Clear Window
The active graphics window is cleared. The history (previously displayed objects) of the
window is also removed.

Visualization > Pixel Info...
Here you can open an inspection display. This is used for interactive examination of gray
values of images. Apart from this, the size, pixel type, and the number of channels are
displayed.

Pixel Information [ x|

Gray/RGE: I 20

Rarwy Column: I (a63,823)

Vicith,Height: | (830,822)

Pixel Type: I hite

# Channels: |1

Figure 2.15: Online gray value inspection and basic image features.

The upper part of the dialog contains a gauge to display the gray value graphically. The
range goes from 0O (left) to 255 (right). Normally the gray value of the first channel is
displayed with a black bar. For color images in RGB-space (three channels with red,
green, and blue values) three colored bars are used. If the gray value is below 1 the gauge
is white (background). If the value is above 255 the gauge is black or colored for rgb
images.

Below the gauge, the gray values are displayed as numbers. If more than three channels
are present only the gray value of the first channel is displayed.

Below the gray values the coordinates of the mouse position is displayed. Below these,
the size, pixel type, and the number of channels of the selected image are shown.

Visualization > Zooming. ..
With this menu item, a tool for real-time viewing of zoomed parts of an image object is
opened. Figur@.16shows the layout of the real-time zooming window.

The upper part of the tool contains a window of fixed size 5%6, in which the part of

the graphics window, over which the mouse pointer is located, is displayed enlarged. In
the zooming window, this pixel is marked by a red square; its coordinates are displayed
at the bottom of the zooming window. The factor, by which the enlargement is done can
be adjusted with the combo b@ooming factor. A zooming factor of O corresponds
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Figure 2.16: Real-time zooming.

to displaying the contents of the graphics window in to normal resolution, i.e., one pixel
in the image object corresponds to one pixel in the zooming window. Increasing the
zooming factor by 1 roughly increases the enlargement by a facto? &fo2L can select

a particular pixel by single-clicking on it with the left mouse button. The zooming tool
stores this position internally, and will redisplay the thus selected part of the image object
when you leave the graphics window. This enables you to have a meaningful display in
the zooming tool whenever you want to do actions outside of the graphics window.

Visualization > Gray Histogram Info...
This menu item opens a sophisticated tool for the inspection of gray value histograms,
that can also be used to select thresholds interactively and to set the range of displayed
gray values dynamically. Figurz17shows the layout of the gray histogram inspection
window.

When opening the tool, the histogram of the image shown in the currently active graphics
window is displayed. When the tool is already open, four modes of sending new image
data to the tool are available. The simplest mode is to display an image in the active graph-
ics window. Whenever you do so, the histogram of this image is computed and drawn,
and the tool records the graphics window from which the image was sent. Another sim-
ple method to send new data to the tool is to single-click into an image that is displayed
in a graphics window. The third mode can be used whenever image data is displayed
overlaid with region data in a graphics window (the graphics window does not need to be
active for this). In this mode, you can click into any of the segmented regions, and the
histogram of the image within that region will be computed and shown. If you click into a
part of the image that is not contained in any of the overlaid regions, the histogram of the
entire image will be displayed. In the fourth mode, the same mechanism is used for re-
gions that have gray value information, e.g., image objects createeldnye domain or
add_channels. Here, the histogram of the image object you click into will be displayed.

3Yes, only roughly by a factor of 2, since the image is scaled such that the red square that indicates the mouse
pointer position is located in the middle of the zooming window. Therefore, the zoom factor is adjusted to display
one pixel more than the power of 2 indicated by the zooming factor. The width and height of the zoomed part of
the image hence ag¥~/ + 1, wheref is the zooming factor.
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Figure 2.17: Online gray histogram inspection.

Finally, when the graphics window the image was sent from is cleared, the histogram is
not reset.

When a multi-channel image, e.g., a RGB color image, is sent to the tool, by default the
histogram of the first channel is displayed. The combo ¢imanel lets you select the
channel from which to compute the histogram.

The radio box in the upper center of the tool lets you select whether to display the his-
togram with relative or absolute frequencies. When you s&lett the frequencies of
individual gray values are displayed as percentages; when you getedhey are dis-
played as the actual number of pixels having a particular gray value. See the operator
gray_histo in the HALCON Reference Manuals for details.

Sometimes it is desirable to suppress the updating of the histogram when new image
data is available, e.g., if you want to select thresholds for a gradient image, but want to
visualize the original image along with the segmentation (see below). To do so, you can
deselect the checkbaxcept.

The main part of the tool is the area, in which the histogram of the image is displayed
in blue. This area contains static parts and parts that can be interactively manipulated.
The first static part is the horizontal coordinate axis, which displays the gray values in the
image. For byte images, this range is always 0 ...255. For all other image types, e.g.,
real images, the horizontal axis runs from the minimum to the maximum gray value of
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the image, and the labeling of the axis is changed accordingly. To the left of the display,
the vertical axis representing the frequency of the gray values is drawn in white. The
final static parts of the display are three cyan arrows. The two upward pointing arrows
denote the maximum and minimum grayvalue of the image. The downward pointing
arrow denotes the gray value that occurs most frequently, i.e., the peak of the histogram.
These data are displayed in textual form within shetic data area of the display.

The dynamic parts of the histogram area are the three colored lines, which can be manip-
ulated. The dashed horizontal yellow line can be dragged vertically. The label on this line
indicates the frequency of gray values above this line. The vertical green and red lines
denote the minimum and maximum selected gray value of the histogram, respectively.
The selected range is drawn as a white bar below the horizontal gray value axis. The gray
values on which the two vertical lines lie are displayed next to the lines in the same color.
The frequency of the respective gray values is displayed withiDghemic data area

of the display.

The selected range of gray values can be used for two major purposes. If the combo
boxDisplay is set tothreshold, the image from which the histogram was computed is
segmented with ahreshold operation with the selected minimum and maximum gray
value. Depending on the setting of the combo Beud, the segmentation result is either
displayed in the graphics window, from which the image was originally s&std(=

back), or in the active graphics windovg4nd = to active).

If Display is set toscale, the gray values of the image are scaled such that the gray
value 0 of the scaled image corresponds to the minimum selected gray value and the gray
value 255 to the maximum selected gray value. Again, the comb@&ox determines

the graphics window, in which the result is displayed. This mode is useful to interactively
set a “window” of gray values that should be displayed with a large dynamic range.

If you want to select threshold parameters for a single image, display the image in the
active graphics window and open the histogram tool. For optimum visualization of the
segmentation results, it is best to set the visualization color to a color different from black
or white (seeVisualization > Color below). Now seDisplay to threshold and
interactively drag the two vertical bars until you achieve the desired segmentation result.
The parameters of the threshold operation can now be read off the two vertical lines.

If you want to select threshold parameters for an image which is derived from another
image, but want to display the segmentation on the original image, e.g., if you want to
select thresholds for a gradient image, two different possibilities exist. First, you can
display the derived image, open the histogram tool, desgteeipt, display the original
image, and then select the appropriate thresholds. This way, only one window is needed
for the visualization. For the second possibility you can display the derived image in
one window, activate another window or open a new window, display the original image
there, activate the first window again, open the histogram tool, activate the second window
again, seSend to to active, and select your thresholds. Although in this case it is
not necessary to deselegicept, it is advantageous to do so, because this prevents the
histogram from being updated if you click into a graphics window accidentaly.

Visualization > Region Info...

This menu item opens a tool for the convenient inspection of shape and gray value fea-
tures of individual regions. It can, for instance, be used to determine thresholds for op-
erators that select regions based on these featuress€lgct_shape Or select_gray.
Figure2.18shows the layout of the region feature inspection window.
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Figure 2.18: Online region feature inspection.

The strategy to determine the data from which to compute the features is very similar to
that of the gray histogram inspection window. You can display an image or region by
double-clicking on it in the variable window or you can select a region or an image which
is already displayed by single-clicking it. If you display or click into an image, the gray
value features of the entire image will be calculated. If you click into a region that is
not underlaid with an image, only the shape features of this region will be displayed. If
you click into a region that is underlaid with an image or into a region that has gray value
information (e.g., fronreduce_domain or add_channels), both the shape and gray value
features of that region will be displayed. Finally, if you have overlaid an image with a
region, but click into a part of the image that is outside the region, only the gray value
features of the entire image will be calculated.

Analogously to the gray histogram inspection window, the gray value features of a multi-
channel image are calculated from the first channel by default. You can use the combo
box Channel to select the desired channel.

The shape features on the left side of the region inspection window are grouped into seven
categories, which correspond roughly to individual HALCON shape feature operators.
The topmost of the displays shows the most basic region features, namely the area and
center of gravity of the region (segea_center in the Reference Manual) and the width

and height of the smallest axis-parallel rectangle of the region. The latter is computed
from the output of the operat@mallest rectanglel.
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The second display contains information about the orientatiagle) and size of the
region along the two principal directionsa andrb) of the region. With the combo box
shape, you can select by what means the size is computed. If you gdlecpse, the size

is computed with the operateilliptic_axis. This means that the parametetsand

rb are the major and minor axis of an ellipse that has the same moments as the selected
region. Note that this ellipse need not enclose the region. If yoshsgk to rectangle,

the size is computed with the operataiallest _rectangle2. This means, thata and

rb are half the width and height of the smallest rectangle with arbitrary orientation that
completely contains the selected region. The orientation of the region is computed in
both cases with the operaterientation region to get the full range of 360for the
angle. You can select whether to display the anglédgrees or radians with the
corresponding combo box.

The next three displays show simpler shape features of the selected region. The first of
these displays shows the contour lenght of the region, i.e., the euclidean length of its
boundary (see the operatosntlength). The second one shows the compactness of the
region, i.e., the ratio of the contour length of the region and the circumference of a circle
with the same area as the region (see the opetatgsactness). The compactness of

a region is always larger than 1. The compacter the region, the closer the value of the
compactness is to 1. The third display shows the convexity of the selected region, i.e.,
the ratio of the area of the region and the area of the convex hull of the region (see the
operatorconvexity). The convexity of a region is always smaller than 1. Only convex
regions will reach the optimum convexity of 1.

The last but one display shows shape features derived from the ellipse parameters of the
selected region, which are calculated with the operatoentricity. The anisometry

of the region is the ratio of the major and minor axis of the ellipse (i.e., the ratia of
andrb in the second display if you sehape t0o ellipse). This feature measures how
elongated the region is. Its value is always larger than 1, with isometric regions having
a value of 1. The definition of the more complex features bulkiness and structure factor
(abbreviated as structure in the display) can be obtained from the HALCON Reference
Manual.

The final shape feature display shows the connected components and number of holes of
the selected region, as computed by the operatatiect_and holes.

The gray value features are grouped into five displays on the right side of the region
inspection window. Again, they correspond roughly to individual HALCON operators.
The first display shows the mean gray value intensity and the corresponding standard
deviation of the selected region. These are computed with the operataisity.

The second display shows the output of the operatarmax_gray. This operator com-
putes the distribution (histogram) of gray values in the image and returns the gray values
corresponding to an upper and lower percentile of the distribution. This percentile can
be selected with the slider at the top of the display. For a percentile of O (the default),
the minimum and maximum gray values of the region are returned. The display also
shows the range of gray values in the region, i.e., the difference between the maximum
and minimum gray values.

In the third display, the gray value entropy of the selected region is displayed (see the
operatorentropy_gray). Again, this is a feature derived from the histogram of gray
values in the region. The feature entropy measures whether the gray values are distributed
equally within the region. This measure is always smaller than 8 (for byte images — the
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only supported image type for this operator). Only images with equally distributed gray
values reach this maximum value. The featan@sometry measures the symmetry of
the distribution (see the operatatisometry. Perfectly symmetric histograms will have

an anisometry of -0.5.

The fourth display contains gray value features derived from the coocurrence matrix of
the selected region are displayed (see the opetaiext_feature image). The combo

box 1d can be used to select the number of gray values to be distinguiglied The
combo boxdir selects the direction in which the coocurrence matrix is computed.
The resulting features — energy, correlation, homogeneity, and contrast — have self-
explanatory names. A detailed description can be found in the reference of the operator
cooc_feature_matrix.

The final display contains the output of the operaiatents_gray_plane. These are the
angles of the normal vector of a plane fit through the gray values of the selected region.

Dialog
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Figure 2.19: Configuration dialog for single region features.

Each of the gauges corresponding to a display can be configured to set the minimum and
maximum values for each gauge. Furthermore, the scaling function of the gauge can be
determined. This can be used to make the relation of the features of different regions more
intuitive. For example, features that depend on the area of the region are more intuitively
grasped when the scaling is setstfrt (x). The configuration dialog is the same for all
gauges, and is shown in figu2elQ It can be brought up by pressing the button next to
each gauge.

Visualization > Size Window
There are convenient methods to change the size of the active graphics window dependent
on the size of the previously displayed image. Using the subrbetgtinal, the window
is set to the same size as the most recently displayed image, that means, for each pixel of
the image one pixel on the screen is used for displaying. Similar to this, you can select
Original half or Original quarter to make the window half or a quarter as big as
the displayed image. The submertis#sf andDouble change the size of the graphics
window to half and double its current size, respectively, independent of the size of the
previously displayed image. You can combih&ible with Original. The submenu
Aspect changes the aspect ratio of the graphics window, so that pixels are displayed as
squares on the screen. For this operation, again the size of the previously displayed image
is used.

Visualization > Zooming
This is a convenient menu for manipulation of the zooming mode. The subreget
switches zooming off, i.e., an image will be displayed so that it fills the graphics window
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completely. The submendsom In andZoom Out apply a zooming “in” and “out” to the
image or region by a factor of two. Finally, there are two interactive modes to control
zooming:Draw Rectangle allows the specification of a rectangular part of the window
to be zoomed whil®raw Center allows the definition of a pixel coordinate that should
be at the center of the window (e.g., for a succesaieen In).

For more information see the melilsualization > Set Parameters... > Zoom.

Visualization > Colored
This is an easy way to display multiple regions or XLDs. Each region is displayed in a
different color, where the number of different colors is specified in the submenu. You can
choose between 3, 6 and 12 colors. If all regions are displayed with one color, you have
to use the operatatonnection beforehand. You can check this also with the operator
count_obj.

Visualization > Color
This item enables color specification to display segmentation results (regions and XLD),
text write_string) and general line drawings (e.g., 3D plots, contour lines, and bar
charts). The number of colors which are available in the submenu depends on the graph-
ics display (i.e., the number of bits used for displaying). After selecting a color, the pre-
viously displayed region or XLD object will be redisplayed with this color. The default
color is white.

Visualization > Draw
Here you can select a visualization mode to display region data. It can eitlidetie
(tem £i11) or thebordersare displayed only (itemargin). The border line thickness
of the displayed regions is specified using the menu itene Width (see figure2.21).

Visualization > Line Width
Here you determine the line width for painting XLDs, borders of regions or other types of
lines. You can select between a wide range of widths using the submenu. This parameter
is effective ifdev_set_draw iS set to modeargin only.

Visualization > Shape
Here you specify the representation shaperégions Thus you are able to display not
only the region’s original shape but also its enclosing rectangle or its enclosing circle.

Visualization > Lut
This menu activates different look up tables, which can be used to display gray images
and color images in different intensities and colors. In the case of a true color display the
image has to be redisplayed due to the missing support of a look-up-table in the graphics
hardware. For color images only the gray look-up-tables can be used, which change each
channel (separately) with the same table.

Visualization > Paint
This menu defines the mode to display gray images. For more information see the menu
itemVisualization > Set Parameters....

Visualization > Set Parameters...
By using this menu item, a dialog call®dsualization Parameters is opened, which
handles more complex parameter settings. Select one setting with your left mouse button
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Figure 2.20: Settings of parameter paint.

and the window brings up the according parameter box. Each box contains different
buttons, text fields, or check boxes to modify parameters.

Each box has aipdate button. If this button is pressed, every change of a parameter will
immediately lead to a redisplay of the image, regions, or XLD in the graphics window. If
the button is “off” the parameters become active for the next display of an object (double
click on an icon or excecution of an operator). By default the update is deactivated for
the boxed.ut andPaint.

You may specify the following parameter settings.

Visualization > Set Parameters... > Paint
Here you can select between several graphical presentations for images. Examples
arecontourline and3D-plot. In the default mode the image will be displayed as
a picture (see figurg.20.

If you have chosen a presentation mode, the window displays all possible parameters

you may modify. For example, after selecting the it&hrplot you have to specify
the following parameters:

Step (the distance of plot lines in pixels),

Colored (use the gray value of a pixel to draw a line segment instead of one
graphic color),

Eye height,

Eye distance (view point),
Scale (height of 3D plot),
Row and

Column (position of the center).

Visualization > Set Parameters... [ Pen
Here the display modes for regions and XLDs are specified. You can select the color
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Figure 2.21: Settings of parameter pen.

(single or multiple), the drawing mode (filled or border), the line width for border
mode and the shape of the regions.

You can select up to 12 colors by clicking the appropriate checkbox. They are used
to emphasize the connectivity of different regions in the graphics window. If you
choose a single color presentation you may specify this color by selecting it in the
list box (see figure.21).

With the parameter shape (defaultoisiginal) you may specify the presentation
shape for regions. Thus you are able to display not only the region’s original shape
but also its enclosing rectangle or its enclosing circle, etc.

For regions thelraw modecan be specified: Either it might biled (item £111)

or thebordersare displayed (itemmargin) only. The border line thickness of the
presented regions is specified with help of the menu iberder width. This
menu isvisible onlyif the draw mode is set teargin, because in the draw mode
fill this parameter has no effect.

Visualization > Set Parameters... > Zoom

The menu item specifies which part of an image, region, XLD, or other graphic
item is going to be displayed (see figte22). The upper left four text fields spec-

ify the coordinate systemleft/upper defines the pixel which will be displayed

at the upper left corner of the windowower/right defines the pixel which will

be displayed at the lower right side of the window. By selecting the upper button
Interactive... Yyou specify a rectangular part in the graphics window interac-
tively. For this, you press the left mouse button to indicate the rectangle’s upper
left corner. Hold the button and drag the mouse to the lower right corner’s position.
Release the button and correct the size by grabbing the borders or corners of the
rectangle. By pressing the right mouse button inside your specified rectangle you
display the objects inside the rectangle in the graphics window.

You also have the possibility to enter the coordinates of the desired clipping manu-

ally. In order to do so you have to specify the coordinates of the upper left corner

and the lower right corner in the respective text fields. Please note that the text fields
sometimes behave unexpectedly.
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Figure 2.22: Settings of parameter zoom.

Below the coordinates of the rectangle you see its center. This center can also be
specified interactively using the buttdmteractive. ... Activating this mode,

you first have to click with the left button into the active graphics window. Now you
can correct this position by again pressing the left mouse button. To quit, press the
right mouse button.

The buttonZoom Out andZoom In activate a zooming with factor 2 or 0.5, respec-

tively.
To get the image’s full view back on your graphics window you simply click the
checkboxReset.

Visualization > Set Parameters... > Lut

UsingLut you are able to load differetwok-up-tabledor visualization (see figure
2.23. With the help of a false color presentation you often get a better impression
of the gray values of an image. In the case of a true color display the image has to
be redisplayed due to the missing support of a look-up-table in the graphics hard-
ware. For color images only the gray look-up-tables can be used, which change each
channel (separately) with the same table.

2.3.2.5 The Menu Item QOperators

This menu item comprises all HALCON and HDevelop operators including the HDevelop con-
trol constructs. In the following you will see a description of all items to select.

Operators > Control
Here, you may select control structures for the program.  This involves the execution
of a program segment (henceforth named body) depending on aifeahd ifelse)
and the repetition of a program segmefdx, while, andbreak). Furthermore, you
may stop the program’s execution at any positiotop) or terminate HDevelopekit).
The operatorassign andinsert do not influence the execution, but serve to specify
values for control data (assignment). The operataiment is used to add a comment,
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Figure 2.23: Settings of parameter lut.

that means any sequence of characters, to the program. The corresponding menu is shown
in figure2.24

1 HDevelop - break_while_dev [_ (O] x|
File Edit Execute Wisualization Qa8 Suggestions ‘wWindow  Help

O] &(me-] EEXE - (e o]

Develop F inzert
Classification »  if
File r o ifelze
il e
Graphics ¥ while
mege |1
Lines F ztop
Clear tatching L=
Morphalogy » comment
Obiect 4
Regions 4
Segmentation »
System »
Toolz 4
Tuple »
KLD »

Control structure

Figure 2.24: Menu item Control.

Selecting a menu item displays the corresponding control construct in the operator win-
dow, where you can set the necessary parameters. After specifying all parameters you
may transfer the construct into your program. A direct execution for loops and conditions
is not possible, in contrast to other HDevelop and HALCON operators, because you have
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to specify the loop’s and condition’s body first to obtain useful semantics. If necessary,
you may execute the program after the input vittep or Run. The insertion cursor is
positioned after the construct head to ensure the input of the construct’s body occurs in
the correct place. This body is indented to make the nesting level of the control constructs
visible, and thus to help you in understanding the program structure (see2i@deTo

get an idea how to use loops, you may look at the example session in se&i@mnd

at the programs in chaptebs3, 5.8and5.9. The semantics for loops and conditions are
shown in chapteB.7.

i\ Program _ (O] x|

dev_open_windowe (0, 0, Wicth, Height, 'black’, WindowID) -
dev_zet_drawe (fill')
wp |dev_zet_part (0, 0, Height-1, Width-11
threshold (Image, Region, 128, 255)
dew_zet_colar ("white”
connection (Region, ConnectedRegions)
zelect_shape (ConnectedRegions, CompactRedions, 'compactness’, 'and', 1.5, 1.8)
Mumber ;= [CompactRedions)|
gen_empty_obj (Eves)
far i =1 to Mumber by 1

SingleSelected ;= CompactRegions[i]

area_center [(SingleSelected, Area, Rowe, Column)

dev_zet_color ('greent
@ if ((Ares = 5000 and (Area = S00007)

dev_zet_colar ('red’)
Eyes = [SingleSelected Eves]

endif
endfor
dev_display (Image)
dev_zet_colar ('red") ;I

-

Figure 2.25: Example for using a for loop.

The operatomssign serves as an assignment operator for control variables (numbers
and strings). Analogously to “normal” operators the input is made in the operator win-
dow by specifying both “parameterghput andResult (i.e., right and left side of the
assignment). An instruction in C, e.g.,

X =y + z;

is declared inside the operator window as
assign(y + z,x)

and displayed in the program window by

X 1=y + z

The operatoinsert implements the assignment of a single value (tuple of length 1) at a
specified index position of a tuple. Thus an array assignment (here in C syntax)

ali] = v;
is entered as
insert(a,v,i,a)

in the operator window, and is displayed as
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ali] := v

in the HDevelop program window.

The operatorstop andexit are used to terminate the program. More precissiyp
interruptsan execution andxit terminatesHDevelop. Having interrupted the execution
you may continue the program by pressiigep or Run. This is useful, e.g., in demo
programs to install defined positions for program interruption. Under UNIX, you can
useexit in combination with a startup file and the optienun (see sectiod.2). Thus,
HDevelop will not only load and run your application automatically, but also terminate
when reachingxit.

The operatoromment allows to add a line of text to the program. This text has no effect
on the execution of the program. A comment may contain any sequence of characters.

Operators > Develop
This menu contains several operators that help to adapt the user interface. These operators
offer the same functionality that you have using mouse interaction otherwise. They are
used to configure the environment without (or with little) user interaction. Using these
operators, the program performs actions similar to the setting of a color in the parameter
window (see sectio2.7), opening a window in the menu bar (see sect0®.2.4 or
iconifying the program window with the help of the window manager. All operators in
this menu start with the prefizev_. It has been introduced to have a distinction to the
underlying basic HALCON operators (e.dsv_set_color andset_color). You can
find the complete listing in figurg.26

i HDevelop - O] x|
File Edit Execute Wisualization JEJEEtie
EEBREEY
T

i Wanable Watch Al :

Op Graphics

| LS - Graphics Winda e

Lines

Suggestion:  Window Help

LControl
Develop

dev_clear_window
dev_set window
dev_zet_colored
dev_zet_draw
dev_zet_line_width

*
»
»
»
»
»
= Morphologe  » dew_set_colar
L3
»
*
»
»
»

Object dev_zet_[ut
Regions dev_zet_paint
S egmentation dev_set_shape
System dev_zet_part
Tools dev_dizplay
#LD dev_inzpect_ctrl
dev_cloze_inspect_ctil
dev_map_par
dev_unmap_par
dev_map_war
dev_unmap_var
dev_map_prog
dev_unmap_prog
dev_update window
dev_update war
dev_update_time
dev_update pc
dev_ermor_var
dev_zet_check

Internal HDevelop Qperator

Figure 2.26: Operators in menu item Develop.

The effects of each operator are described as follows:
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e dev_open_window, dev_close_window, dev_clear_window
The operatorsiev_open_window anddev_close_window are used to open and to
close a graphics window, respectively. During opening, the parameterization allows
you to specify the window’s size and position. The operai®r_clear window
clears the active window’s content and its history. This corresponds to the usage
of the buttonClear in the graphics window. Please note tldatr_open window
anddev_close_window are not supported for Visual Basic export because here one
HWindowXCtrl is used.

e dev_set_window_extents
With this operator, you can set the size and position of the active HDevelop graphics
window.

e dev_set_window
This operator activates the graphics window containing the given ID. This ID is an
output parameter afev_open_window. After the execution, the output is redirected
to this window. This operator is not needed for exported code in C++, because here
every window operation uses the ID as a parameter. The operator has no effect for
exported code in Visual Basic.

e dev_set_color, dev_set_colored
dev_set_color has the same effects as the menu iteualization > Color.
dev_set_colored is equal to the menu itefisualization > Colored.

e dev_set_draw
This operator has the same effect¥asualization > Draw.

e dev_set_line_width
For an explanation see iteisualization > Line Width.

e dev_set_lut
For an explanation see iteMisualization > Lut.

e dev_set_paint
For an explanation see itefiisualization > Paint. If you want to specify all
possible parameters of a given paint mode, you have to specify them as a tuple,
analogously to the HALCON operateet_paint.

e dev_set_shape
For an explanation see iteisualization > Shape.

e dev_set_part
This operator adjusts the coordinate system for image, region, XLD and other
graphic output. This is done by specifying the upper left and the lower right corner
coordinates. This specified part is shown in the entire graphics window. If the width
or height of the specified rectangle has a negative value gagl, > Row2) the
result is equivalent to the menisualization > Zooming > Reset: the zoom
mode is switched off, i.e., th@ost recenthdisplayed image fills the whole graph-
ics window. This feature odlev_set_part is not supported for exported C++ and
Visual Basic code.

e dev_display
Iconic variables are displayed in the active graphics window by this opera-
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tor. It is reasonable to do this when the automatic output is suppressed (see
dev_update _window andFile > Options... On pagelo).

dev_clear_obj

This operator deletes the iconic object stored in the HDevelop variable that is passed
as the input parameter. In the variable window, the object is displayed as undefined
(with a? as its icon).

dev_inspect_ctrl

This operator opens an inspection window displaying the values of the variable
passed to the operator. In most cases a list dialog is opened, which slhealsies

of the variable. In the case of a frame grabber handle, a description of this frame
grabber is opened. In addition, this dialog allows online grabbing of images. This
operator is not supported for exported C++ and Visual Basic code.

dev_close_inspect_ctrl
This is the opposite operatordev_inspect_ctrl, and closes the inspect window.
This operator is not supported for exported C++ and Visual Basic code.

dev_map_par, dev_unmap_par

These operators open and close the parameter dialog, which can also be opened us-
ing the menwisualization > Set Parameters.... This operator is not sup-
ported for exported C++ and Visual Basic code.

dev_map_var, dev_unmap_var

These operators iconify the variable windaé{_unmap_var), and retransform the
iconified window to the normal visualization size, respectivabg(map_var). This
means that the variable window always remains visible on the display in one of the
two ways of visualization. These operators can be executed with the help of the
window manager. These operators are not supported for exported C++ and Visual
Basic code.

dev_map_prog, dev_unmap._prog

Analogously todev_map_var anddev_unmap_var, these operators iconify or de-
iconify the program window. These operators are not supported for exported C++
and Visual Basic code.

dev_update_window, dev_update_var, dev_update_time, dev_update_pc

Using these operators, you may configure the output at runtime. It corresponds to
the settings in mendisualization > Options. .. (See pag@5). These operators

are not supported for exported C++ and Visual Basic code.

dev_set_check

This operator is equivalent teet_check of the HALCON library. It is used to
handle runtime errors caused by HALCON operators that are executed inside HDe-
velop. The parameter valugive_error’, which is the default, leads to a stop

of the program together with an error dialog if a value not equal M8$G_TRUE is
returned. Using the valu&™give_error’, errors or other messages are ignored
and the program can continue. This mode is useful in connection with operators
like get mposition, file exists, read image, Or test_region point, which

can returri_MSG_FAIL. An example can be found on pafj&3

dev_error_var
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This operator specifies a variable that contains the return value (error code) of an
operator after execution. This value can be used to continue, depending on the
given value.dev_error_var is normally used in connection wittev_set_check.

An example how to uséev_error_var in connection withdev_set_check can be

found in

%HALCONROOT%\examples\hdevelop\Graphics\Mouse\get_mposition.dev .

Please note that operations concerning graphics windows and their corresponding op-
erators have additional functionality as HALCON operators with corresponding names
(without dev_): graphics windows in HDevelop are based on HALCON windows (see
open_window in the HALCON reference manual), but in fact, they have an enhanced
functionality (e.g., history of displayed objects, interactive modification of size, and
control buttons). This is also true for operators that modify visualization parameters
(dev_set_color, dev_set_draw, etc.). For example, the new visualization parameter

is registered in the parameter window when the operator has been executed. You can eas-
ily check this by opening the dialo@isualization > Set Parameters... > Pen

and apply the operatdev_set_color. Here you will see the change of the visualization
parameters in the dialog box. You have to be aware of this difference if you edpast

to C++ and Visual Basic code.

In contrast to the parameter dialog for changing display parameters like color, the cor-
responding operators (likeev_set_color) do not change to contents of the graphics
window (i.e., they don’t cause a redisplay). They are used to prepare the parameters for
thenextdisplay action.

Operators > Classification, File,
In the following items, you can find all HALCON operators, arranged in chapters and
subchapters. This set of image analysis operators forms the most important part of HAL-
CON: the HALCON library. HALCON operators implement the different image analysis
tasks such as preprocessing, filtering, or measurement (seeZigiye

You may look for a detailed description of each operator in the HALCON reference
manual*

The menu has a cascade structure, according to the chapter structure of the HALCON
reference manual. As this menu has to be built up after opening the program window, it
might take some time until it is available. During the build-up time the menu is “grayed
out”. Selecting a chapter of the menu opens a pulldown menu with the corresponding
subchapters or operators, respectively.

This operator hierarchy is especially useful for novices because it offers all operators
sorted by thematic aspects. This might be interesting for an experienced user, too, if he
wants to compare, e.g., different smoothing filters, because they reside in the same sub-
chapter. To get additional information, a short description of an operator (while activating
its name in the menu) is displayed in the status bar (see fiydie

Note, that some operators are visible in the menus but cannot be selected, e.g.,
open_window (in Operators > Graphics > Window) Orreset_obj_db (in Operators
> System > Database) . In the case of most of these operators, you should use the cor-

4Operators of the menuntrol andDevelop are special operators of HDevelop. Thus you will not find
them in the reference manuals.
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Figure 2.27: Menu hierarchy of all HALCON operators.

respondingevelop operator (e.g.dev_open_window instead ofopen_window) within
HDevelop. Some operators, exgset_obj_db, cannot be called at all within HDevelop.

2.3.2.6 The Menu Item Suggestions

This menu shows you another possibility how to select HALCON operators. But here they are
proposed to you in a different manner. It is assumed that you have already selected or executed
an operator in a previous step. Depending on this operator, five different suggestions are offered.
Figure2.28shows possible successor suggestions for operatar image.

Suggestions are separated into groups as follows:

Suggestions > Predecessor
Many operators require a reasonable or necessary predecessor operator. For example be-
fore computing junction points in a skeletojufictions_skeleton), you have to com-
pute this skeleton itselkkeleton). To obtain a threshold image you have to use a low-
pass filter before executing a dynamic threshdlgh(threshold). Using the watershed
algorithms gatersheds), it is reasonable to apply a smoothing filter on an image first,
because this reduces runtime considerably.
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i HDevelop

File Edit Ezecute “isudlization Operators [EEaREREE "Window Help

Dl@lnl "X’llﬁlnl || Altemnatives > Ellml@l

— ———— ———  fSeedw 3

Prececessor »

Sy Y dizp_image

socess
| Kepwards. threshold

Operatar: I read_image T iegiongowing
count_channels

decomposed
Image I Imge class_ndim_norm ject]

|»

gauss_image
FileMame | abrik fil_interlace

zoom_image_size
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crop_park
write_image
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| hMoegliche Machfolge-Prozedur

Figure 2.28: Suggestions to select a successor of HALCON operator read_image.

Suggestions > Successor
In many cases the task results in a “natural” sequence of operators. Thus as a rule you
use a thresholding after executing an edge filter or you execute a region processing (e.g.,
morphological operators) after a segmentation. To facilitate a reasonable processing all
the possible operators are offered in this menu item.

Suggestions > Alternatives
Since HALCON includes a large library, this menu item suggests alternative operators.
Thus, you may, for example, replagean_image with operators such aguss_image,
sigma_image, Of smooth_image.

Suggestions > See also
Contrary toAlternatives, operators are offered here which have saoenectionto
the current operator. Thus, the median filiesdian_image) is not a direct alternative to
the mean filterfean_image). Similarly, the regiongrowing operatardgiongrowing) is
no alternative for a thresholding. In any case, they offer another approach to solve a task.
References might consist of pure informative nature, too: the opegatoilowpass,
which is used to create a lowpass filter in the frequency domain, is a reasonable reference
to a Gaussian filter.

Suggestions > Keywords
This menu item gives access to HALCON operators by using keywords which are asso-
ciated with each operator. You get a window, divided into two parts, which contains all
keywords on the left hand side and the selected operators on the right (se f&fire

After the suggestions for an operator have been generated, all keywords belonging to this

HALCON 6.0.4



44 CHAPTER 2. GRAPHICAL USER INTERFACE
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Figure 2.29: Operator suggestions according to keyword “Clipping”.

operator are marked (reversed) on the left hand side of the wihddmthe right side you

will find all operators associated with at least one of these keywords. Clicking a keyword
on the left list causes the addition of operators belonging to this keyword. If you want to
transfer one of these operators to the operator dialog area, you click one of them with the
left mouse button. Afterwards the selection window is closed.

2.3.2.7 The Menu ltem Window

This menu item offers support to manage your four windows, i.e., the program, operator, vari-
able and graphics window. They are very useful while working with HDevelop. You see the
items in figure2.30 This menu item is not supported in a UNIX environment, because ac-

cording to the X-Windows style we don’t have a main window with a functionality similar to
Windows.

Window > Cascade

By pressing this item, HDevelop arranges the four windows in a cascade as you can see
in figure2.30Q

Window > Tile

When selecting this item, you see all four windows inside the main window. They have
the same size and fit exactly in the main window. Thus, you get a global view of the
windows’ contents at once. Notice that the four windows may shrink depending on their
size to fit in the main window. Figur.31shows you the effect using this item.

Window > Arrange Icons

As in every system using windows, you are able to iconify and deiconify your windows.
You may even move your icons on the display. This might create a confusing working en-
vironment if you are handling several graphics tools simultaneously. To get the HDevelop
icons back on top of the main window’s status bar you just have to press this button.

5Because there are many entries in the left keyword list, you may see all marked keywords only by scrolling it.
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Figure 2.30: Window management functions.

Window > Next
By using this item you bring the top window in the background. Hence it looses its
window focus. The window to get the window focus and to become the top window is
the window which was only hidden by the former top window.

If you use one of the next four item®f{ogram Window, Operator Window, Variable
Window andGraphics Window) the specified window will become the top window and gets
the window focus.

2.3.2.8 The Menu Item Help

Here you may query information about HALCON itself and all HALCON and HDevelop oper-
ators.

Help > About...
The menu itemHelp > About... delivers information about the current HALCON
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Figure 2.31: The window management function Tile.

version (see figur@.32. Furthermore, it lists host IDs detected by the license manager
(see the manu#betting Started with HALCON for more information).

About HDevelop E

@ HALCOM - Yersion B.0.

HDevelop - Yersion 3.1.

M Tec Software GrabH

Munich, Germary

L myvtec. com

@ 1996-2000 MY Tec Software GrmbH

The hostids of this computer are
00e02958e36a, 0003-C10E-01C3-E7IF, FLEXID=7-36c73bd7

Figure 2.32: Information about the current HALCON version.
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Help > HALCON Operators
The next menu item iHelp > Halcon Operators. This help is based on an HTML
browser (see chapté:3). The browser will display the main page of all HALCON and
HDevelop operators. It is quite easy for you to browse through this operator menu and
to find the desired operator.

Another possibility of requesting information about the current operator is pressing button
Help inside the operator window (see pa&af@).

Help > HDevelop Language
The menu itentielp > HDevelop Language starts the HTML browser with a descrip-
tion of the language, similar to chapt@of this manual.

Help > HALCON News (WWW)
The menu itenHelp > HALCON News (WWW)lets you check for the latest news about
HALCON on MVTec’'s WWW server, e.g., whether new extension packages, frame grab-
ber interfaces, or HALCON versions are available.

2.3.3 Tool Bar

You use most icons in this tool bar to accelerate accessing important HDevelop features. These
are features which you are performing many times while working with HDevelop. Hence there
are buttons to handle your HDevelop programs and to edit them. The most important buttons
are used to start and to stop a program (or parts of a program). These icons are explained in
figure2.34

D|=@] & [Ele] | FUEkE] EElE G Sl nE)

Figure 2.33: The HDevelop tool bar.

2.3.4 Window Area

The window area contains all necessary windows to show your HDevelop programs, to visual-
ize your iconic and control results, and to specify any operator’s parameters. Additionally, you
may open as many graphics windows as you want to get a detailed view of your iconic results.

You are free to move the windows according to your needs and preferences inside this area. You
may iconify and/or deiconify them. To handle these windows in a comfortable way, HDevelop
supports you with some window management functions 2sg.7.

2.3.5 Status Bar

The status bar at the bottom of the program window shows you information which is important
while working with HALCON, e.g., context sensitive information about a specific user action
or the operator runtime (if time measurement has not been deactivated).
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These icons are shortcuts for the menu itéike > New,
File > Load, andFile > Save in the menu bar. For a
detailed description, see patyaff.

These icons are shortcuts for the menu itéaist > Cut,
Edit > Copy, Edit > Paste, andEdit > Undo in the
menu bar. For a detailed description, see ki

s

G
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These icons are shortcuts for the menu itéirscute >
Run, Execute > Step andExecute > Stop in the menu
bar. For a detailed description, see pag.

& E= 1D
m

These icons are shortcuts for the menu itebagcute
> Activate, Execute > Deactivate, and Execute >
Reset Program in the menu bar. For a detailed descrip-
tion, see pagé@iff.

]
i
mi

This icon is a shortcut for the menu iteémsualization
> Set Parameters... in the menu bar. For a detailed
description, see padzSff.

‘Eh'lTHl {El These icons are shortcuts for the menu items
- Visualization > Pixel Info..., Visualization
> Zooming. . ., Visualization > Gray Histogram
Info...,andVisualization > Region Info... inthe
menu bar. For a detailed description, see [2je

v

Figure 2.34: The different parts to the HDevelop toolbar.
2.4 Program Window

The program window is divided into two areas. The left one (a small column) contains the
program counterpPC, represented as a green arrow pointing to a program line), the insertion
cursor (a triangle between two program lines) and optionally one or breek point{BP — a

red STOP sign). You may position or activate these three labels as follows:

e ThePC is set by pressing the left mouse button only.
e The insertion cursor is set by pressing the left mouse button andtigt> key.

e A BPis set by pressing the left mouse button and<tierl> key.

The program counter resides in the line of the next operator to execute. The insertion cursor
indicates the position to insert a new program line. A break point shows the program line before
which the program is stopped. Clicking on a break point again while pressingtha> key
deletes it. A break pointis active only if it is visible. In figuze35you see a program and the
column with thePC (indicated as an arrow),BP and the insertion cursor.

By clicking into the column on the left with the right mouse button you can open a context
menu, which contains shortcuts to some of the actions of the nearits e.g., copy and paste

lines, ancExecute, e.g., activate and deactivate lines or set and clear break points. Please note
that these actions behave slightly differently than their counterparts in the main menus: When
called via the main menus, the actions are performed only on the selected part of the program; if
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zelect_shape (ConnectedRegions, CompactRegions, 'compactness’, "and', 1.5, 1.8)
Mumber ;= |CompactRegions|
gen_empty_abj (Eves)
far i =1 to Mumber by 1

SingleSelected ;= CompactRegions[i]

ares_center (SingleSelected, Area, Rowe, Column)
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Eves := [SingleSelected Eyes]

endif
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Figure 2.35: Program example with the PC (the arrow pointing to the right), insertion cursor and
a break point (BP).

nothing is selected, no action is performed. In contrast, when an action is called via the context
menu and no line is selected in the program, the action is performed for the line onto which you
clicked with the right mouse button.

The big text area at the right side of the program window contains the program code of the
HDevelop program. Here the user has the possibility to obtain information about the inserted
operators. A program is built up such that every line contains exacioperator with its
parameters or an assignment. An exception are the condition constfuantslifelse respec-

tively, and the loop construcigiile andfor. They contain two, in case afelse even three,

program lines, which enclose the body. Every line starts with an operator name, which is in-
dented if necessary, to highlight the structure created by the above mentioned control structures.
After the operator name the parameters are displayed in parentheses. Parameters are separated
by commas.

The program window is used tasualizeprogram lines, but not to modify them. You cannot
change a program by modifying the text directly. Editing the program text in HDevelop is done
in theoperator window(this will be described below). The main reason for this principle is the
advantage of providing sophisticated help. Thus you are able to avoid many input errors.

To edit a line of a program you chose an operator in the program window by clicking the left
mouse button twice. In case of conditions and loops it is unimportant which linesfiergor
endfor) are selected. In any case, the head with its parameters is selected. You may edit only
oneoperator at a time.

Besides editing the parameters of a single operator, single and multiple lines can be deleted,
cut, or pasted in one step using simple mouse functions. To use this feature, one has to select
one or more lines using the mouse:

e The selection obneline is done by clicking on it. Previously activated lines will then
become deactivated.

e To activate more than one line you have to press<tterl> key while clicking on the
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line. If the line is already activated it will become deactivated, while the state of all other
lines remains unchanged.

e The<Shift> key is used to activate a sequence of lines using one mouse click: All lines
between the most recent activation and the new one will become activated.

After the selection of lines, the edit function can be activated by either using the Edenu
(see sectiong.3.2.9 or the tool bar (see sectio2s3.3. Further information on the use of the
mouse can be found in secti@.

2.5 Operator Window

This window is mainly used to edit and display an operator and all its parameters. Here you

will obtain information about the number of the operator’'s parameters, the parameter types,

and parameter values. You are able to modify the parameter values according to your image
processing tasks. For this you may adopt the proposed system values or specify your own
values.

The operator window consists of the following three parts:
e The first one is the operator text field.

e The second one is the largest part. It is called parameter display and is used to edit the
parameters of an operator.

e The last one is a row of buttons to control the parameter display.

2.5.1 Operator Name Field

The operator name field is another possibility to select operators. You simply have to enter a
substring of an operator name. By pressiRgturn> or pressing the button of the combo box

the system is looking for all operators (in the méperators) that contain the user-specified
substring (see figur.36. If there is an unambiguous search result, the operator is displayed
immediately in the operator window. If there are several matching results, a combo box opens
and displays all operators containing the specified substring. By clicking the left mouse button
you select one operator and the combo box disappears. Now the operator’s parameters are
shown in the operator window.

If you are already more familiar with HDevelop, it is reasonable to select an operator in the
operator name field. However, in order to do so, you obviously have to be familiar with the
operator names.

2.5.2 Parameter Display

The parameter display is the main part of the operator window. It is empty in its initial state.
If you have selected an operator, HDevelop displays the operator’s parameter data, i.e., name,
number, type, and default values, in the display.

e In the first column of the operator window you find the parameter names.
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Figure 2.36: Operator selection in the operator name field.

e The second column consists of the text fields, which contain variable names in case of
iconic and control output parameters and expressions in case of control input parameters.
If you want to change the suggestions offered by the system (variable names or default
values) you may do so either manually or by pressing the arrow button connected with the
respective text field. This opens a list containing a selection of already defined variables
and other reasonable values from the operator knowledge base. By clicking the appropri-
ate item you set the text field and the list disappears.

e The third column indicates the parameter’s default type in parentheses. This is a raw hint
for the user, what types of data have to be specified for each operator.

Please refer to the following rules on how parameters obtain their values and how you may
specify them:

Iconic input parameters:
These are the only parameters that do not have any defaults. You have to make sure that
there is an input. Possible inputs are iconic variables of the corresponding list. If there is
no need to execute the operator immediately, you may even specify new variable names,
i.e., names, that do not already exist in the variable window, but will be instantiated
later by adding further operators to the program. In any case you have to specify iconic
parametergxclusively with variable namek is not possible to use expressions.

Iconic output parameters:
These parameters contain default variables, which have the same names as the param-
eters themselves. If a variable with the same name as the output parameter is already
being used, a number is added to the name to make it unique. Because the parameter
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names characterize the computed result very well, you may adopt these default names in
many cases. Besides this, you are free to choose arbitrary names either by yourself or by
opening the list (see above). If you use a variable that already has a value, this value is
deleted during execution before overwriting it with new results. It is possible to specify a
variable both in an input and output position.

Control input parameters:

These parameters normally possess a default value. In particular, this is to support novices
selecting an appropriate value. As an alternative, you may use the text field’s button to
open a combo box and to select a value suggestion. In addition, this combo box contains
a list of variables that contain values of the required type. A restriction of proposed
variables is especially used for parameters that contain data like file, frame grabber, or
ocr handles.

Input control parameters may contain constants, variables, and expressions. Common
types are integer numbersnfteger), floating point numbersreal), boolean values

(true andfalse) and character strings€ring). You are able to use multiple values

of these types at once. This is done by usingttihme type This is an enumeration of
values, separated by commas and enclosed in brackets. Furthermore, you may build up
expressions with these values. The possibilities of using tuples are very extensive. You
may use expressions in HDevelop similar to the use of expressions in C or in Pascal. You
will find a more detailed description in sectiBrb.

Control output parameters:

These parameters are handled in the same way as output object parameters. Their de-
faults are variables, named with their parameter names. Other possibilities to obtain a
control output variable name are either using the combo box or specifying variable names
manually. You cannot use any expressions for these parameters, either.

After discussing what can be input for different parameters, it is expldwogdthis is done.
Nevertheless, you have to keep in mind that you need to modify a parameter only, if it contains
no values or if you are not satisfied with the HALCON default values.

Text input:

To specify a parameter using your keyboard is the simplest but not the most often used
method. Here you have to click into a text field with the left mouse button. This activates
the field and prepares it for user input. Simultaneously, the writing position is marked
by a vertical bar. Now you may input numbers, strings, expressions, or variables. There
are some editing functions to help you doing inpgBackspace> deletes the left and
<Delete> deletes the right character. You may also select (invert) a sequence of charac-
ters in the text field using the mouse. If there is a succeeding input, the marked region is
going to be deleted first and afterwards the characters are going to be written in the text
field. You can find additional editing functions on padk9.

Combo box selection:

Using this input method, you can obtain rapid settings of variables and constants. To do
so, you have to click the button on the text field’s right side. A combo box is opened,
in which you may select an item. Thus you are able to choose a certain variable or
value without risking erroneous typing. This item is transferred to the operator name
field. Previous entries are deleted. Afterwards the combo box is closed. If there are no
variables or appropriate values, the combo box remains closed.
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2.5.3 Control Buttons

Below the parameter edit fields you find four buttons that comprise the following functions (see
figure2.37):

i Dperator M= &1
Jperatar; Iselect_shape j
e
Regions IREgiDn j (region § object) ol
SelectedRegions ISEIEDtEdREgiDnS j (region [ object)
Features I'area' j [=tring]
Operstion I'and' j [=tring)
Miri |1SD | (rean
It |99999 j (real)
Ok | Enter Cancel | Apply | Helg |
=
1| | B

Figure 2.37: Operator window with operator select_shape.

0K
By clicking OK you execute the operator with the specified parameters. In doing so,
the execution mode is dependent on the position ofpthelf the PC is placed above
the insertion position, the system computes the program frore¢hentil the insertion
position first. Thenthe operator that has been edited in the operator window is executed.
The reason for this is that the parameter values that are used as input values for the new
operator have to be calculated. In caseR@és placed at or after the insertion position,
this operator is executed only. Before execution the operator is entered into the program
window. ThePC and the insertion cursor are positioned after the new operator. The
computed output parameter values are displayed in the variable window. Iconic variables
are shown in the current graphics window, if you haven’t suppressed this option (see page
25). Afterwards the operator window is cleared. If you did not specify all parameters or
if you used wrong values, an error dialog is raised and execution is canceled. In this case,
the operator window remains open to support appropriate changes.

Enter
By clicking the buttorEnter the program line is only transferred in the program window.
There is no operator execution, i.e., the position off@és not changed. The insertion
cursor is positioned after the new operator.

Apply
If you click Apply the operator is executed with the specified parameters, but not entered
into or changed in the program. This enables you to determine the optimum parameters
of an operator rapidly since the operator dialog remains open, and hence you can change
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parameters quickly. Unlike the butto#, only the single line you edit or enter is executed,

no matter where thec is located. Thus, you have to ensure that all the input variables
contain maningful values. By pressiagply, the corresponding output variables are
changed or created, if necessary, to allow you to inspect their values. If you decide to
not enter the line into the program, some unused variables may thus be created. You can
easily remove them by selectifigle > Cleanup.

Cancel
Clicking Cancel clears the contents of the operator window. Thus, there are neither
changes in the program nor in any variables.

Help
Clicking Help invokes an appropriate help text for the selected operator. For this the
system activates an HTML-browser (see chapt8).

2.6 Variable Window

There are two kinds of variables in HALCON. This corresponds to the two parameter types of
HALCON: iconic objects (images, regions, and XLDs) and control data (numbers, strings). In
HALCON the corresponding variables are called iconic and control variables. These variables
may possess a value or be undefined. An undefined variable is created, for example, when load-
ing a program or after inserting an operator with a new variable that is not executed immediately
into a program. You may access these undefined variables by writing them only. If you try to
read such a variable, a runtime error occurs. If a variable obtains a value, the variable type is
specified more precisely. A control variable that contains, for example, an integer is of type
integer. This type might change after specification of new values for this variahlead or

a tuple ofinteger. But it always remains a control variable. The more refined type is bound
to the value and not to the variable. Similarly, this is the case for iconic variables, which may
contain regions, images, or XLDs. You may assign new values as often as you want to. But you
cannot change them to the state before the first assignment (see above).

Creation of a new variable happens in the operator dialog area during specification of operator
parameters. Here every sequence of characters without single quotation marks is interpreted as
a variable name. If this name did not exist before, the variable is created in the operator dialog
area by pressingK or Enter. The variable type is specified through the type of the parameter
where it was used for the first time: Variables that correspond to an iconic object parameter
create an iconic variable; variables for a control parameter create a control variable. Every time
an operator is excecuted the results are stored in variables connected to its output parameters.
This is done by first deleting the contents of the variable and then assigning the new value to it.

The variable window is a kind of watch window used in window-oriented debuggers. Inside
this window you are able to keep track of variable values. Corresponding to the two variable
types, there are two areas in the variable window. One for iconic data (above) and the other for
control data (below) (see figug38).

All computed variables are displayed showing their iconic or control values (se€lpagk
case of a tuple result which is too long, the tuple presentation is shortened, indicated by three
dots.
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Figure 2.38: Variable window for both iconic and control data.

2.6.1 Area for Iconic Data

Here you can see iconic variables. They are represented by icons, which contain a gray image,
a region or an XLD, depending on the current value. The icons are created depending on the
type of data according the following rules:

¢ In the case of images the icon contains a zoomed version of it filling the icon completely.
Due to the zooming onto the square shape of the icon the aspect ratio of the small image
might be wrong. If there is more than one image in the variable, onlyitstamage is
used for the icon. Similarily for multi channel images only fitst channel is used.

e Regions are displayed by first calculating the smallest surrounding rectangle and then
zooming it so that it fills the icon using a border of one pixel. In contrast to images, the
aspect ratio is always correct. This can lead to black bars at the borders. The color used
to draw the region is always white without further modifications (except zooming).

e XLD data is displayed using the coordinate system of the largest image used so far. The
color used for XLD objects is white on black background.

Due to the different ways of displaying objects you have to be aware that the coordinates cannot
be compared. The variable name is positioned below each icon. They are displayed in the
variable window in the order of creation from left to right. If there is not enough space, a
horizontal scrollbar is created, which you can use to scroll the icons.

Clicking on an icon with the mouse will select this icon. This is indicated by the black back-
ground for the icon name. For an activated icon all operators that use the corresponding variable
are marked in the program area with a black rectangle on the left.

Double-clicking with the left mouse button on an icon displays the data in the active graphics
window. If you use images of different sizes in a program, the system uses the following output
strategy for an automatic adaption of the zooming: Every window keeps track of the size of
the most recently displayed image. If you display an image with a different size, the system
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modifies the graphics window coordinate system in a way that the image is visible completely
in the graphics window. If a partial zooming has been activated before (see cRaptet is
going to be suppressed.

Normally, regions, images, and XLDs are represented in variable icons. Besides this there are
three exceptions which are shown by special icons:

e Empty variables are displayed as a question maykcon. You mayto write but not read
them, because they do not have any values.

e Brackets (1) are used if a variable is instantiated but does not contain an iconic object
(empty tuple). This may be the case using operatorsdikesct_shape with “wrong”
specified thresholds or using operagmpty_obj. Such a value might be reasonable if
you want to collect iconic objects in a variable gradually in a loogn€at_obj). Here,
an empty tuple is used as starting value for the loop.

e A last exception is aempty region This isoneregion that does not contain any pixels
(points), i.e., the area (number of points) is 0. You must not confuse this case with the
empty tuple, because there the area is not defined. The empty region is symbolized by an
empty set icon().

2.6.2 Area for Control Data

To the right of the variable name you find their values in the default represefitatioyou

specify more than one value for one variable (tuple), they are separated by commas and enclosed
by brackets. If the number of values exceeds an upper limit, the output is clipped. This is
indicated by three dots at the end of the tuple. For empty variables, their name7aack a
shown in the variable field. An empty tuple is representedloyBoth exceptions use the same
symbols as the corresponding cases for the iconic variables.

Clicking on a variable will select it. Similar to iconic variables, all program lines that use this
variable are then marked with a black rectangle on the left.

Double-clicking a control variable opens a window that displays all its values. In most cases
this will be a dialog containing a scrolled list. This is helpful if you have variables with a large
number of values that you want to inspect. In the case of a frame grabber handle, a dialog
representing basic frame grabber parameters is opened (seefi@dréHere you find the size,
name, device, port, and other features of the frame grabber. The toggle ilttare allows to

grab images continuously and to display them in the active graphics window. If an error occurs
during grabbing, it is displayed in the status bar of the dialog. At most one of these frame
grabber dialogs can be opened at the same time.

2.7 Graphics Window

This window displays iconic data. It has the following properties:

5You have to keep in mind that a floating point number without significant fractional part is represented as an
integer (e.g., 1.0 is representedids
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Figure 2.39: Variable inspection for frame grabber handles.

e The user may open several graphics windows.
e The active graphics window is shown by the green dot initteive button.

e Pressing thelear button clears the graphics window content and the history of the
window.

¢ You close a graphics window using the close button of the window frame.

Figure2.40shows an example for a graphics window.

The the origin of the graphics window is the upper left corner with the coordinates (0,0). The x
values (column) increase from left to right, the y values increase from top to bottom. Normally,
the coordinate system of the graphics window corresponds to the the most recently displayed
image, which is automatically zoomed so that every pixel of the image is visible. The coordinate
system can be changed interactively using the nv¥asualization > Set Parameters...

> Zoom (See sectior.3.2.9 or with the operatodev_set_part (see pagé&8). Every time an

image with another size is displayed, the coordinate system will be adapted automatically.

Each window has a history that contains all

e Objects and

e display parameters

that have been displayed or changed since the most reteat or display of an image. This
history is used for redrawing the contents of the window. The history is limited to a maximum
number of 30 “redraw actions”, where one redraw action contains all objects of one displayed
variable.

Other output like text or general graphics likésp_line or disp_circle or iconic data that
displayed using HALCON operators likéisp_image Or disp_region are not part of the
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Figure 2.40: HDevelop’s graphics window.

history, and ar@otredrawn. Only the object classes image, region, and XLD that are displayed
with the HDevelop operatodev_display or by double clicking on an icon are part of the
history.

You may change the size of the graphics window interactively by “gripping” the window border
with the mouse. Then you can resize the window by dragging the mouse pointer. After this size
modification the window content is redisplayed. Now you see the same part of the window with
changed zoom.

The menu area of the graphics window has an additional function: If the mouse cursor is in this
area the look up table of the window is reactivated. This is necessary if other programs use their
own look up table. Thus if there is a “strange” graphics window presentation, you may load the
proper look up table by placing the mouse near the buttons.

If you want to specify display parameters for a window you may select the menu item
Visualization in the menu bar. Here you can set the appropriate parameters by clicking
the desired item (see secti@rB.2.4. The parameters you have set in this way are usedIfor
windows. The effects of the new parameters will be applied direcly tdas$teobject of the
window history and alter its parameters only.
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For further information on parameter effects please refer to the appropriate HALCON operators
in the reference manual.
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Chapter 3
Language

The following chapter introduces the syntax and the semantics of the HDevelop language. In
other words, it illustrates what you can enter into a parameter slot of an operator. In the simplest
case this is the name of a variable, but it might also be an expressiosglik€A) . Besides,
control structures (like loops) and the semantics of parameter passing are described.

Chapter5 explains the application of this language in image analysis. Note that the HALCON
operators themselves are not described in this chapter. For this purpose refer to the HALCON
reference manual. All program examples used in this chapter can also be found in the directory
%HALCONROOT%\examples\hdevelop\Manuals\HDevelop.

3.1 Basic Types of Parameters

HALCON distinguishes two kinds of data: control data (numerical/string) and iconic data (im-
ages, regions, etc.).

By further distinguishingnput from output parametersve get four different kinds of parame-
ters. These four kinds always appear in the same order in the HDevelop parameter lis3. Table
shows their order of appearance.

iconic | input
iconic | output
control | input
control | output

Table 3.1: Order of appearance of the four basic parameter types.

As you see, iconic input objects are always passed as the first parameter(s), followed by the
iconic output objects. The iconic data is followed by the control data, and again, the input
parameters succeed the output parameters. Each parameter is separated from its neighbours by
a comma:

read_image (Image, ’Name’)
area_center (Region, Area, Row, Column)
mean_image (Image, Mean, 11, 11)
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In the above example the operatgrad_image has one output parameter for iconic objects
(Image) and one input control parameter (flenamejrea_center accepts regions as in-

put (iconic) and three control parameters as outpué4, Row, Column). The filter operator
mean_image has one iconic parameter as input and one as output. Its two input control param-
eters specify the size of the filter mask.

Input control parameters can either be variables, constants or even complex expressions. An ex-
pression is evaluatdakforeit is passed to a parameter that receives the result of the evaluation.
Since iconic objects always are represented by variables all iconic parameters only accept vari-
ables. Control output parameters must always contain variables, too, as they store the results of
an operator evaluation.

3.2 Control Types and Constants

All non-iconic data is represented by so calbeshtrol data(numerical/string) in HDevelop. The

name is derived from their respective functions within HALCON operators wherectirgyol

the behaviour (the effect) of image processing operators (e.g., thresholds for a segmentation
operator). Control parameters in HDevelop may contain arithmetic or logical operations. A
control data item can be of one of the following typésteger, real, boolean, andstring.

integer andreal
The typesinteger andreal are used under the same syntactical rules as in C. Integer
numbers can be input in the standard decimal notation, in hexadecimal by prefixing the
number withOx, and in octal by prefixing the number with For example:

4711

-123
Oxfebl2
073421
73.815
0.32214

.56
-17.32e-122
32E19

Data items of typeinteger or real are converted to their machine-internal representa-
tions: real becomes the C-typ#&uble (8 bytes) andnteger becomes the C-typsng
(4 or 8 bytes).

string
A String (string) is a sequence of characters that is enclosed in single qutesie
maximum string length is limited to 1024 characters. Special characters, like the line
feed, are represented in the C-like notation, as you can see irdt&gkee the reference
of the C language for comparison).

Examples of strings are shown in tal3e.
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Meaning Abbreviation| Notation
line feed NL (LF) \n
horizontal tabulator HT \t
vertical tabulator | VT \v
backspace BS \b
carriage return CR \r
form feed FF \f
bell BEL \a
backslash \ \\
single quote ) \’

Table 3.2: Surrogates for special characters.

String Meaning
’Hugo’ letters
’10.9° numbers (noteal)
"Text...\n’ NL at the end of the string
"\t Textl \t Text2’ two tabs in a text
’Sobel\’s edge-filter’ single quote within the text
’c:\\Programs\\MVTec\\Halcon\\images’ | Directory

Table 3.3: String examples.

boolean
The constantsrue andfalse belong to the typ®oolean. The valuetrue is internally
represented by the number 1 and the vdkiese by 0. This means, that in the expression
Val := true the effective value ofal is set to 1. In general, every integer vahed
meangrue. Please note that some HALCON operators take logical values for input (e.g.,
set_system). In this case the HALCON operators expect string constants tikee’ or
>false’ rather than the represented valtiese or false.

constants
There are constants for the return value (result state) of an operator. The constants can
be used together with the operatiety_error_var anddev_set_check. These constants
represent the normal return value of an operator, so callessagesFor errors no con-
stants are available

Constant Meaning Value
H_MSG_TRUE | No error; for tests: f{rue) 2
H_MSG_FALSE | For testsfalse 3

H_MSG_VOID | No result could be computed4
H_MSG_FAIL | Operator did not succeed |5

Table 3.4: Return values for operators.

In table3.4 all return messages can be found.

There exist more than 400 error numbers internally E&etension Package Programmer’s Manug).
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The control types are only used within the generic HDevelop typ&e A tuple of length 1

is interpreted as an atomic value. A tuple may consist of several numerical data items with
differenttypes. The standard representation of a tuple is a listing of its elements included into
brackets (see figur@.1).

Tuple constant Vaue

=i
HII

bool ean

Vaue 1/

Figure 3.1: The syntax of tuple constants.

[] specifies the empty tuple. A tuple with just one element is to be considered as a special case,
because it can either be specified in the tuple notation or as an atomic Vafiledefines the
same constant &b. Examples for tuples are:

(]

4711

0.815

’Text’

[16]
[100.0,100.0,200.0,200.0]
[’FileName’,’Extension’]
[4711,0.815, ’Hugo’]

The maximum length of a tuple is limited to 12000000.

3.3 Variables

Names of variables are built up as usual by composing letters, digits and the underscore

The maximum length of a variable name is limited to 256 characters. The kind of a variable
(iconic or control variable) depends on its position in the parameter list in which the variable
identifier is used for the first time (see also cha@4dj. The kind of the variable is determined
during the input of the operator parameters: whenever a new identifier appears, a new variable
with the same identifier is created. Control and iconic variables must have different names.
The value of a variable (iconic or control) is undefined until the first assignment defines it (the
variable hasn’'t been instantiated yet). A read access to an undefined variable leads to a runtime
error Variable <x> not instantiated).

HDevelop provides a pre-defined variable namésingle underscore). You can use this vari-

able for output control parameters whose value you are not interested in. Please note that it is not
allowed to use this variable for HDevelop-specific operators (chapéarsrol andDevelop,

see the appendix for a complete list).
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Instantiated variables contain tuples of values. Depending on the kind of the variable the data
items are either iconic objects or control data. The length of the tuple is determined dynamically
by the performed operation. A variable can get new values any number of times, but once a value
has been assigned the variable will always keep beeing instantiated, unless you select the menu
itemExecute > Reset Program. The content of the variable is deleted before the variable is
assigned with new values.

The concept of different kinds of variables allows a first (“coarse”) typification of variables
(control or iconic data), whereas the actual type of the data ¢e4gl, integer, string, etc.)

is undefined until the variable gets assigned with a concrete value. Therefore, it is possible that
the type of a new data item differs from that of the old.

3.4 Operations on Iconic Objects

Iconic objects are exclusively processed by HALCON operators. HALCON operators work
on tuples of iconic objects, which are represented by their surrogates in the HALCON data
management. The results of those operators are again tuples of iconic objects or control data
elements. For a detailed description of the HALCON operators refer to the HALCON reference
manual and the remarks in chap8b.3

3.5 Expressions for Input Control Parameters

In HDevelop, the use of expressions is limited to control input parameters; all other kinds of
parameters must be assigned by variables.

3.5.1 General Features of Tuple Operations

This chapter is intended to give you a short overview over the features of tuples and their oper-
ations. A more detailed description of each operator mentioned here is given in the following
sections.

Please note that in all following tables variables and constants have been substituted by letters.
These letters give information about possible limitations of the areas of definition. A single
letter (inside these tables) represents a data type. Operations on these symbols can only be
applied to parameters of the indicated type or to expressions that return a result of the indicated
type. To begin with, tabl8.5 specifies the names and types of the symbolic names.

Operators are normally described assuming atomic tuples (tuples of length 1). If the tuple
contains more than one element, most operators work as follows:

e If one of the tuples is of length one, all elements of the other tuples are combined with that
single value for the chosen operation.

e If both tuples have a length greater than one, both tuples must have the same length (other-
wise a runtime error occurs). In this case, the selected operation is applied to all elements
with the same index. The length of the resulting tuples is identical to the length of the
input tuples.
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Symbol | Types
i integer
arithmetic, that isinteger or real
boolean
string
all types (atomic)
all types (tuple)

< -

Table 3.5: Symbolic variables for the operation description.

e If one of the tuples is of length 0{), a runtime error occurs.

In table3.6you can find some examples for arithmetic operations with tuples. In this example

Input Result

5 x5 25

(6] = [5] 25

[1,2,3] * 2 [2,4,6]

[1,2,3] * 2.1 + 10 [12.1,14.2,16.3]
[1,2,3] * [1,2,3] [1,4,9]

[1,2,3] * [1,2] runtime error
’Textl’ + ’Text2’ ’Text1Text2’
17.23 + 7 Text’ ’17.23 Text’
’Textl > + 99 + ’ Text2’ | "Textl 99 Text2’
‘Text 7 + 3.1 % 2 ’Text 6.2’

3.1 % (2 + ’ Text’) runtime error

3.1 + 2+’ Text’ ’5.1 Text’

3.1 + (2 +  Text?) ’3.12 Text’
‘Text 7 + 2.1 + 3 ’Text 2.13°

Table 3.6: Examples for arithmetic operations with tuples and strings.
you should pay special attention to the order in which the string concatenations are performed.

3.5.2 Assignment

In HDevelop, an assignment is treated like an operator. To use an assignment you have to se-
lect the operatomssign (Input, Result). This operator has the following semantics: It
evaluatesInput (right side of assignment) and stores itRasult (left side of assignment).
However, in the program text the assignment is represented by the usual syntax of the assign-
ment operator: ’'=". The following example outlines the difference between an assignment in

C syntax and its transformed version in HDevelop:

The assignment in C syntax

u = sin(x) + cos(y);
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is defined in HDevelop using the assignment operator as

assign(sin(x) + cos(y), u)

which is displayed in the program window as:

u := sin(x) + cos(y)

If the result of the expression doesn’t need to be stored into a variable, the expression can
directly be used as input value for any operator. Therefore, an assignment is necessary only if
the value has to be used several times or if the variable has to be initialized (e.g., for a loop).

A second assignment operator is availablensert (Input,Value,Index,Result)). Itis
used to assign tuple elements. If the first input parameter and the first output parameter are
identical, the call:

insert (Areas, Area, Radius-1, Areas)

is not presented in the program text as an operator call, but in the more intuitive form as:

Areas[Radius-1] := Area.

To construct a tuple withnsert, normally an empty tuple is used as initial value and the
elements are inserted in a loop:

Tuple := []

for i := 0 to 5 by 1
Tuple[i] := sqrt(real(i))

endfor

As you can see from this example, the indices of a tuple start at O.
An insertion into a tuple can generally be performed in one of the following ways:

1. In case of appending the value at the 'back’ or at the 'front’, the concatenation can be
used. Here thessign operator is used with the following parameters:

assign([Tuple,NewVal],Tuple)

which is displayed as

Tuple := [Tuple,NewVall

2. If the index position is somewhere in between, the operateert has to be used. It
takes the following arguments as input: first the tuple in which the new value should be
inserted; then the new value and after that the index position as the third input parameter.
The result (the fourth parameter) is almost identical with the input tuple, except of the
new value at the defined index position.
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In the following example regions are dilated with a circle mask and afterwards the areas are
stored into the tupléreas. In this case the operatansert is used.

read_image (Mreut, ’mreut’)

threshold (Mreut, Region, 190, 255)

Areas := []

for Radius := 1 to 50 by 1
dilation_circle (Region, RegionDilation, Radius)
area_center (RegionDilation, Area, Row, Column)
Areas[Radius-1] := Area

endfor

Please note that first the variallleeas has to be initialized in order to avoid a runtime error.
In the example\ireas is initialized with the empty tuple[(). Instead ofinsert the operator
assign with tuple concatenation

Areas := [Areas,Area]

could be used, because the element is appended at the back of the tuple.

More examples can be found in the progragsign.dev.

3.5.3 Basic Tuple Operations

A basic tuple operation may be selecting one or more values, combining tuples (concatenation)
or reading the number of elements.

[t,t] concatenation of tuples
It| number of elements
t[i] selection of an element
t[i:1] selection of (a part of) a tupl

(9%

Table 3.7: Basic operations on tuples.

The concatenation accepts one or more variables or constants as input. They are all listed
between the brackets, separated by commas. The result again is a tuple.

[t1,t2] IS the concatenation of tuptg andt,. Example:
[[5,’Text’],[5.9]1] — [5,’Text’,5.9]
So even the following holds( [t]] = [t] = t.

|t | returns the number of elements of a tuple. The indices of elements range from zero to the
number of elements minus one (i.et,| -1). Therefore, the selection index has to be within this
range?

2Please note that the index of objects (esglect_object) ranges from 1 to the number of elements.
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Tuple := [V1,V2,V3,V4]

for i := 0 to |Tuplel-1 by 1
fwrite_string (FileHandle,Tuple[i]+’\n’)

endfor

There are no direct operations on parameter position for the handling of iconic variables. This
means that single iconic objects cannot be directly selected using [] and their number cannot be
directly determined using []. For this purpose, however, HALCON operators are offered which
carry out the equivalent tasks. In taBl&you can see tuple operations that work on control data
and their counterparts that work on iconic data. In the table the symisgresents a control

tuple, and the symbols andq represent iconic tuples. Further examples can be found in the
programtuple.dev.

control | iconic

(] gen_empty_obj ()

[t] count_obj (p, num)

[t1,t2] | concat_obj (pl, p2, q)
t[i] select_obj(p, q, i+1, 1)
t[i:j] | copy_obj(p, q, i+1, j-i+1)

Table 3.8: Equivalent tuple operations for control and iconic data.

3.5.4 Tuple Creation

The simplest way to create a tuple, as mentioned in se8t@ns the use of constants together
with theassign operator:

assign([],empty_tuple)

assign(4711,one_integer)
assign([4711,0.815],two_numbers)

This code is displayed as

(]
4711
[4711,0.815]

empty_tuple :
one_integer :
two_numbers :

This is useful for constant tuples with a fixed (small) length. More general tuples can be created
by successive application of the concatenation oritl¥ert function together with variables,
expressions or constants. If we want to generate a tuple of length 100, where each element has
the value 4711, it might be done like this:

assign([],tuple)

for i := 1 to 100 by 1
assign([tuple,4711],tuple)

endfor
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which is transformed to

tuple := []

for i := 1 to 100 by 1
tuple := [tuple,4711]

endfor

Because this is not very convenient a special function cgadtuple_const is available to
construct a tuple of a given length, where each element has the same value. Using this function,
the program from above is reduced to:

assign(gen_tuple_const(100,4711) ,tuple)

which is displayed as

tuple := gen_tuple_const(100,4711)
If we want to construct a tuple with the same length as a given tuple there are two ways to get
an easy solution, The first one is basedsen_tuple_const:

assign(gen_tuple_const(|tuple_old|,4711),tuple_new)

which is displayed as

tuple_new := gen_tuple_const(|tuple_old|,4711)

The second one is a bit tricky and uses arithmetic functions:

assign((tuple_old * 0) + 4711,tuple_new)

which is displayed as

tuple_new := (tuple_old * 0) + 4711

Here we get first a tuple of the same length with every element set to zero. Then we add the
constant to each element.

In the case of tuples with different values we have to use the loop version to assign the values
to each position:

assign([],tuple)
for i := 1 to 100 by 1

assign([tuple,ix*i],tuple)
endfor

which is displayed as
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tuple := []

for i := 1 to 100 by 1
tuple := [tuple,ixil

endfor

In this example we construct a tuple with the square values from 1002,

3.5.5 Simple Arithmetic Operations

Table3.9shows an overview of the available simple arithmetic operations.

All operations are left-associative, except the right-associative unary minus operator. The evalu-
ation usually is done from left to right. However, parentheses can change the order of evaluation
and some operators have a higher precedence than others (see 8fapder

a / a division

a * a multiplication

v + v addition ancconcatenatiorof strings
a - a Subtraction

-a nhegation

Table 3.9: Arithmetic operations.

The arithmetic operations in HDevelop match the usual definitions. Expressions can have any
number of parentheses.

The division operatora / a) can be applied tanteger as well as tareal. The result is of
typereal, if at least one of the operands is of typeal. If both operands are of typeteger

the division is an integer division. The remaining arithmetic operators (multiplication, addition,
subtraction, and negation) can be applied to eitherger or real numbers. If at least one
operand is of typeeal, the result will be aeal number as well. In the following example.

Vi := 4/3
V2 := 4/3.0
V3 := (4/3) * 2.0

V1is setto 1,v2 to 1.3333333, andl3 to 2.0. Simple examples can be found in the program
arithmetic.dev.

3.5.6 Bit Operations
This section describes the operators for bit processing of numbers. The operands have to be
integers.

The result ofish(i1,i2) is a bitwise left shift ofi1 that is appliedi2 times. If there is no
overflow this is equivalent to a multiplication 2. The result ofrsh(i1,i2) is a bitwise
right shift of 11 that is appliedi2 times. For non-negativel this is equivalent to a division
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1sh(i,i) left shift
rsh(i,i) right shift
i band i bitwise and
i bor i bitwise or
i bxor i bitwise xor
bnot i bitwise complement

Table 3.10: Bit operations.

by 2*2. For negativei1 the result depends on the used hardware. llsarandrsh the result
is undefined if the second operand has a negative value or the value is larger than 32. More
examples can be found in the progrant . dev.

3.5.7 String Operations

There are several string operations available to modify, select and combine strings. Furthermore,
some operations allow to convert numbersal andinteger) to strings.

v$s string conversion
v + v concatenatiorof strings and addition
strchr(s,s) search character in string
strstr(s,s) search substring
strrchr(s,s) search character in string (reverse)
strrstr(s,s) search substring (reverse)
strlen(s) length of string
s{i} selection of one character
s{i:i} selection of substring
split(s,s) splitting in substrings

Table 3.11: String operations.

$ converts numbers to strings or modifies strings. The operator has two parameters: The first
one (left of the$) is the number that has to be converted. The second one (right &) the
specifies the conversion. This format string consists of the following four parts

<flags><field width><precision><conversion characters>

So a conversion might look like

1332.4554 $ ’.6e’

flags Zero or more flags, in any order, which modify the meaning of the conversion specifi-
cation. Flags may consist of the following characters:

- The result of the conversion is left justified within the field.
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+ The result of a signed conversion always begins with a sigm,-.

<space> If the first character of a signed conversion is not a sign, a space character is
prefixed to the result. This means that if the space flag+aitay both appear, the
space flag is ignored.

# The value is to be converted to an “alternate form”. Baands conversions, this
flag has no effect. Fos conversion (see below), it increases the precision to force
the first digit of the result to be a zero. Foror X conversion (see below), a non-
zero result hasx or 0X prefixed to it. Fore, E, £, g, andG conversions, the result
always contains a radix character, even if no digits follow the radix characteg, For
andG conversions, trailing zeros are not removed from the result, contrary to usual
behavior.

field width An optional string of decimal digits to specify a minimum field width. For an
output field, if the converted value has fewer characters than the field width, it is padded
on the left (or right, if the left-adjustment flag, - has been given) to the field width.

precision The precision specifies the minimum number of digits to appear faod,thex, or
X conversions (the field is padded with leading zeros), the number of digits to appear after
the radix character for the e and f conversions, the maximum number of significant digits
for the g conversion, or the maximum number of characters to be printed from a string
in s conversion. The precision takes the form of a periddllowed by a decimal digit
string. A null digit string is treated as a zero.

conversion characters A conversion character indicates the type of conversion to be ap-
plied:

d,0,x,X The integer argument is printed in signed decim#l unsigned octal d),
or unsigned hexadecimal notation éndX). The x conversion uses the numbers
and letter9123456789abcdef, and theX conversion uses the numbers and letters
0123456789ABCDEF. The precision component of the argument specifies the min-
imum number of digits to appear. If the value being converted can be represented
in fewer digits than the specified minimum, it is expanded with leading zeroes. The
default precision is 1. The result of converting a zero value with a precision of O is
no characters.

f The floating-point number argument is printed in decimal notation in the style
[-]dddrddd, where the number of digits after the radix characteris equal to
the precision specification. If the precision is omitted from the argument, six digits
are output; if the precision is explicitly 0, no radix appears.

e,E The floating-point-number argument is printed in the stitédrddde+dd, where
there is one digit before the radix character, and the number of digits after it is
equal to the precision. When the precision is missing, six digits are produced; if the
precision is 0, no radix character appears. Ehmnversion character produces a
number withE introducing the exponent instead@fThe exponent always contains
at least two digits. However, if the value to be printed requires an exponent greater
than two digits, additional exponent digits are printed as necessary.

g,G The floating-point-number argument is printed in styt& e (or in styleE in the case
of aG conversion character), with the precision specifying the number of significant
digits. The style used depends on the value converted; stidaused only if the
exponent resulting from the conversion is less than -h or greater than or equal to the
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precision. Trailing zeros are removed from the result. A radix character appears
only if it is followed by a digit.

s The argument is taken to be a string, and characters from the string are printed until the
end of the string or the number of characters indicated by the precision specification
of the argument is reached. If the precision is omitted from the argument, it is
interpreted as infinite and all characters up to the end of the string are printed.

b Similar to the s conversion specifier, except that the string can contain backslash-escape
sequences which are then converted to the characters they represent.

In no case does a nonexistent or insufficient field width cause truncation of a field; if the
result of a conversion is wider than the field width, the field is simply expanded to contain
the conversion result.

Examples for the string conversion can be found in the programng . dev.

The string concatenatior) can be applied in combination with strings or all numerical types;

if necessary, the operands are first transformed into strings (according to their standard repre-
sentation). At least one of the operands has to be already a string so that the operator can act
as a string concatenator. In the following example a filename (elgme5.tiff’) is gener-

ated. For this purpose two string constantafne’ and’.tiff’) and an integer value (the
loop-indexi) are concatenated:

for i :=1 to 5 by 1
read_image (Bild, ’Name’+i+’.tiff’)
endfor

str(r)chr(s1,s2) returns the index of the first (last) as a tuple occurrence of one character in
s2 in strings1, or -1 if none of the characters occurs in the string.

str(r)str(sl,s2) returns the index of the first (last) occurrence of string s2 in string s1, or
-1 if s2 does not occur in the string.

strlen(s) returns the number of characterssin

s{i} returns the character at index positioin s. The index ranges from zero to the length of
the string minus 1. The result of the operator is a string of length one.

s{i1:i2} returns all characters from index positioh up to positioni2 in s as a string. The
index ranges from zero to the length of the string minus 1.

split(s1,s2) devides the string1 into single substrings. The string is split at those positions
where it contains a character frasD. As an example the result of

split(’/usr/image: /usr/proj/image’,’:’)

consists of the two strings

[’/usr/image’,’/usr/proj/image’]
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3.5.8 Comparison Operators

In HDevelop, the comparison operators are defined not only on atomic values, but also on tuples
with an arbitrary number of elements. They always return values ofdypeean. Table3.12
shows all comparison operators.

t < t lessthan
t > t (greater than
t <=t lessorequal
t >= t greater or equal
t =t equal
t # t notequal

Table 3.12: Comparison operators.

t = tandt # t are defined on all types. Two tuples are equalg), if they have the same
length and all the data items on each index position are equal. If the operands have different
types @integer andreal), the integer values are first transformed intal numbers. Values

of type string cannot be mixed up with numbers, i.etring values are considered to be not
equal to values of other types.

1st Operand 2nd Operand Operation| Result
1 1.0 = true
(] (] = true
’) (] = false
[1,’2°] [1,2] = false
[1,2,3] [1,2] = false
[4711,’Hugo’] | [4711, Hugo’] | = true
’Hugo’ ’hugo’ = false
2 1 > true
2 1.0 > true
[5,4,1] [5,4] > true
[2,1] [2,0] > true
true false > true
’Hugo’ ’hugo’ < true

Table 3.13: Examples for the comparison of tuples.

The four comparison operators compute the lexicographic order of tuples. On equal index
positions the types must be identical, however, values of typeger, real andboolean are
adapted automatically. The lexicographic order applies to strings, ansbthean false is
considered to be smaller than the booleate (false < true). Inthe prograntompare.dev

you can find examples for the comparison operators.

3.5.9 Boolean Operators

The boolean operatoemd, or, xor andnot are defined only for tuples of length 1. and 1
is set totrue (1) if both operands arerue (1), wheread or 1 returnstrue (1) if at least one
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not 1 negation
1 and 1 logical’and’
1 or 1 logical 'or
1 xor 1 logical 'xor’

Table 3.14: Boolean operators.

of the operands isrue (1). 1 xor 1 returntrue (1) if exactly one of both operands is true.
not 1 returnstrue (1) if the input isfalse (0), andfalse (0), if the input istrue (1).

3.5.10 Trigonometric Functions

All these functions work on tuples of humbers as arguments. The input can either be of type
integer or real. However, the resulting type will be of typeal. The functions are applied

to all tuple values and the resulting tuple has the same length as the input tupletakrar

the two input tuples have to be of equal length. TahlEs shows the provided trigonometric

sin(a) sine ofa

cos(a) cosine ofa

tan(a) tangent ofa
asin(a) arc sine ofainthe interval F-7/2,7/2],a € [—1,1]
acos(a) arccosinexintheinterval F7/2,7/2],a € [—1,1]
atan(a) arctangentintheinterval F7/2,7/2],a € [—1,1]

atan2(a,b) arctangent/b in the interval |-, 7]

sinh(a) hyperbolic sine o
cosh(a) hyperbolic cosine o4
tanh(a) hyperbolic tangent of

Table 3.15: Trigonometric functions.

functions. For the trigonometric functions the angle is specified in radians.

3.5.11 Exponential Functions

All these functions work on tuples of humbers as arguments. The input can either be of type
integer or real. However, the resulting type will be of typeal. The functions are applied

to all tuple values and the resulting tuple has the same length as the input tupleowror
and 1dexp the two input tuples have to be of equal length. Takl®6 shows the provided
exponential functions.

3.5.12 Numerical Functions
The functionanin andmax select the minimum and the maximum values of the tuple values.
All values either have to be of typsring, or integer/real. It is not allowed to mix strings

with numerical values. The resulting value will be of typeal, if at least one of the elements
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exp(a) exponential functior?®
log(a) natural logarithmn(a), a> 0
logl0(a) decadic logarithmlog,,(a), a> 0
pow(al,a2) a122

ldexp(al,a2) al 032

Table 3.16: Exponential functions.

is of typereal. If all elements are of typenteger the resulting value will also be of type
integer. The same applies to the functienm that determines the sum of all values. If the
input arguments are strings, string concatenation will be used instead of addition.

min(t) minimum value of the tuple
max (t) maximum value of the tuple
sum(t) sum of all elements of the tuple
or string concatenation
mean(a) mean value
deviation(a) standard deviation
sqrt(a) square root/a
deg(a) convert radians to degrees
rad(a) convert degrees to radians
real(a) convertinteger toreal
round(a) convertreal to integer
abs(a) absolute value o (integer or real)
fabs(a) absolute value of (alwaysreal)
ceil(a) smallestinteger value not smaller than
floor(a) largestinteger value not greater than
fmod(al,a2) fractional part ofal/a2, with the same sign ast

Table 3.17: Numerical functions.

The functionssqrt, mean, deviation, deg, rad, fabs, ceil, floor andfmod can work with
integer andreal; the result is always of typeeal.

The functiomean calculates the mean value adxlriation the standard deviation of numbers.
sqrt calculates the square root of a number.

deg andrad convert numbers from radians to degrees and from degrees to radians, respectively.

The functionround always returns atinteger value and the functioabs always returns the
absolut value that is of the same type as the input value.

real converts annteger to areal. Forreal as input it returns the input.
round converts aeal to aninteger and rounds the value. Fanteger it returns the input.

The following example (filenamesuclid_distance.dev) shows the use of some numerical
functions:
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V1 := [18.8,132.4,33,19.3]

V2 := [233.23,32.786,234.4224,63.33]
Diff := V1 - V2

Distance := sqrt(sum(Diff * Diff))
Dotvalue := sum(V1 * V2)

First, the Euclidian distance of the two vectdisandv2 is computed, by using the formula:

d= \/Z (V1, — V2,)2

The difference and the multiplication (square) are successively applied to each element of both
vectors. Afterwardsum computes the sum of the squares. Then the square root of the sum is
calculated. After that the dot productof andv2 is determined by the formula:

(V1,V2) =3 (V1 V2)

2

3.5.13 Miscellaneous Functions

sort(t) sorting in increasing order
sort_index(t) returnindex instead of values
inverse(t) reverse the order of the values
is_number(v) testif value is a number
number (v) convertstring to a number
environment (s) Vvalue of an environment variable
ord(a) ASCII number of a character
chr(a) convert an ASCIlI number to a character
ords(s) ASCII number of a tuple of strings
chrt (i) convert a tuple of integers into a string

Table 3.18: Miscellaneous functions.

sort sorts the tuple values in ascending order, that means, that the first value of the resulting
tuple is the smallest one. But again: strings must not be mixed up with nunseetts.index

sorts the tuple values in ascending order, but in contrasbie it returns the index positions

(0..) of the sorted values.

The functioninverse reverses the order of the tuple values. Betlit andinverse are the
identity operation, if the input is empty, if the tuple is of length 1, or if the tuple contains only
one value in all positions, e.g., [1,1,...,1].

is_number returnstrue for variables of the typénteger or real and for variables of the type
string that represent a number.

The functionnumber converts astring representing a number to dnteger or areal de-
pending on the type of the number. Note that strings starting Ovithre interpreted as hex-
adecimal numbers, and strings starting vaitas octal numbers; for example, the stririg’ is
converted to the integex0, > 020’ to 16, and’0x20’ to 32.
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If called with astring that does not represent a number or with a variable of theitypeger
or real, number returns a copy of the input.

environment returns the value of an environment variable. Input is the name of the environ-
ment variable as a string.

ord gives the ASCII number of a character asiamneger. chr converts an ASCII number to a
character.

ords converts a tuple of strings into a tuple of (ASCII) integershrt converts a tuple of
integers into a string.

3.5.14 Operator Precedence

Table3.19shows the precedence of the operators for control data. Some operations (like func-
tions,| |, t[], etc.) are left out, because they mark their arguments clearly.

or, xor, bor, bxor
and, band

#, =

<=,>= <, >

+, -

/, *

- (unary minusy; !
$

Table 3.19: Operator precedence (increasing from top to bottom).

3.6 Reserved Words

The strings shown in tabl@.20are reserved words and their usage is strictly limited to their
predefined meaning. They cannot be used as variables.

3.7 Control Structures

HDevelop provides the following constructs to structure programs:

if The simplest control structure i. The condition contains a boolean expression. If the
condition is true, the body is executed. Otherwise the execution is continued at the first
expression or operator call that follows the wetdiif.

if (<Condition>)

endif
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true false and or

Xor bor bxor chr
ord chrt ords band
bnot not sum sin
cos tan asin acos
atan sinh cosh tanh
exp log logl0 ceil
floor atan2 pow fabs
abs fmod ldexp round
deg rad min max
sort inverse strlen strchr
strrchr strstr strrstr split
environment is_number number real
1sh rsh deviation mean
sqrt gen_tuple_const H_MSG_TRUE H_MSG_FALSE
H_MSG_FAIL H_MSG_VOID

Table 3.20: Reserved words.

ifelse Another simple control structure is the condition with alternative. If the condition is

true, all expressions and calls between the head and theswaid are performed. If the
condition is false the part betweemnse andendif is executed. Note that the operator is
calledifelse and itis displayed asf in the program text area.

if (<Condition>)
else

endif

while Thewhile loop has a boolean expression as the conditional part. As long as-itds

for

the body of the loop is performed. In order to enter the loop, the condition has to be true
in the first place. The loop can be terminated immediately with the instrustiesak
(see below).

while (<Condition>)
endwhile
In chapter5.3you can find an example for using theile loop.

Thefor loop is controlled by a start and termination value and an incrementation value
that determines the number of loop steps. These values may also be expressions which
are evaluated immediately before the loop is entered. The expressions may be of type
integer or of typereal. If all input values are of typenteger the loop variable will

also be of typeinteger. In all other cases the loop variable will be of typeal.

If the start value is less or equal to the termination value, the starting value is assigned to
the loop index and the body of the loop is entered. If the increment is less than zero the
loop is entered if the start value is larger or equal to the end value. Each time the body is
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executed, the loop index is incremented by the incrementation value. If the loop index is
equal to the termination value, the body of the loop is performed for the last time. If the
loop index is larger than the termination value the body will not be excecuted any fonger.
Please note, that the loop index does not need to become equal to the termination value
in order terminate the loop. The loop index is set to the termination value when the loop
is being left.

The loop can be terminated immediately with the instructioeak (see below).

Please note, that the expressions for start and termination value are evaluated only once
whenentering the loopA modification of a variable that appears within these expressions
has no influence on the termination of the loop. The same applies to the modifications
of the loop index. It also has no influence on the termination. The loop value is as-
signed to the correct value each time tlwe operator is executed. For more details, see
sectiord.4.2on the code generation 66r loops.

If the for loop is left too early (e.qg., if you preskop and set the’C) and the loop is
entered again, the expressions will be evaluated, as if the loop were entered for the first
time.

for <loop value> := <Start> to <End> by <Increment>

endfor

In the following example the sine from 0 up tar s computed and printed in to the
graphical window (filenamesine.dev):

old_x := 0

old_y := 0

dev_set_color (’red’)
dev_set_part(0, 0, 511, 511)
for x := 1 to 511 by 1

y := sin(x / 511.0 * 2 * 3.1416 * 3) * 255
disp_line (WindowID, -old_y+256, old_x, -y+256, x)
old_x := x
old_y :=y

endfor

In this example the assumption is made that the window is of size 512. The drawing
is always done from the most recently evaluated point to the current point.

Further examples on how to use ther loop can be found in chapté&8and5.9.
break The instructiorbreak enables you to exitor andwhile loops. The program is then
continued at the next line after the end of the loop.

A typical use of the instructiobreak is to terminate a&or loop as soon as a certain
condition becomes true, e.g., as in the following example:

3For negative increment values the loop is terminated if the loop index is less than the termination value.
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Number := |Regions|
AllRegionsValid := 1
* check whether all regions have an area <= 30
for i := 1 to Number by 1
ObjectSelected := Regions[i]
area_center (ObjectSelected, Area, Row, Column)
if (Area > 30)
AllRegionsValid := O
break ()
endif
endfor

In the following example, the instructiasreak is used to terminate an (infinitghile
loop as soon as one clicks into the Graphics Window:

while (1)
grab_image (Image, FGHandle)
dev_error_var (Error, 1)
dev_set_check (’“give_error’)
get_mposition (WindowHandle, R, C, Button)
dev_error_var (Error, 0)
dev_set_check (’give_error’)
if ((Error = H_MSG_TRUE) and (Button # 0))

break ()

endif

endwhile

stop The stop construct stops the program after the operator is executed. The program can

be continued by pressing tiseep or Run button.

exit Theexit constructerminateshe session of HDevelop.

3.8 Limitations

This section summarizes the restritions of the HDevelop language:

e Maximum number of objects per parameter : 100000
e Maximum length of strings : 1024 characters
e Maximum length of a variable name : 256 characters

e Maximum length of a tuple : 2000000

The general restrictions of the HALCON operators can be found in the manual

Getting Started with HALCON .

HDevelop, 2003-08-01



Chapter 4

Code Generation

The idea of code generation is as follows: After developing a program according to the given
requirements it has to be translated into its final environment. Here, you often don’t want to
use HDevelop to save memory or disk space. In addition, the program should execute as fast as
possible, especially without the overhead of an interpreter. Therefore, the program is transfered
into another programming language that can be compiled and allows a faster execution. In
addition to this, features of the new environment like special libraries or graphical user interface
builder can thus be used.

HDevelop allows to “export” a developed HDevelop program to the programming languages
C++, Visual Basic, and C, by writing the corresponding code to a file. The seeti®y.2, and
4.3describe the general steps of program development using this feature for the three languages,
including some language-specific details of the code generation and optimization aspects.

Because HDevelop does more than just execute a HALCON program, the behavior of an ex-
ported program will differ in some points from its HDevelop counterpart. A prominent example
is that in HDevelop, all results are automatically displayed, while in the exported programs
you have to insert the corresponding display operators explicitely. Setdatescribes these
differences in more detail.

4.1 Code Generation for C++

This section describes how to create a HALCON applicationtirr,Gtarting from a program
developed in HDevelop.

4.1.1 Basic Steps
4.1.1.1 Program Export

The first step is to export the program using the mBille > Save As. Here, select the lan-
guage (G+*) and save it to file. In UNIX you specify the language by giving the file the exten-
sion “. cpp”. A file will be created that contains the HDevelop program &g €ource code in a
procedureaction(). This procedure is called in functiarain (). Besides the program code,
the file contains all necessattynclude instructions. All variables (iconic as well as control)
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are declared locally in the procedwetion(). Iconic variables belong to the claBsbject
and all other variables belong Eauple.

4.1.1.2 Compiling and Linking in Windows NT / 2000 / XP Environments

The next step is to compile and link this new program. In the Windows environment, Visual
C++ is used for the compiling and linking. Example projects can be found in the directory
JHALCONROOT?,\ examples\cpp\i586-nt4.

If you want to use Parallel HALCON, you have to include the libragigshalcon.1ib/.d11
and parhalconcpp.lib/.d11l instead ofhalcon.lib/.d11 andhalconcpp.lib/.d11 in
your project (see thelALCON/C ++ User’s Manual for more detalils).

4.1.1.3 Compiling and Linking in UNIX Environments

To compile and link the new program (called etgst . cpp) in the case of UNIX, you can use
the examplenakefile which can be found in the directo8HALCONROOT/examples/cpp by
calling

make TEST_PROG=test

Alternatively, you can set the varialblf@ST_PROG in makefile t0 test and then just typaake.

You can link the program to the Parallel HALCON libraries by calling

make parallel TEST_PROG=test

or just typemake parallel if you set the variabl@EST _PROG as described above.
For more details see tH¢ALCON/C ++ User’'s Manual.

4.1.2 Optimization

Optimization might be necessary for variables of cl#Bsple. This kind of optimization can
either be done in HDevelop or in the generatedt@ode. In most cases optimization is not
necessary if you program according to the following rules.

1. Using the tuple concatenation, it is more efficient to extend a tuple at the “right” side,
like:
T := [T,New]

because this can the transformed to
T.Append (New) ;

in C++ and requires no creation of a new tuple, whereas
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T := [New,T]

which is translated into
T = New.Append(T);

would need the creation of a new tuple.

2. Another good way to modify a tuple is the operatasert (see sectior3.5.2. In this
case HDevelop code like

T[i] := New

can directly be translated into the efficient and similar looking code

T[i] = New;

4.1.3 Used Classes

There are only two classes that are usetliple for control parameters arntbbject for iconic

data. There is no need for other classes as long as the program has the same functionality
as in HDevelop. When editing a generated program you are free to use any of the classes of
HALCON/C++ to extend the functionality.

4.1.4 Limitations and Troubleshooting

Besides the restrictions mentioned in this section and in sedtimplease also check the de-
scription of the HDevelop operators on p&fe

4.1.4.1 Exception Handling

In HDevelop, every exception normally causes the program to stop and report an error message
in a dialog window. This might not be useful int€. In addition, there are different default
behaviors concerning the result state of operators.

Messages In the case of €+ only severe errors cause an exception handling which termi-
nates the program and prints an error message. This might cause problems with minor errors,
so calledmessages HALCON. These messages are handled as return values of the operators
and can have the following values, which are also available in HDevelop as constants:

H_MSG_TRUE
H_MSG_FALSE
H_MSG_FAIL
H_MSG_VOID
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One of these messages is always returned indicating the status of the operator. Normally, the
result isH.MSG_TRUE. Some operators retuthMSG_FAIL like read_image Or read_region to

indicate that they could not open a file or there was no permission to read it. In this case the
programmer has to check the return value and apply some adequate action. If the message
H_MSG_FALSE is ignored, errors like

Halcon Error #4056: Image data management: object-ID is NULL

will happen in successive operators, because the predecessor operator did not calculate an ap-
propriate value.

Errors In the case of hard errors (i.e., no message as described above) the program stops
with an error message. To prevent this behavior the HDevelop oper@orsrror_var
anddev_set_check can be used to control the exception handling in the application. This
works similarly in HDevelop and €. One difference is caused by the dynamic evaluation

of dev_error_var in HDevelop. This means that each time the operator is executed (e.g., in

a loop) the use of the error variable might change. In contrast to this#ingpecial code

is added to store the return values of operators. This code will therefore be static and cannot
change during program excecution. To understand how the code generation works let us have a
look at a short example. Here at first the HDevelop program:

dev_set_check(’“give_error’)

dev_error_var (error,true)

threshold(image,region, 100,255)

dev_error_var (error,false)

if (error # H_MSG_TRUE)
write_string(WindowId,’error number = ’ + error)
exit ()

endif

dev_set_check(’give_error’)

This program will be translated into

HTuple error;

::set_check("“give_error");

error = ::threshold(image,&region,100,255);

if (error != 2)

{
::write_string(WindowId,HTuple("error number = ") + HTuple(error));
exit(1);

+

::set_check("give_error");

As can be seen, the operatav_error_var is eliminated and replaced by the use of the error
variable later on.

The points mentioned above might cause these two problems:
e If the second parameter aév_error_var cannot be derived from the program (because
no constanfalse or true are used but expressions, the value will be interpretedas
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that means: “start to use the variable”. To avoid confusion use only the constarts
or true as values for the second parameter.

e The usage of a variable starts after the first catl@f_error_var (ErrVariable,true).
In C++ this means that all successive lines (i.e., lines “below”), until the first
dev_error_var (ErrVariable,false) will have the assignment terrVariable. This
might lead to a different behavior compared with HDevelo@eif_error_var is called
inside a loop, because here the operators inside the loop kieforerror_var might also
useErrVariable after the second excecution of the loop body. Therefore: Try not to use
dev_error_var inside a loop. Use it right at the beginning of the program.

4.1.4.2 Compiler errors

Sometimes it happens that messages like

CC: "./example.cpp", line 17: bad operands for *: int * HTuple

or
CC: "./example.cpp", line 17: error ambiguous call
CC: "./example.cpp", line 17: choices of HTuple::operator *():
CC: "./example.cpp", line 17: HTuple: :operator *(const HTuple&) const;
CC: "./example.cpp", line 17: HTuple: :operator *(double) const;
CC: "./example.cpp", line 17: HTuple: :operator *(int) const;

are reported by the compiler. Both errors are caused by conflicting operators. In this case one
either has to change the HDevelop or thet(program. To understand how, let us look at the
code which caused the errors abdveor the first error the € program would look like this:

HTuple T1,T2;
T1 = 2 * T2;

Because there is no operatart * HTuple a compiler error is given. This error can be handled
in two ways:

1. Do appropriate type casting inH€: T1 = HTuple(2) * T2;

2. Change the order of the Operands in HDevelop and export the program again:
T1 = T2 % 2;

Both changes will do. The first one would be used by the code generation anyway.

The second error mentioned above is caused by a similar reason. The program might look like
this:

HTuple T1,T2;
long val;
Tl = T2 *x val;

1Both concrete errors shown above are hypothetical, as they would be avoided by the automatic code generation
in this special case. But they are good examples for similar errors that might be caused by conflicting operators.
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In this caseval is along variable and there is no multiplication available for the typeg in
the classiTuple. So again we have to change the program slightly by adding the cast Operator:

HTuple T1,T2;
long val;
T1 = T2 * HTuple(val);

4.2 Code Generation for Visual Basic

This section describes how to create a HALCON application in Visual Basic, starting from a
program developed in HDevelop. HALCON can be used together with Visual Basic based on
the COM interface of HALCON. A detailed description of this interface can be found in the
HALCON/COM User’'s Manual .

4.2.1 Basic Steps
4.2.1.1 Export

The first step is to export the program using the mefile > Save As. Here, select the lan-
guage (isual Basic) and save it to file. In UNIX you specify the file by giving it the cor-
responding extension, which isBas”. The result is a new file with the given name and the
extension “bas”.

4.2.1.2 The Visual Basic Template

The exported file is intended to be used together with the predefined Visual Basic project that
can be found in the directory

%HALCONROOT%\examples\vb\HDevelopTemplate

This project contains a form with a display windodWindowXCtrl) and a button labeleRun.

The file generated by HDevelop has to be added to this project. This is done by using the
menuProject > Add Module > Existing and selecting the file. Now the project is ready

for execution: Run the project and then pressihe-button of the form which will call the
exported code.

4.2.2 Program Structure

The file created by HDevelop consists of the subroukimetalcon() which corresponds to
the original program. In addition, another subroutine is created with the fam#alcon().
This subroutine applies the same initializations which HDevelop does.

Most of the variables (iconic as well as control) are declared locally in the subroutine
RunHalcon(). lconic variables insid&unHalcon() belong to the clasHUntypedObjectX
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and control variables belongtariant. The subroutin@unHalcon () has a paramet@rindow
which is of typeHWindowX. This is the link to the window in the panel where all output opera-
tions are passed to.

Depending on the program, additional subroutines and variables are declared.

4.2.2.1 Array Assignment

If a single value is assigned to a variant array, a special subroutine is called to ensure that the
index is valid. If the array is to small it is resized.

4.2.2.2 Expressions

All parameter expression inside HDevelop are translated into expressions based on the HAL-
CON tuple operators. Therefore, an expression might look somewhat complex. In many cases
these expressions can be changed to simple Visual Basic expressionsplikesub becomes
a simple subtraction. To ensure that the exported program has the same effect in Visual Basic
this exchange is not applied automatically, because the semantic is not always identical.

4.2.2.3 Stop

The HDevelop operatagtop is translated into a subroutine in Visual Basic which creates a
message box. This message box causes the program to halt until the button is pressed.

4.2.2.4 Exit

The HDevelop operatosxit is translated into the Visual Basic routimad. Because this
routine has no parameter the parametersxat are suppressed.

4.2.25 Used Classes

There are only six classes/types that are usethiriant for control parameters and
HUntypedObjectX for iconic data. In addition, there is the container cla$spleX which
comprises all operators of HALCON processing tuples, in this case the dat&dypent.

Then, there are the class@igindowXCtrl and its low level conteritWindowX. HWindowXCtrl

is used inside the project for the output window and a variable of @ssdowX directs the

output to this window. Finally, the clagSperatorSetX is used as a container for all HALCON
operators. There is no need for other classes as long as the program has the same functionality
as in HDevelop. When editing a generated program you are free to use any of the classes of
HALCON/COM to extend the functionality.

4.2.3 Limitations and Troubleshooting

Besides the restrictions mentioned in this section and in sedt®mplease also check the de-
scription of the HDevelop operators on p&fe
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4.2.3.1 Duplicate Parameters

Due to the parameter handling of Visual Basic / COM it is not possible to use the same variable
more than once in one call. Thus, for input and output parameters different variables have to be
used. Also it is not possible to use the same variable twice for input or output. Examples for

code which isnotallowed are:

mean_image (Image, Image,3,3)
add_image (Image, Image,Add,1,0)

You have to introduce additional variables.

4.2.3.2 Reserved Words

In contrast to C, &+, or HDevelop, Visual Basic has many reserved words. Thus, the export
adds the prefifixP to all variables to avoid collisions with these reserved words.

4.2.3.3 Exception Handling

In HDevelop, every exception normally causes the program to stop and report an error message
in a dialog window. This might not be useful in Visual Basic. The standard way to handle this

in Visual Basic is by using thén Error Goto command. This allows to access the reason

for the exception and to continue accordingly. Thus, for HDevelop programs containing error
handling flev_set_error_var) the corresponding code is automatically included.

Please note, that a call Gfiev_) set_check("give_error") has no influence on the operator
call. The exception willalwaysbe raised. This is also true for messages HkEESS FAIL
which are not handled as exceptions ihiCe.g..

When handling exceptions you also have to be aware that the COM interface always resets the
output parameters at the beginning of the operator execution. Thus, when the exception occures,
output variables are set Mothing. Therefore, you cannot use the values of variables used as
output parameters of the operator causing the exception.

4.2.3.4 Special Comments

HDevelop comments containing tikesymbol as the first character are exported as Visual Basic
statement. Thus the line

* #Call MsgBox("Press button to continue",vbYes,"Program stop","",1000)

in HDevelop will result in

Call MsgBox("Press button to continue",vbYes,"Program stop","",1000)

in Visual Basic. This feature can be used to integrate Visual Basic code into an HDevelop
program.

HDevelop, 2003-08-01



4.3. CODE GENERATION FOR C 91
4.3 Code Generation for C

This section describes how to create a HALCON application in C, starting from a program
developed in HDevelop.

4.3.1 Basic Steps
4.3.1.1 Program Export

The first step is to export the program using the mefile > Save As. Here, select the lan-
guage (C) and save it to file. In UNIX you specify the language by giving the file the extension
“.c”. Afile will be created that contains the HDevelop program as C source code in a proce-
dureaction(). This procedure is called in functiorain(). Besides the program code, the
file contains all necessatyinclude instructions. All variables (iconic as well as control) are
declared locally in the procedueetion (). Iconic variables belong to the clagsbject and

all other variables belong ttuple.

Please note, that in the current version the generated C code is not optimized for readability,
yet.

4.3.1.2 Compiling and Linking in Windows NT / 2000 / XP Environments

The next step is to compile and link this new program. In the Windows environment, Visual
C++ is used for the compiling and linking. Example projects can be found in the directory
%HALCONROOTY,\ examples\c\i586-nt4.

If you want to use Parallel HALCON, you have to include the librafieshalcon.1ib/.d11
and parhalconc.lib/.d11 instead ofhalcon.lib/.d11l andhalconc.lib/.d11 in your
project (see thelALCON/C ++ User’'s Manual for more details).

4.3.1.3 Compiling and Linking in UNIX Environments

To compile and link the new program (called etgst . c) in the case of UNIX, you can use the
examplenakefile which can be found in the directo®JALCONROOT/examples/c by calling

make TEST_PROG=test

Alternatively, you can set the varialblf@ST_PROG in makefile to test and then just typaake.

You can link the program to the Parallel HALCON libraries by calling

make parallel TEST_PROG=test

or just typemake parallel if you set the variabl@EST _PROG as described above.
For more details see tH¢ALCON/C User’s Manual .
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4.4 General Aspects of Code Generation

In the following, general differences in the behavior of a HDevelop program and its exported
versions are described.

4.4.1 Assignment

In HDevelop each time a new value is assigned to a variable its old contents are removed au-
tomatically, independent of the type of the variable. In the exported code, this is also the case
for iconic objects (&+: Hobject, Visual Basic:HUntypedObjectX) and for the clasdTuple

(C++) and the typevariant (Visual Basic), as they all have a destructor which removes the
stored data. As the language C does not provide destructors, the generated C code calls the
operatorsclear_obj anddestroy_tuple to remove the content of iconic output parameters
(Hobject) and control output parametetstiiple) before each operator call.

However, problems arise if a tuple (variant) contaitadle for example for a file, a window,

or for OCR. In this case, the memory of the handle is automatically remiowedot the data
which it points at In the exported programs, this data has therefore to be removed explicitely
by calling the corresponding operatarkose_* like close_ocr or close_ocv. Please insert

the close_* operators for all handles in use

e before a new value is assigned to a handle and
e at the end of the program.

In Visual Basic, the ideal way would be to use the specific COM classes for this kind of data in
combination with the member function. This exchange has to be done “by hand” because the
export is not able to generate appropriate code.

4.4.2 for -Loops

HDevelop and the programming languages have different semantics for loops, which can cause
confusion. Because the problems are so rare and the generated code would become very difficult
to understand otherwise, the code generation ignores the different semantics. These differences
are:

1. In the programming languages, you can modify the loop variable (e.g., by setting it to
the end value of the condition) to terminate the loop. This can't be done in HDevelop,
because here the current value is stored “insideftheoperator and is automatically
updated when it is executed again.

2. In the programming languages, you can modify the step range if you use a variable for
the increment. This is also not possible with HDevelop because the increment is stored
“inside” the for-operator when the loop is entered.

3. The last difference concerns the value of the loop variable after exiting the loop. In the
programming languages, it has the value with which the condition becomes false for the
first time. In HDevelop it contains the end value, which was calculated when the loop
was entered.
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Looking at the mentioned points we recommend to do the programming according to the fol-
lowing rules:

1. Don’'t modify the loop variable or the step value inside the loop. If you need this behavior
use thevhile-loop.

2. Don't use the loop variable after the loop.

4.4.3 System Parameters

You should know that HDevelop performs some changes of system parameters of HALCON
by calling the operatoset_system (See reference manual). This might cause the exported
program not to produce identical output. If such a problem arises, you may query the system
parameters by means gét_system in HDevelop after or while running the original HDevelop
version of the program. Depending to the problem, you can now modify relevant parameters by
explicitly calling the operatoset_system in the exported program.

4.4.4 Graphics Windows

The graphics windows of HDevelop and the basic windows of the HALCON libraries:(C
classHWindow, Visual Basic: classiwindowXCtrl, C: addressed via handles) have different
functionality.

e Multiple windows
If you use the operatadev_open window to open multiple graphics windows in HDe-
velop, these calls will be converted into corresponding callspein window only for
C++ and C programsin the export of Visual Basic programs, all window operations are
suppressed, because the exported code is intended to work together with the Visual Basic
template. If you want to use more than one window in Visual Basic, you have to modify
the code and project manually.

Note, that the export of programs containing multiple windows to-©r C might be
incorrect if theActivate-button was used during program execution.

e Window size
In exported Visual Basic programs, the size of the window in the panel is predefined
(512 x 512) thus it will normally not fit to your image size. Therefore, you must adapt the
size interactively or by using the properties of the window.

e Displaying results
Normally, the result of every operator is displayed in the graphics window of HDevelop.
This is not the case when using an exported program. It behaves like the HDevelop pro-
gram running with the options: “update window = off”. We recommend to insert the
operatordev_display in the HDevelop program at each point where you want to dis-
play data. This will not change the behavior of the HDevelop program but result in the
appropriate calldisp-image, disp_region, etc.) in the exported code.

When generating code for ¥3, close the default graphics window (using
dev_close_window) and open a new one (usidgv_open_window) beforethe first call of
dev_display in order to assure a correct export.
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e Displaying images

In HDevelop, images are automatically scaled to fit the current window $izes. is not

the case in exported programi§for example you load and display two images of different
size, the second one will appear clipped if it is larger than the first image or filled up with
black areas if it is smaller. For a correct display, you must use the opéeatatet _part
beforedisplaying an image witdev_display as follows:

dev_set_part (0, 0, ImageHeight-1, ImageWidth-1)
dev_display (Image)

In this example Image is the image variablelmageHeight andImageWidth denote its
size. You can query the size of an image with the opergdérimage pointeri. Please
consult the HALCON Reference Manuals for more details.

Note, that the operatatev_set_part (and its HALCON library equivalerdet_part) is

more commonly used for displaying (and thereby zoompagjsof images. By calling it

with the full size of an image as shown above, you assure that the image exactly fits the
window.

Changing display parameters

If you change the way how results are displayed (color, line width, etc.) in HDevelop
interactively via the menUisualization, these changes will not be incorporated in the
exported program. We recommend to insert the corresporginglop operators (e.g.,
dev_set_color Ordev_set_line_width) in the HDevelop program explicitely. This will
result in the appropriate cakét_color, set_line_width, etc.) in the exported code.
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Chapter 5

Program Examples

This chapter contains examples that illustrate how to program with HDevelop. To understand
the examples you should have a basic knowledge of image analysis.

The user interface is described in chapteizand2. Language details are explained in chap-
ter 3. The examples of this chapter are also available as program code in the directory

%HALCONROOT%\examples\hdevelop\Manuals\HDevelop

To experiment with these examples we recommend to create a private copy in your working
directory.

More detailed information on HALCON operators is available in the reference manuals.

5.1 Stamp Segmentation

File name: stamps.dev

The first example performs a document analysis task.Figrghows a part of a stamp catalog
page. It contains two types of information about stamps: a graphical presentation and a textual
description of the stamp.

In this example you have to transform the textual information into a representation that can
be processed by a computer with little effort. You might use an OCR program for this task,
but you will soon recognize that most of the available products create many errors due to the
graphical presentation of the stamps. Thus another task has to be preprocessed: the elimination
of all stamps (i.e., changing stamps to the gray value of the paper). After this preprocessing it
is possible to process the remaining text using an OCR program.

When creating an application to solve this kind of problem, it is helpful to describe characteristic
attributes of the objects to be searched (here: stamps). This task can be solved by a novice with
some experience, too. In this case, a characterization might look as follows:

e Stamps are darker than paper.
e Stamps are connected image areas that do not overlap.

e Stamps have a minimum and maximum size.
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Figure 5.1: Part of the page of a Michel catalog.

e Stamps are rectangular.

The task would be very simple if the attribute list would directly represent the program. Unfor-
tunately, this is not possible due to the ambiguity of spoken language. Thus you need language
constructs with a precise syntax and a semantics that are as close as possible to the informal
description. Using the HDevelop syntax, an appropriate program would look like this:
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dev_close_window ()

read_image (Catalog, ’swissl.tiff’)

get_image_pointerl (Catalog, Pointer, Type, Width, Height)
dev_open_window (0, O, Width/2, Height/2, ’black’, WindowID)
dev_set_part (0, O, Height-1, Width-1)

dev_set_draw (’°fill’)

threshold (Catalog, Dark, 0, 110)

dev_set_colored (6)

connection (Dark, ConnectedRegions)

fill_up (ConnectedRegions, RegionFillUp)

select_shape (RegionFillUp, StampCandidates, ’area’,

’and’, 10000, 200000)
select_shape (StampCandidates, Stamps,

’compactness’, ’and’, 1, 1.5)
smallest_rectanglel (Stamps, Rowl, Columnl, Row2, Column2)
dev_display (Catalog)
dev_set_draw (’margin’)
dev_set_line_width (3)
disp_rectanglel (WindowID, Rowl, Columnl, Row2, Column2)

Figure5.2shows the segmentation result.

Due to the unknown operators and unfamiliar syntax this program appears unclear to the user
at first glance.

Butif you look closer at the operators you will notice the direct relation to the description above.

threshold selects all image pixels darker than the paper.
connection merges all selected pixels touching each other to connected regions.
select_shape selects the regions with areas (attributerea’) inside a specified interval.

smallest _rectanglel computes each region’'s coordinates (row/column) of the enclosing
rectangle.

Once the user is familiar with the single operators and their syntax, the transformation becomes
easy. In particular, it is not important to the program whetiieimageor a set of regionss
processed. You can handle them both in the same way. In addition memory management of
internal data structuresis transparent to the user. Thus, you do not need to bother about memory
management and you can concentrate on the image analysis tasks to solve.

5.2 Capillary Vessel

File name: vessel .dev

The task of this example is the segmentation of a capillary vessel. In particular, you have to
separate the cell area in the upper and lower part of figlBdeft image) from the area in the
middle of the image.
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Figure 5.2: Segmentation result for stamps.

The area boundaries are very blurred and even a human viewer has difficulties recognizing
them. At first glance it seems very difficult to find a segmentation criterion: There is neither a
clear edge nor a significant difference between the gray values of both areas. Thus it is not very
promising to use an edge operator or a threshold operation.

One solution of this problem makes use of the different textures within the areas: Cells are more
textured than the part which is supplied with blood. To emphasize this difference you can use a
texture transformatioy Laws. Texture transformations are linear filters that intensify certain
frequencies which are typical for the requested texture. The corresponding HALCON operator
is texture_laws. You have to specify the filter size and type. Both attributes determine the
frequency properties. In this program the filten > with mask size 5 5 is used. It performs a
derivation in vertical direction and a smoothing in horizontal direction. Thus structures in verti-
cal direction are intensified. You cannot directly use the computed restdkofire_laws (see
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Figure 5.3: Capillary vessel (left) and texture transformation (right).

figure5.3right), because it is too speckled. Therefore you must generalize the texture image by
a mean filterfean_image). From this you obtain the so calléeixture energyfigure 5.4 left).

Figure 5.4: Capillary vessel texture energy (left) and segmentation (right).

The filter mask is chosen very large within this program. The mask size for the horizontal
direction is 211 and 61 for the vertical direction. The asymmetry is used, because the vessel is
nested in horizontal direction. From this you obtain an image with an upper and lower part that
is brighter than that in the middle.

read_image (Image, ’vessel’)

texture_laws (Image, Texture, ’el’, 5, b)
mean_image (Texture, Energy, 211, 61)
bin_threshold (Energy, Vessel)

To separate these areas you just have to find the appropriate threshold. In this case — we
have only two types of textures — the threshold can be found automatically. This is done by
the operatobin_threshold, which also applies the resulting threshold and thus extracts the
vessel. The right side of figuie4 shows the result of the segmentation.
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5.3 Particles

File name: particle.dev
This program example processes an image that was taken from a medical application. It shows
tissue particles on a carrier (figused left).

».

Figure 5.5: Tissue particles (left) and large objects (right).

As in many other medical applications, the existing objects have to be evaluated statistically.
This means that different objects have to be extracted and classified according to their size or
other attributes for example. After this, you can analyze them. An important step to solve this
problem is the image segmentation that locates the relevant objects. For the statistical evaluation
you may have a look at appropriate literature about statistics.

In our case there are two object classes:

e large, bright particles

e small, dark particles

The large, bright particles differ clearly from the background because of their gray values. The
informal description 'brighter than the background’ leads directly to the algorithmic solution
using a thresholding. The only thing to decide is whether you specify the threshold automat-
ically or empirically. In our case, a fixed threshold is completely sufficient due to the good
contrast. Hence you get the following simple segmentation operator:

read_image (Particle, ’particle’)
threshold (Particle, Large, 110, 255)

The variabld.arge contains all pixels whose gray values are brighter than 110. You can see the
result on the right side of figure.5.

It is more difficult to find the small, dark particles. A first effort to specify a threshold inter-
actively shows that there is no fixed threshold suitable to extract all particles. But if you look
closer at the image you will notice that the smaller particles are much brighter than their local
environment, i.e., you may specify suitable threshold values that are valid for a small image part
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each. Now it is easy to transform this observation into an algorithm. One way is to determine
the threshold values locally (e.g., from a bar chart). Another solution might be the definition of
a local environment by an x n window. This method is used in the example. The window’s
mean value is used as an approximation of the background intensity. This can be done by ap-
plying a low pass filter, such as a mean filter or a Gaussian filter. The window sleénes

the size of the local environment and should approximately be twice as large as the objects to
search for. Since they show an average diameter of 15 pixels, a mask size of 31 is used.

The resulting pixels are specified by the comparison of the original gray values with the mean
image. To reduce problems caused by noise you add a constant to the mean image (3). The
appropriate program segment looks as follows:

mean_image (Particle, Mean, 31, 31)

dyn_threshold (Particle, Mean, Small, 3, ’light’)

The operatodyn_threshold compares two images pixel by pixel. You can see the segmenta-
tion result in figureb.6 left.

Figure 5.6: Small objects: simple (left) and advanced segmentation (right).

As we see, all objects have been found. Unfortunately, the edges of the large particles and
several very small regions that emerged due to the noisy image material were found, too.

We first try to suppress the edges. One way is to eliminate all objects that exceed a certain
maximum size. You can do this by calling:

connection (Small, SmallSingle)
select_shape (SmallSingle, ReallySmall, ’area’, ’and’, 1, 300)

By the same method you might also eliminate all objects which are too small (blurring). For
this, you would just have to increase the minimum size with the calkbéct_shape. But if

you examine the segmentation results again, you will notice that some of the resulting pixels
were already extracted by the first segmentation. Thus you should search the small particles
within the complement of the large ones only. To avoid the segmentation of small particles in
the direct neighbourhood of the large ones, those are enlarged before building their complement.
Thus we get the following modified program:
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dilation_circle (Large, LargeDilation, 8.5)
complement (LargeDilation, NotLarge)

reduce_domain (Particle, NotLarge, ParticleRed)
mean_image (ParticleRed, Mean, 31, 31)
dyn_threshold (ParticleRed, Mean, Small, 3, ’light’)

This method shows two advantages: First, the (reliable) model of the large particles can be used
to extract the small ones. This increases the quality of the segmentation. Second, the processing
speed is increased, as the second segmentation works only on a part of the image data. The right
side of figure5.6 shows the segmentation result.

Unfortunately, the image still contains noise. To remove it, you may either sort out noisy objects
by their area as described above, or byogeningoperation. We prefer the second method as
it additionally smooths the object edges.

opening_circle (Small, SmallClean, 2.5)

Here, a circle is used as the structuring element of the opening operation. The operator preserves
regions only that may at least cover a circle of radius 2.5. Smaller regions are eliminated.
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Figure 5.7: Noise-removed segmentation (left) and final result (right).

Figure5.7 shows the result of the segmentation with noise removal on the left side. The right
side contains the final result.

Finally, we would like to show within this example how to select regions with the mouse in-
teractively. At this, a loop is executed until you press the middle or right mouse button. When
pressing a mouse button, the operaiet_mbutton returns the button that was pressed and
the position (coordinates) where it was pressed. This information is used to select the chosen
object. In the following you see the corresponding program part:
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dev_clear_window (WindowID)

connection (SmallClean, SmallSingle)

Button := 1

dev_set_color (’red’)

while (Button = 1)
get_mbutton (WindowID, Row, Column, Button)
select_region_point (SmallSingle, OneObject, Row, Column)
intensity (OneObject, Particle, MeanGray, Deviation)

endwhile

First, the window is cleared videv_clear window. After that, connection calculates all
connected components to allow the selection of single regions. This also displays the region
components in the HDevelop window. Then you may set the drawing color (here: red) to
visualize the selected regions. The loop is initialized by assigning 1 to the vabiabien (1

is the code for the left mouse button). Within the loop the mouse state is queried and the chosen
region is selected. As an example the mean gray value and the standard deviation are computed
for each selected region. As long as you press only the left mouse button within the window the
loop continues. You can terminate it by pressing any other mouse button.

5.4 Annual Rings

File name: wood .dev

Everyone knows the task to determine the age of a tree by counting its annual rings. This will
now be done automatically using the example program. The first step is the segmentation of
annual rings. This is quite simple as you can see them clearly as bright or dark lines. Again, the
dynamic thresholdingifyn_threshold) can be used (as before during the particle segmentation

in section5.3). To achieve a suitable threshold image you apply the mean filéen(image)

with size 15x 15 first.

The segmentation result contains many tiny regions that are no annual rings. To eliminate them
you have to create the connected componerisnection) and suppress all regions that are

too small gelect_shape). Counting the rings becomes difficult, as there might be fissures in
the wood (see figurg.8).

Thus, we suggest the following method: You define the start and end point of a line across the
annual rings using your mouse. Then the number of intersections with annual rings is counted
along this line. This can be done by the following HALCON operators: The start and end points,
represented by their x- and y-coordinates, are transformed into géineregion line). This

line is intersectediltersection) with the annual ringsSelectedRegions). The number

of the connected regionsdunt_obj) in this intersection is the number of annual rings. The
complete program looks as follows:
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Figure 5.8: Annual rings of a tree.

dev_close_window ()
read_image (WoodPiecel, ’woodring’)
get_image_pointerl (WoodPiecel, Pointer, Type, Width, Height)
dev_open_window (0, O, Width/2, Height/2, ’black’, WindowID)
mean_image (WoodPiecel, ImageMean, 9, 9)
dyn_threshold (WoodPiecel, ImageMean, Regions, 5.0, ’dark’)
threshold (WoodPiecel, Dark, 0, 90)
dilation_rectanglel (Dark, DarkDilation, 30, 7)
difference (Regions, DarkDilation, RegionBright)
connection (RegionBright, ConnectedRegions)
select_shape (ConnectedRegions, SelectedRegions,
’area’, ’and’, 30, 10000000)
get_mbutton (WindowID, Rowl, Columnl, Buttonl)
get_mbutton (WindowID, Row2, Column2, Button2)
gen_region_line (Line, Rowl, Columnl, Row2, Column2)
intersection (Line, SelectedRegions, Inters)
connection (Inters, ConnectedInters)
Number := |ConnectedInters|

5.5 Bonding

File name: ball.dev
This is the first example in the field of quality inspection. The task is to detect bonding balls.
Figure5.9shows two typical microscope images dia.

Thedie border and the bonding wires appear dark. Thus you may apply a thresholding. Since
the background is also dark we have to extractdiedbefore doing the segmentation. Ttie
is rather bright. Thus we can select the pixels by their gray values.
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Figure 5.9: Examplary images with bonding balls on a die.

read_image (Bond, ’die3’)
threshold (Bond, Bright, 120, 255)
shape_trans (Bright, Die, ’rectangle2’)

All pixels of thedie that got lost by the thresholding can be recoverd by using a hull compu-
tation. Since thelie is rectangular and may be slightly turned during the assembly we use the
smallest enclosing rectangle as a hull.

Now you can start the segmentation of wires and bonding balls. Since only those parts of wires
and balls are of interest that lie within tldee area, you may restrict the segmentation to this
region. All dark pixels within thelie area belong to wires. Unfortunately, there are some bright
reflections on the wires that are not found by the segmentation. You may fill these gaps by using
i1l _up_shape. In our case, the gaps with a certain size (1 up to 100 pixels) are filled.

reduce_domain (Bond, Die, DieGray)

threshold (DieGray, Wires, 0, 100)

£ill_up_shape (Wires, WiresFilled, ’area’, 1, 100)

opening_circle (WiresFilled, Balls, 15.5)

connection (Balls, SingleBalls)

select_shape (SingleBalls, IntermediateBalls, ’circularity’,and,0.85, 1.0)
sort_region (IntermediateBalls, FinalBalls, ’FirstPoint’, ’True’, ’column’)
smallest_circle (FinalBalls, Row, Column, Radius)

Since the balls are wider than the wires, you may clean this region using a simple opening.
The radius (here 15.5) should correspond to the minimum size of one ball. In both images
you see an erroneous segmentation that was created by a rectangular dark region. This can be
suppressed by a shape segmentation. Since in practice a bonding detection would be performed
only close to the anticipated positions of bonding balls. Figufé® shows the results of the

whole segmentation.

Balls are shown in white color. Every radius of a ball you can find in the tuple variable Radius.
The number of balls within the example you can get with the absolute value of Radius.
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Figure 5.10: Detected bonding positions.

NumBalls := |Radius|

Diameter := 2*Radius

MeanDiameter := sum(Diameter)/NumBalls
MinDiameter := min(Diameter)

Diameter, MeanDiameter and MinDiameter are some examples for calculations possible with
HDevelop.

5.6 Calibration Board

File name: calib.dev

This example works with the image of a calibration board. It is used to specify the internal
parameters of a CCD camera. Therefore, you have to extract the circles on the board (see left
side of figure5.17).

This example describes an interesting operator. It is cgteg_inside and is a so-called
fuzzy operatarin this case, fuzzy means that the value of each pixel is not interpreted as gray
value but as thaffiliation to a certain class. The bigger the number (max. 1), the stronger the
affiliation.

By applyinggray_inside to an image every pixel value is interpreted as the “potential energy”
you have to afford to get from the pixel position to the image border. The dark pixels present
valleys and the bright pixels mountains. Thus a dark region in the middle of an image is equiv-
alent to a hole in a mountain that needs a lot of energy to be left. This is also true for the dark
circles on the bright background in the image of the calibration board.

Before callinggray_inside you should use a smoothing filter to suppress small valleys. This
reduces runtime considerably.

If you look at the operator result on the right side of figbré1you will notice the circles as
significant bright points. Now a simple thresholding is sufficient to extract them.

1In HALCON the range of 0 to 1 is mapped to values of a byte image (0 to 255).

HDevelop, 2003-08-01



5.7. DEVICES 107

Figure 5.11: Calibration board and gray_inside result.

read_image (Caltab, ’caltab’)
gauss_image (Caltab, ImageGauss, 9)
gray_inside (ImageGauss, ImageDist)
threshold (ImageDist, Bright, 110, 255)
connection (Bright, Circles)
elliptic_axis (Circles, Ra, Rb, Phi)

After calculating the ellipse parameters of each cirelel{ptic_axis), you may compute the
camera parameters.

5.7 Devices

File name: ic.dev

This example discusses the combination of different segmentation methods. It works with an
image of multiple electronic components. These differ in shape, size and arrangement. The left
side of figure5.12shows the input image.

First you extract resistors and capacitors. This is quite simple because you have a color image
and both component types have different colors. The input image consists of three channels
containing the red, green, and blue channels. Since segmentation in the RGB space is difficult,
you have to transform the image into the HSV space. Here the color information is stored in
one single channel. The right side of figlrd2shows the image representation in this channel
(Hue). Elements that are too small can be eliminatedseéirect_shape. The program sequence

to extract resistors and capacitors is shown below:
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Figure 5.12: Board with electronic devices (left) and the corresponding color value image in the
HSV space (right).

read_image (ICs, ’ic’)

decompose3 (ICs, Red, Green, Blue)

trans_from_rgb (Red, Green, Blue, Hue, Saturation, Intensity)
threshold (Saturation, Colored, 100, 255)

reduce_domain (Hue, Colored, HueColored)

threshold (HueColored, Blue, 114, 137)

connection (Blue, BlueConnect)

select_shape (BlueConnect, Bluelarge, ’area’, ’and’, 150, 100000)
shape_trans (BluelLarge, Condensators, ’rectangle2’)

threshold (HueColored, Red, 10, 19)

connection (Red, RedConnect)

select_shape (RedConnect, RedLarge, ’area’, ’and’, 150, 100000)
shape_trans (RedLarge, Resistors, ’rectangle2’)

If you look closer at this program segment you will notice some obvious enhancements that can
be made. One is necessary due to the color model: The thresholding of the color image chooses
all pixels with a certain color. This selection is independent of the color saturation. Thus it
might happen that very bright pixels (nearly white pixels) or very dark pixels (nearly black
pixels) have the same color value as the components. But you are only looking for stronger
colors. For this you select all pixels first whose color is strong, i.e., all pixels with a high
saturation.

The second enhancement concerns the objects’ shape. As the devices are rectangular you
can specify the smallest enclosing rectangle of all connected components to enhance the seg-
ments.On the left side of figuie 13the resulting components are marked.

In a second step, we will search for all ICs. This seems to be easy, as they are rather large
and dark. However, some problems emerge due to the bright labels that are printed across
some ICs. Thus a simple thresholding alone is not sufficient. In addition you have to combine

the segments belonging to one IC. This is done by examining the spatial adjacencies of the
segments. A dilation is used to enlarge the regions until they overlap each other. This dilation

must not be so large that different ICs are merged. Thus gaps caused by labels have to be
smaller than gaps between ICs. Now you can separate the enlarged ICs in their connected
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Figure 5.13: Resistors and capacitors (left) and ICs (right).

components. Unfortunately, they have become too large by the dilation. Another thresholding
for each connected component will detect the dark pixels of each IC. Finally, you can specify
the enclosing rectangles analogously to the resistors and the capacitors (see above).

threshold (Intensity, Dark, 0, 50)
dilation_rectanglel (Dark, DarkDilate, 15, 15)
connection (DarkDilate, ICLarge)

add_channels (ICLarge, Intensity, ICLargeGray)
threshold (ICLargeGray, ICsDark, 0, 50)
shape_trans (ICsDark, IC, ’rectangle2’)

The right side of figures.13 shows the resulting ICs. We have to mention two aspects
about the program segment above. Here the opesdibrchannels has been used instead
of reduce_domain. Thisis necessary agverakegions have to be “supplied” with gray values.
The situation of previous programs was quite different: there the number of valid pixate of
image has been restricted. From this follows the second point: here the opgradshold

gets several images as inguthe thresholding is performed in every image. Thus you receive
as many regions as input images.

Finally, the segmentation of IC contacts has to be done. They are bright and small. Thus it
is easy to extract them using a dynamic thresholding (compare ctapteHowever, several

other tin elements on the board remain a problem, because they have to be distinguished from
the IC contacts. This can be done by restricting the searchregi@n of interestIC contacts

may only appear either on the right or the left side of IC’s. The coarse region of interest is
defined by enlarging the IC regions with a following set subtraction. Then the result is resized
appropriately by using another dilation. Figird.4shows the operator result on the left side.

Now you only have to intersect the result of the thresholding with the region of interest.

20ne matrix is shared by several iconic objects to reduce costs of memory and computation time.
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Figure 5.14: Searching regions for contacts (left) and IC contacts (right).

dilation_rectanglel (IC, ICWidth, 5, 1)

difference (ICWidth, IC, SearchingArea)

dilation_rectanglel (SearchingArea, SearchingAreaWidth, 14, 1)
unionl (SearchingAreaWidth, SearchingAreaUnion)

reduce_domain (Intensity, SearchingAreaUnion, SearchGray)
mean_image (SearchGray, Mean, 15, 15)

dyn_threshold (SearchGray, Mean, Contacts, 5, ’light’)

connection (Contacts, ContactsConnect)

f£ill_up (ContactsConnect, ContactsFilled)

select_shape (ContactsFilled, ContactsRes, ’area’, ’and’, 10, 100)

The result of the intersection is still not satisfying. Too many small and too many wrong regions
have been found. So we have to eliminate them by usélgct_shape. Figure5.14shows the
final result of the segmentation on the right side.

5.8 Cell Walls

File name: wood_cells.dev
In this example we will examine the alteration of the cell wall's proportion during a tree’s

growth. The input image is a microscope view of wooden cells (see flgage
You can clearly see the single cells and the discontinuity that is caused by the stopped growing
in winter.

Extracting cell walls is simple because they are significantly darker. The remaining “difficulty”

lies in the computation of the distribution in growth direction, i.e., along the image x-axis. First,

we define the width of the window over which the cell distribution is computed by assigning it to

the variableX in the program. Then we fetch the image size ugjet image pointerl to get

the corresponding loop parameters. The broader the search range, the stronger the smoothing

during the measurement.

Now the loop starts from the “left” side to compute the whole image. The ratio of the area of
the cell walls and a rectangle of widxhs computed for every value of the loop variableThe
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Figure 5.15: Microscope image of wooden cells.

number of pixels belonging to a cell wallfea) is determined byarea_center. This value is
transformed to percent for the output.

X =20

read_image (WoodCellsl, ’woodcell’)

threshold (WoodCellsl, CellBorder, 0, 120)

get_image_pointerl (WoodCellsl, Pointer, Type, Width, Height)

open_file (’wood_cells.dat’, ’output’, FileHandle)

for i := 0 to Width-X-1 by 1
clip_region (CellBorder, Part, O, i, Height-1, i+X)
area_center (Part, Area, Row, Col)
fwrite_string (FileHandle, i + > ’ + (Area * 100.0 / (X * Height)))
fnew_line (FileHandle)

endfor

close_file (FileHandle)

Figure5.16shows the measurement result.

To allow further processing of the data (such as for plotting uginglot as in figure5.16

it has to be written to a file. Therefore, a text file is opened fisgef file). Now you can
write to this file by usingwrite_string andfnew_line. Note the formatting of output when
usingfwrite_string. The output text starts with the loop variable that is followed by a space
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Figure 5.16: Cell wall proportion in growth direction in percent.

character. Thus the number is transformed into a string. Finally, the proportion of the cell wall
(in percent) is concatenated to the string. At this it is important that the first or second value
of the expression is a string, so that the following numbers are converted into strings+ Here
denotes the concatenation of characters instead of the addition of numbers.

5.9 Region Selection

File name: eyes.dev

This example explains how to handle single iconic objects. In contrast to numerical data, where
many different functions may be executed on parameter positions (see cB.&ptaronic ob-

jects may only be handled by using HALCON operators. The most important operators to select
and combine iconic objects are shown in this example.

The task is to search the eyes of the mandrill in figu e,

This is a simple task. First, we extract the bright parts by a thresholding. Then we have to
examine the connected components according to their shape and size to select the eyes. At this,
you could use the operateelect_shape and get a fast program of five lines that processes the
task. For demonstration purpose we use a kind of “low level” version instead: every region is
extracted separately and examined afterwards. If it conforms to a given shape, it is added to a
result variable.
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Figure 5.17: Mandrill and the detected result.

dev_close_window ()
read_image (Image, ’monkey’)
threshold (Image, Region, 128, 255)
connection (Region, ConnectedRegions)
select_shape (ConnectedRegions, CompactRegions,
’compactness’, ’and’, 1.5, 1.8)
Number := |CompactRegions|
Eyes := []
for i := 1 to Number by 1
SingleSelected := CompactRegions[i]
area_center (SingleSelected, Area, Row, Column)
dev_set_color (’green’)
if ((Area > 500) and (Area < 50000))
dev_set_color (’red’)
Eyes := [SingleSelected,Eyes]
endif
endfor

Note that you have to specify the number of regiotisuft_obj) in order to run afor loop

from 1 toNumber. Within this loop a region is selectedglect_obj) according to the loop
variablei in order to evaluate its attributes. If its area is within certain bounds the region is
added to variabl€yes (concat_obj). You have to specify the variab®yes properly, as it is
also used as input faroncat_obj. This can be done by usingnpty_object that assigns no
iconic object in a defined way to the variable, iunt_obj returns zero for it.

During the run time of the program you can see how the individual regions are selected and
examined. To speed up the processing you can use the m@au> Options to suppress the
automatic output.

5.10 Exception Handling

File name: exception.dev
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In some applications it is necessary to have explicit control over the result state of an operator.
By default HDevelop stops if an operator returns a different state Hhé8G_TRUE and gives

an error message. To have explicit control over the result state, two HDevelop operators are
available: dev_error_var anddev_set_check. The following example shows how to use
these operators.

The task is to get online information about the position of the mouse inside a graphics window
and to display the gray value at this position. This can be achieved using the two operators
get_mposition andget_grayval. The problem withget mposition in HDevelop is, that it
returnsiH_MSG_FAIL if the mouse is outside of the window to indicate that the mouse coordinates
are invalid. This would lead to an interruption of the program. Therefore an explicit error
handling is needed. The complete program is given below:

read_image (Image, ’mreut’)
dev_close_window ()
dev_open_window (0, 0, -1, -1, ’black’, WindowID)
dev_display (Image)
Button := 1
while (Button # 4)
dev_error_var (Error, 1)
dev_set_check (’“give_error’)
get_mposition (WindowID, Row, Column, Button)
dev_error_var (Error, 0)
dev_set_check (’give_error’)
if (Error = H_MSG_TRUE)
get_grayval (Image, Row, Column, Grayval)
dev_set_color (’black’)
disp_rectanglel (WindowID, O, O, 22, 85)
dev_set_color (’white’)
set_tposition (WindowID, 15, 2)
write_string (WindowID, ’(’+Row+’,’+Column+’)=’+Grayval)
endif
endwhile

After loading an image and opening a window we enter the loop to query the mouse position.
Because the operat@et_mposition might cause an exception we cakv_set_check to
declare that HDevelop should not stop if an exception ocal#s.set_check has to be called
before and after the critical call(s). If we want to know which error occurred we have to specify
the variable in which the return value will be stored. This is done by ugévgerror_var.

Now get mposition can be called independent of the context. To check if the coordinates
are valid, the error variable is compared to one of the constants for standard return values (like
H_MSG_TRUE or H.MSG_FAIL). If the call succeeded, this coordinate is used to query the gray
value of the corresponding pixel in the image, which is then displayed in the window.

5.11 Road Scene

File name: road_signs.dev
The computing time is a critical factor in many image analysis tasks. Thus the system has
to offer features to speed up the processing. But direct hardware access must be avoided in
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any case. All operators should work on encapsulated data structures. To allow optimization for
performance, data structures have to be used that support transparent and efficient programming.
The example segmentation of a road scene demonstrates how HALCON helps to achieve this
goal.

Here the task is to find the middle and border road markings of a motorway. The program is
performed by a normal workstation with a processing time of maximum 20 ms per half image
(video frequency) at a resolution of 5%2512 pixels. In figuré.18you see an image of such

a road sequence on the left side.

Figure 5.18: Part of an image sequence (left) and search grid for marking band (right).

Assume that there is no specialized operator for this task. Thus, you have to make use of
standard methods. The data structure used consists of a gray value image with a covering mask,
i.e., the definition rang&. All operators work only on those parts of the image data that lie
within the definition range. This can be exploited to reduce computation time.

The following assumptions on the image data help to specify a region as a search mask:

1. Road markings remain in a certain image part only.
2. Road markings have a certain minimum length in y-direction.

3. Road markings are separated by an edge from their environment.

The first two assumptions can restrict the search area enormously. To make use of this, we
create a region as a grid whose line distance is determined by the minimum size of the road
marking. Figures.18shows the corresponding region (= line grid) on the right side.

While performing an edge filter within the grid all pixels with a high gradient are candidates
on the contour of a road marking. By enlarging these pixels by the minimum diameter of the
markings (dilation) with rectangle, you will get the search window shown in fi§ut8on the

left side.

Now the road markings can be easily extracted by a thresholding within the search windows.
The segmentation result is shown on the right side of figut& The corresponding HDevelop
program looks as follows:

3See the manu#etting Started for a short introduction to the data structures used by HDevelop.
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Figure 5.19: Search areas for markings (left) and segmentation (right).

MinSize := 30

set_system (’init_new_image’, ’false’)

read_image (Motorway, ’motorway’)

count_seconds (Seconds1)

gen_grid_region (Grid, MinSize, MinSize, ’lines’, 512, 512)
clip_region (Grid, GridRoad, 130, 10, 450, 502)
reduce_domain (Motorway, GridRoad, Mask)

sobel_amp (Mask, Gradient, ’sum_abs’, 3)

threshold (Gradient, Points, 40, 255)

dilation_rectanglel (Points, RegionDilation, MinSize, MinSize)
reduce_domain (Motorway, RegionDilation, SignsGray)
threshold (SignsGray, Signs, 190, 255)

count_seconds (Seconds?2)

Time := Seconds2-Secondsl

dev_display (Signs)

First you create a grid by usingen _grid region. It is reduced to the lower image half with
clip_region. The operatoreduce_domain creates an image containing this pattern as def-
inition range. This image is passed to the operatdrel_amp. You obtain pixels with high
gradient values usinghreshold. These pixels are enlarged to the region of interest (ROI) by a
dilation with a rectangular mask. Within this region another thresholding is performed. Correct
road markings are equivalent to bright areas in the search window (ROI).

The HALCON program needs an average of 20 ms on a standard Pentium. Notice that this is
even possible under the following restrictions:

1. Only standard operators have been used.

2. Only encapsulated data structures have been used.

3. Despite optimization the program is quite comprehensible.
4. The program is very short.

This example shows that you can write efficient programs even while using complex data struc-
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tures. Hence a significant reduction of development time is achieved. Furthermore, data encap-
sulation is a basic condition for the portability of the whole system and the user software.
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Chapter 6

Miscellaneous

This chapter contains helpful information for working with HDevelop.

6.1 Keycodes

In order to speed up the entering of values in the input fields of HDevelop (e.g., operator pa-
rameters), several keycodes are defined, which have special functions. They conform to the
standards of themacs editor. This feature is only available for UNIX systems. Some of them
are shown in tablé.1

Delete Delete single character at current cursor position.

<Ctrl> a | Move the cursor to the beginning of the line.

<Ctrl> b | Move cursor left one character.

<Ctrl> d | Analogous tDelete

<Ctrl> e | Move cursor to last character in line.

<Ctrl> f | Move cursor right one character.

<Ctrl> h | Delete single character immediately preceding current cursor position
<Ctrl> k | Delete all characters from current position to end of line.
<Meta> b | Backward to previous word.

<Alt> b | Backward to previous word.

<Meta> d | Delete from current cursor position to end of current word.
<Alt> d | Delete from current cursor position to end of current word.
<Meta> f | Forward to next word.

<Alt> f | Forward to next word.

Table 6.1: Keycodes for special editing functions.

6.2 Interactions During Program Execution

The interpreter of HDevelop allows some user interactions during the execution of a program.
First, the stop button has to be mentioned, which is responsible for interrupting the execution
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of a program. When the stop button is pressed, the execution is stopped at the active HALCON
operator.

Other features of the HDevelop interpreter are the possibility to display iconic variables by
simply double clicking on them, and the facility to set the parameters which control the display
to the appropriate values. In addition to this, it is possible to insert commands into the program
text, no matter whether this makes any sense or not. Please note that interactions during the
execution of HALCON application can only be used in a sensible way, if the single operators
have short runtimes, because HDevelop can only react within the “gaps”, that is, between the
calls to the HALCON library.

Please note that neither t®€ nor theBP can be set during the execution of the HALCON
application.

6.3 Online Help

Online documentation is available in PDF and partly in HTML format. In a UNIX environment,
the full documentation is available in postscript format as well.

To display the HTML files containing information on HALCON operators, you need a browser.

It is not provided in the HALCON distribution, but nevertheless used by HDevelop. Such a
tool may already be installed on your computer. Otherwise you may obtain it for free, e.g., via
the Internet. One browser that is suitable for displaying HTML files is Netscape Navigator. It
is a WWW browser that is able to display HTML documents. Since the reference manual for
HALCON operators is also stored in HTML format, it is convenient to use a standard WWW

browser. In the tool HDevelop you may call Netscape via the niiedg > html-help. It will

start Netscape with the corresponding help files (see p&ageAn alternative to Netscape is to

use the Microsoft Internet Explorer.

Besides HTML, the documentation is available in PDF format as well. To display the manuals,
the Adobe file viewer Acrobat Reader is included in the distribution for Windows systems. This
viewer is not activated from HDevelop, but has to be started from the Windows start menu.

6.4 Warning and Error Windows

Warning and error windows are popups, that make the user aware of user errors. Usually, they
interrupt the faulty actions with a description of the error. For this purpose information about
the kind of the error is determined during the execution. Figuieshows an example of an

error window.

6.5 Restrictions

Not every HALCON operator that is available in HALCON/C or HALCON/C++ can or should
be used in HDevelop. There are two reasons for this. On the one hand the HALCON system
is influenced by HDevelop so deeply, that some operators don’t behave like in a normal user
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Ermror |

Q guntay emor in parameter #1: <"car''>

Figure 6.1: Example for an error window.

program. Usually this concernes the graphical operatorsskkecolor. For this class of
operators, specific versions for HDevelop are available, &g.set_color.

On the other hand some low-level operators exist (fi&get_obj_db or clear_obj), that will
bring HDevelop “out of balance.”

Not the whole functionality of HDevelop can be transferred to a C++-program, because the
graphics windows of HDevelop are more comfortable than the simple HALCON windows.

However, the points described above are very special and will not bother the normal user,
because the appropriate functions can be found in both working environments. If you use
dev_set_color in HDevelop, for example, you would uset_color as its counterpart in
HALCON/C++. Further restrictions can be found in sectoh.4

HALCON 6.0.4



122 CHAPTER 6. MISCELLANEOUS

HDevelop, 2003-08-01



Appendix A

Control

assign ( : : Input : Result )

Assign a new value to a control variable.

assign assigns a new value to a variable. In HDevelop an assignment is treated like an op-
erator. To use an assignment you have to select the opesatogn (Input ,Result). This
operator has the following semantics: It evaluatesut (right side of assignment) and stores

it in Result (left side of assignment). However, in the program text the assignment is repre-
sented by the usual syntax of the assignment operatet. The following example outlines

the difference between an assignment in C syntax and its transformed version in HDevelop:

The assignment in C syntax
u = sin(x) + cos(y);

is defined in HDevelop using the assignment operator as
assign(sin(x) + cos(y), w)

which is displayed in the program window as:

u := sin(x) + cos(y)
Parameter.
> Input (inputcontrol) .......... .. ..o, real(-array)~ reall integer / string
New value.
Default Value : 1
> Result (outputcontrol) .......................... real(-array)~ reall integer / string

Variable that has to be changed.
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Example
Tuplel := [1,0,3,4,5,6,7,8,9]
Val := sin(1.2) + cos(1.2)
Tuplel[1] := 2
Tuple2 := []
for i := 0 to 10 by 1
Tuple2[i] := i
endfor
Result

assign returns 2 (HMSG_TRUE) if the evaluation of the expression yields no error.

Parallelization Information
assign is reentrant local, and processedithoutparallelization.

Alternatives

insert

Module

Basic operators

break ( : : : )

Terminate loop execution.

break terminates the smallest enclosifigr or while loop. Program execution is continued at
the next program line after the end of the loop or at the next line aftesrtbek statement in
case no enclosing loop exists.

Example

read_image (Image, ’monkey’)
threshold (Image, Region, 160, 180)
connection (Region, Regions)
Number := |Regions]|
AllRegionsValid := 1
* check if for all regions area <=30
for i := 1 to Number by 1
ObjectSelected := Regions[i]
area_center (ObjectSelected, Area, Row, Column)
if (Area > 30)
AllRegionsValid := 0
break ()
endif
endfor

Result

break always returns 2 (HMSG_TRUE)
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Parallelization Information
break is reentrant local, and processedithoutparallelization.

See Also

for,while
Module

Basic operators

comment ( : : Comment : )

Add a comment of one line to the program.

comment allows to add a comment of one line to the program. As parameter value, i.e. as
comment, all characters are allowed. This operator has no effect on the program execution.

Parameter

> Comment (INputcontrol) ... string string
Arbitrary sequence of characters.

Example

* This is a program width comments
* ’this is a string as comment’

* here are numbers: 4711, 0.815
stop ()

Result
comment always returns 2 (HMSG_TRUE).

Parallelization Information
comment is reentrant local, and processedithoutparallelization.

Module

Basic operators

exit (: : :)

Terminate HDevelop.

exit terminates HDevelop. The operator is aquivalent to the nféne > Quit. Internally
and for exported C++ code the C-function cattit (0) is used.

Example

read_image (Image, ’fabrik’)

intensity (Image, Image, Mean, Deviation)
open_file (’intensity.txt’, ’output’, FileHandle)
fwrite_string (FileHandle, Mean + ’ ’ + Deviation)
close_file (FileHandle)

exit ()
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Result
exit returns 0 (0.k.) to the calling environment of HDevelop = operating system.

Parallelization Information
exit isreentrant local, and processedithoutparallelization.

See Also
stop
Module
Basic operators
for ( : : Start, End, Step : Variable )

Execute the body for a fixed number.

The for loop is controlled by a start and termination value and an incrementation value that
determines the number of loop steps. These values may also be expressions which are evaluated
immediately before the loop is entered. The expressions may be ofifiteger or of type

real. If all input values are of typeénteger the loop variable will also be of typenteger.

In all other cases the loop variable will be of typeal. If the start value is less or equal to the
termination value, the loop index is assigned with the starting value and the body of the loop
is entered. If the increment is less than zero the loop is entered if the start value is larger or
equal to the end value. Each time the body is executed, the loop index is incremented by the
incrementation value. If the loop index is equal to the termination value, the body of the loop is
performed for the last time. If the loop index is larger than the termination value the body will
not be excecuted any longer. For negative increment values the loop is terminated if the loop
index is less than the termination value.

Please note that it is not necessary, that the loop index has to be equal to the termination value
before terminating the loop. The loop index is set to the termination value when the loop is
being left. Please note, that the expressions for start and termination value are evaluated only
once when entering the loop. A modification of a variable that appears within these expressions
has no influence on the termination of the loop. The same applies to the modifications of the
loop index. It also has no influence on the termination. The loop value is assigned to the correct
value each time theor operator is executed.

If the for loop is left too early (e.g. if you pressop and set theé’C) and the loop is entered
again, the expressions will be evaluated, as if the loop were entered for the first time.

Attention
For exported C++ please note the different semantics of the for loop.
Parameter.
> Start (inputcontrol) .......... . number integerl real

Start value for the loop variable.
Default Value : 1
> End (inputcontrol) . ... numberintegerl real
End value for the loop variable.
Default Value : 5
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> Step (inputcontrol) ... number integer real
Increment value for the loop variable.
Default Value : 1

> Variable (Qutputcontrol) ..., number integerl real
Loop variable.

Example

dev_update_window (’off’)

dev_close_window ()

dev_open_window (0, 0, 728, 512, ’black’, WindowID)
read_image (Bond, ’die3’)

dev_display (Bond)

stop ()

threshold (Bond, Bright, 100, 255)

shape_trans (Bright, Die, ’rectangle2’)
dev_set_color (’green’)

dev_set_line_width (3)

dev_set_draw (’margin’)

dev_display (Die)

stop ()

reduce_domain (Bond, Die, DieGrey)

threshold (DieGrey, Wires, 0, 50)

fill_up_shape (Wires, WiresFilled, ’area’, 1, 100)
dev_display (Bond)

dev_set_draw (’fill’)

dev_set_color (’red’)

dev_display (WiresFilled)

stop ()

opening_circle (WiresFilled, Balls, 15.5)
dev_set_color (’green’)

dev_display (Balls)

stop O

connection (Balls, SingleBalls)

select_shape (SingleBalls, IntermediateBalls, ’circularity’, ’and’, 0.85, 1.0)
sort_region (IntermediateBalls, FinalBalls, ’first_point’, ’true’, ’column’)
dev_display (Bond)

dev_set_colored (12)

dev_display (FinalBalls)

stop O

smallest_circle (FinalBalls, Row, Column, Radius)
NumBalls := |Radius|

Diameter := 2*Radius

meanDiameter := sum(Diameter)/NumBalls
mimDiameter := min(Diameter)

dev_display (Bond)

disp_circle (WindowID, Row, Column, Radius)
dev_set_color (’white’)

set_font (WindowID, ’system26’)
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for i := 1 to NumBalls by 1
if (fmod(i,2)=1)
set_tposition (WindowID, Row[i-1]-1.5%Radius[i-1], Column[i-1]-60)
else
set_tposition (WindowID, Row[i-1]+2.5%Radius[i-1], Column[i-1]-60)
endif
write_string (WindowID, ’Diam: ’+Diameter[i-1])
endfor
dev_set_color (’green’)
dev_update_window (’on’)

Result
for returns 2 (HMSG_TRUE) if the evaluation of the expression yields no erratdfor (as
operator) always returns 2 (MSG_TRUE)

Parallelization Information
for is reentrant local, and processedithoutparallelization.

Alternatives
while
See Also
if, ifelse
Module

Basic operators

if ( : : Condition : )

Conditional statement.

if is a conditional statement. The condition contains a boolean expression. If the condition
is true, the body is executed. Otherwise the execution is continued at the first expression or
operator call that follows the correspondiegiif.

Parameter
> Condition (INPULCONLIOl) ... ... o i e integer integer
Condition for the if statement.
Default Value : 1
Result

if returns 2 (HMSG_TRUE) if the evaluation of the expression yields no errefidif (as
operators) always returns 2 (MSG_TRUE)

Parallelization Information
if is reentrant local, and processewithoutparallelization.

Alternatives
ifelse
See Also
for,while
Module

Basic operators
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ifelse ( : : Condition : )

Condition with alternative.

ifelse is a condition with an alternative. If the condition is true (i.e. not 0), all expressions
and calls between the head and operatarif are performed. If the condition is false (i.e. 0)
the part betweenlse andendif is executed. Note that the operator is cali€dlse and it is
displayed ad f in the program text area.

Parameter
> Condition (iInputcontrol) ... integer integer
Condition for the if statement.
Default Value : 1
Result

ifelse returns 2 (HMSG_TRUE) if the evaluation of the expression yields no eredrse and
endif (as operators) always return 2 (iISG_TRUE)

Parallelization Information
ifelse isreentrantlocal, and processewithoutparallelization.

Alternatives
if
See Also
for,while
Module
Basic operators
insert ( : : Input, Value, Index : Result )

Assignment of a value into a tuple.
insert assigns a single value into an tuple. If the first input parameter and the first output
parameter are identical, the call:

insert (Areas, Area, Radius-1, Areas)

is not presented in the program text as an operator call, but in the more intuitive form as:

Areas[Radius-1] := Area

Parameter

> Input (inputcontrol) ............ ..o, real(-array)~ reall integer / string
Tuple, where the new value has to be inserted.
Default Value : '[]

HALCON 6.0.4



130 APPENDIX A. CONTROL

> Value (inputcontrol) ........ ... real ~» reall integer / string
Value that has to be inserted.
Default Value : 1
Typical Range of Values :0 < Value < 1000000

> Index (INPULCONLIOL) .. .. e e integerinteger
Index position for new value.
Default Value : 0
Value Suggestions Index € {0, 1, 2, 3,4,5, 6
Minimal Value Step : 1

> Result (outputcontrol) ............. ... ... .L. real(-array)~ reall integer / string
Result tuple with inserted values.

Result
insert returns 2 (HMSG_TRUE) if the evaluation of the expression yields no error.

Parallelization Information
insert is reentrant local, and processewithoutparallelization.

Alternatives

assign

Module

Basic operators

stop (: : :)

Stop program execution.

stop stops the program execution of HDevelop. TH&is then placed at the program line
behindstop. The operator is equivalent the presing ghep button in the menu bar.

Attention

stop is not available in C++.

Example

read_image (Image, ’fabrik’)
regiongrowing (Image, Regions, 3, 3, 6, 100)
Number := |Regions|
dev_update_window (’off’)
for i := 1 to Number by 1
RegionSelected := Regions[il
dev_clear_window ()
dev_display (RegionSelected)
stop O
endfor

Result

stop always returns 2 (IMSG_TRUE)

Parallelization Information
stop is reentrant local, and processedithoutparallelization.
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See Also

exit

Module

Basic operators

while ( : : Condition : )

Continue to execute the body as long as the condition is true.

while executes the body as long as the condition is true. witi@e loop has a boolean ex-
pression as the conditional part. As long as itise (i.e. not equal 0), the body of the loop is
performed. In order to enter the loop, the condition has to be true in the first place.

Parameter

> Condition (iInputcontrol) ...........oo i integer integer
Condition for loop.

Example

dev_update_window (’off’)

dev_close_window ()

dev_open_window (0, 0, 512, 512, ’black’, WindowID)
read_image (Image, ’particle’)

dev_display (Image)

stop O

threshold (Image, Large, 110, 255)
dilation_circle (Large, LargeDilation, 7.5)
dev_display (Image)

dev_set_draw (’margin’)

dev_set_line_width (3)

dev_set_color (’green’)

dev_display (LargeDilation)

dev_set_draw (’fill’)

stop O

complement (LargeDilation, NotLarge)
reduce_domain (Image, NotLarge, ParticlesRed)
mean_image (ParticlesRed, Mean, 31, 31)
dyn_threshold (ParticlesRed, Mean, SmallRaw, 3, ’light’)
opening_circle (SmallRaw, Small, 2.5)
connection (Small, SmallConnection)
dev_display (Image)

dev_set_colored (12)

dev_display (SmallConnection)

stop ()

dev_set_color (’green’)

dev_display (Image)

dev_display (SmallConnection)

Button :=1
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while (Button = 1)
dev_set_color (’green’)
get_mbutton (WindowID, Row, Column, Button)
dev_display (Image)
dev_display (SmallConnection)
dev_set_color (’red’)
select_region_point (SmallConnection, SmallSingle, Row, Column)
dev_display (SmallSingle)
NumSingle := |SmallSingle]
if (NumSingle=1)
intensity (SmallSingle, Image, MeanGray, DeviationGray)
area_center (SmallSingle, Area, Row, Column)
dev_set_color (’yellow’)
set_tposition (WindowID, Row, Column)
write_string (WindowID, ’Area=’+Areat’, Int=’+MeanGray)
endif
endwhile
dev_set_line_width (1)
dev_update_window (’on’)

Result
while returns 2 (HMSG_TRUE) if the evaluation of the expression yields no eremdwhile
(as operator) always returns 2 (ASG_TRUE)

Parallelization Information
while is reentrant local, and processedithoutparallelization.

Alternatives
for
See Also
if, ifelse
Module

Basic operators
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dev_clear_obj ( Objects : : : )

Delete an iconic object from the HALCON database.

dev_clear_obj deletes iconic objects, which are no longer needed, from the HALCON
database. It should be noted thkiatr_clear obj cannot be exported to C++ due to the au-
tomatic memory management in C++.

Attention
Never useclear_obj to clear objects in HDevelop. The operatiiv_clear_obj has to be
used instead.

Parameter

> Objects (inputobject) ....... ... objeatray) ~» Hobject
Objects to be deleted.

Result
dev_clear_obj returns 2 (HMSG_TRUE) if the variable is instantiated. If necessary, an ex-
ception is raised.

Parallelization Information
dev_clear_obj islocal and processedompletely exclusivelyithout parallelization.

See Also
clear_obj, test_obj_def, dev_set_check, reset_obj_db

Module

Basic operators

dev_clear window ( : : : )

Clear the active graphics window.

dev_clear_window clears the graphics window content and the history of the active window.
Parameters assigned to this window (e.g. wiéh_set_color, dev_set_draw, etc.) remain
unmodified. The operator is equivalent to pressing@hear button of the active graphics
window. A graphics window can be activated by calltwy_set_window.
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Attention
If dev_clear _window should be used for exported Code (C++), please note the description of
clear _window due to the different semantics in C++.

Example

read_image (Image, ’fabrik’)
regiongrowing (Image, Regions, 3, 3, 6, 100)
Number := |Regions]|
dev_update_window (’off’)
for i := 1 to Number by 1
RegionSelected := Regions[il
dev_clear_window ()
dev_display (RegionSelected)
* stop O
endfor

Result
dev_clear_window always returns 2 (tMSG_TRUE).

Parallelization Information
dev_clear_window is local and processecompletely exclusivelyithout parallelization.

Possible Predecessor Functians
dev_set_window, dev_open_window, dev_display

Possible Successor Functions

dev_display

See Also
clear_window

Module
System
dev_close_inspect_ctrl ( : : Variable : )

Close an inspect window of a control variable.

dev_close_inspect_ctrl is the opposite operator tiev_inspect_ctrl, and closes the in-
spect window corresponding #ariable. The window can also be closed by pressing the
Close-button of the dialog.

Attention
This operator is not supported for exported C++ code.
Parameter.
> Variable (inputcontrol) .................... ... real(-array)~- reall integer / string

Name of the variable which inspect window has to be closed.
Example
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Var := 1

dev_inspect_ctrl (Var)

Var := [1,2,3,9,5,6,7,8]
Var[3] := 4

stop

dev_close_inspect_ctrl (Var)

Result
If an inspect window associated wittariable iS opendev_close_inspect_ctrl returns 2
(H.MSG_TRUE).

Parallelization Information
dev_close_inspect_ctrl is local and processedompletely exclusivelwithout paralleliza-
tion.

Possible Predecessor Functians

dev_inspect_ctrl
Module

Basic operators

dev_close_window ( : : : )

Close the active graphics window.

dev_close_window closes the active graphics window which has been opened by
dev_open_window or by HDevelop (default window). The operator is equivalent to press-
ing the Close button of the active window. A graphics window can be activated by calling
dev_set_window.

Attention

If dev_close window should be used for exported Code (C++), please note the description of
close_window due to the different semantics in C++.

Example

* close all windows
for i :=1 to 10 by 1
dev_close_window ()
endfor
read_image (For5, ’for5’)
get_image_pointerl (For5, Pointer, Type, Width, Height)
dev_open_window (0, O, Width, Height, ’black’, WindowHandle)
dev_display (Forb)

Result
dev_close_window always returns 2 (tMSG_TRUE).

Parallelization Information
dev_close_window is local and processecompletely exclusivekyithout parallelization.

Possible Predecessor Functions
dev_set_window, dev_open_window
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Possible Successor Functions

dev_open_window

See Also
close_window
Module
System
dev_display ( Object : : : )

Displays image objects in the current graphics window.

dev_display displays an image object (image, region, or XLD) in the active graphics window.
This is equivalent to a double click on an icon variable inside the variable window.
Attention

If dev_display should be used for exported Code (C++), please note the description of
disp-obj due to the different semantics in C++.

Parameter

> Object (INPULODJECE) ...t e objeatray) ~» Hobject
Image objects to be displayed.

read_image (Image, ’fabrik’)

regiongrowing (Image, Regions, 3, 3, 6, 100)
dev_clear_window ()

dev_display (Image)

dev_set_colored (12)

dev_set_draw (’margin’)

dev_display (Regions)

Result

dev_display always returns 2 (H(MSG_TRUE)

Parallelization Information
dev_display islocal and processecbmpletely exclusivehyithout parallelization.

Alternatives
disp_obj, disp_image, disp_region, disp_x1d
See Also
dev_set_color, dev_set_colored, dev_set_draw, dev_set_line_width
Module
System
dev_error_var ( : : ErrorVar, Mode : )

Define or undefine an error variable.

HDevelop, 2003-08-01



137

dev_error_var defines an error variable, i.e. a variable which contains the status of the last call
of an operatorErrorVar will be HMSG_TRUE (2) if no error had occured. The parameter
Mode specifies if the error variable should be used (1) or not (0). If an error variable is active it
will be updated each an operator excetion is finished. Thus a value is only valid until the next
call of an operator. The value can be saved by assigning it to another variable (see example) or
by callingdev_error_var (ErrorVar,0).

Attention
If dev_error_var should be used for exported Code (C++), please note the different handling
of return values in C++.

Parameter.
> ErrorVar (inputcontrol) .......... ..o inexg-array) ~ integer
Name of the variable which shall contain the error status.
> Mode (INnputCcoNtrol) . ... ... o e integerinteger
Switch the error variable on or off.
Default Value : 1
Value List : Mode € {0, 1}
Example

dev_close_window ()

dev_open_window (0, 0, 512, 512, ’black’, WindowHandle)
dev_error_var (Error, 1)

dev_set_check (’“give_error’)

FileName := ’wrong_name’
read_image (Image, FileName)
ReadError := Error

if (ReadError # H_MSG_TRUE)
write_string (WindowHandle, ’wrong file name: ’+FileName)
endif

Result
dev_error_var always returns 2 (HMSG_TRUE)

Parallelization Information
dev_error_var islocal and processecdompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_set_check

Possible Successor Functions
dev_set_check, if, ifelse, assign

See Also
set_check
Module
Basic operators
dev_inspect_ctrl ( : : Variable : )

Open a window to inspect a control variable.
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dev_inspect_ctrl opens a dialog to check the contents of a control variable. This dialog
has a scrolled list with all the values of the variable. In the case of an frame grabber handle
a specific dialog is opened which displays the most important frame grabber parameters and
can be used to switch the frame grabber only interactively. The contents of the dilaog will be
updated whenever the value(s) of variable changes. The update mode can influenced by the
operatodev_update_var. The dialog can be closed by pressingthese-button or by calling
dev_close_inspect_ctrl.

Attention
This operator is not supported for exported C++ code.
Parameter.
> Variable (inputcontrol) ....................... integ(-array) ~ integerl real / string

Name of the variable to be checked.

Example

read_image (Image, ’fabrik’)

regiongrowing (Image, Regions, 3, 3, 6, 100)
area_center (Regions, Area, Row, Column)
dev_inspect_ctrl (Area)

Result
dev_inspect_ctrl always returns 2 (lIMSG_TRUE)

Parallelization Information
dev_inspect_ctrl islocal and processecompletely exclusivelyithout parallelization.

See Also

dev_update_var
Module

Basic operators

devmap_par ( : : : )

Open the dialog to specify the display parameters.

dev_map_par opens the dialog which can also be accessed from the fignualization >
Set Parameters.... The dialog is used to configure the modes to display data like images,
regions, or polygons.

Attention
This operator is not supported for exported C++ code.

Example

read_image (Image, ’fabrik’)
threshold (Image, Region, 128, 255)
dev_map_par ()
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Result
dev_map_par always returns 2 (HMSG_TRUE)

Parallelization Information
dev_map_par islocal and processedompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_unmap_par
Module

Basic operators

devmap_prog ( : : : )

Make the main window of HDevelop visible.

dev_map_prog is used to map the main window of HDevelop after it has been unmapped by
dev_unmap_prog.

Attention
This operator is not supported for exported C++ code.

Depending on the operating system or the window manager the executiav @fap_prog
will result only in a visible icon of the window. In this case it has to be opened by the user with
mouse interaction.

Result
dev_map_prog always returns 2 (lIMSG_TRUE)

Parallelization Information
dev_map_prog is local and processecompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_unmap_prog

Possible Successor Functions

dev_unmap_prog
See Also

dev_map_par, dev_map_var
Module

Basic operators

devmap.-var ( : : : )

Map the variable window on the screen.

dev_map_var maps the variable window on the screen (i.e. makes it visible) that has been
unmapped usingev_unmap_var.

Attention
This operator is not supported for exported C++ code.

Result
dev_map_var always returns 2 (HMSG_TRUE)
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Parallelization Information
dev_map_var islocal and processecompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_unmap_var

Possible Successor Functions

dev_unmap_var

See Also
dev_map_par, dev_map_prog
Module
Basic operators
dev_open_window ( : : Row, Column, Width, Height, Background :

WindowHandle )

Open a graphics window.

dev_open_window opens a new graphics window, which can be used to perform output of gray
value data, regions, and graphics as well as to perform textual output. This new window auto-
matically becomes active, which means that all outpat(display and automatical display

of operator results) is redirected to this window. This is shown by the green dot kzthee

button.

In the case of the standard display operators (ik€p_image, disp_region, disp_line, etc.)
instead ofdev_display the logical window numbeiindowHandle has to be used.

The background of the created window is set to the color specifiBaldkground.

Pressing th€lear button clears the graphics window contents and the history of the window.
This can also be achived by using the operator_clear _window. You close a graphics win-
dow using theClose button of the window frame or by callindggv_close_window.

The the origin of the graphics window is the upper left corner with the coordinates (0,0). The x
values (column) increase from left to right, the y values increase from top to bottom. Normally,
the coordinate system of the graphics window corresponds to the the most recently displayed
image, which is automatically zoomed so that every pixel of the image is visible. The coordinate
system can be changed interactively using the marmwalization > Set Parameters ©

Zoom or with the operatodev_set_part. Every time an image with a different size is displayed,

the coordinate system will be adapted automatically.

Each window has a history which contains all

e objects and
e display parameters

which have been displayed or changed since the most recent clear action or display of a full
image. This history is used for redrawing the contents of the window. Other output like text or
general graphics likeisp_line or disp_circle or iconic data that is displayed using HAL-
CON operators likelisp_image or disp_region arenot part of the history, and aneot re-
drawn. Only the object classes image, region, and XLD that are displayed with the HDevelop
operatordev_display or by double clicking on an icon are part of the history.
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You may change the size of the graphics window interactively by “gripping” the window border
with the mouse. Then you can resize the window by dragging the mouse pointer. After this size
modification the window content is redisplayed. Now you see the same part of the window with
changed zoom.

If the mouse cursor is inside the window its look-up-table is reactivated. This is necessary
if other programs use their own look-up table. Thus if there is a “strange” graphics window
presentation, you may load the proper look-up table by placing the mouse inside the window.

Opening a window causes the assignment of a default font. It is used in connection with pro-
cedures likewrite_string and you may overwrite it by performinget_font after calling
dev_open_window. On the other hand you have the possibility to specify a default font by call-
ing set_system(’default_font’,<Fontname>) before opening a window (and all following
windows; see alsquery_font).

If you want to specify display parameters for a window you may select the menu item
Visualization in the menu bar. Here you can set the appropriate parameters by clicking
the desired item. Parameters which you have set in this way are usaitl 'ondows (in con-

trast to standard windows opened witben_window). The effects of the new parameters will

be applied direcly to thiast object of the window history and alter its parameters only.

Attention
Never use close window to close an HDevelop graphics window. The operator
dev_close_window has to be used instead.

If dev_open_window should be used for exported Code (C++), please note the description of
open_window due to the different semantics in C++.

Parameter

> Row (inputcontrol) ... rectangle.origin.y~ integer
Row index of upper left corner.
Default Value : 0
Typical Range of Values :0 < Row
Minimal Value Step : 1
Recommended Value Step 1
Restriction : Row > 0

> Column (inputcontrol) .......... ... . ... rectangle.origin.x~ integer
Column index of upper left corner.
Default Value : 0
Typical Range of Values :0 < Column
Minimal Value Step : 1
Recommended Value Step 1
Restriction : Column > 0

> Width (inputcontrol) ........ ... rectangle.extent.x-» integer
Width of the window.
Default Value : 256
Typical Range of Values :0 < Width
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Width > 0) V (Width = -1)
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> Height (inputcontrol) .......... ... rectangle.extent.yw» integer
Height of the window.
Default Value : 256
Typical Range of Values :0 < Height
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Height > 0) V (Height = -1)
> Background (inputcontrol) ........... ... ... integes integerl string
Color of the background of the new window.
Default Value : "black”

> WindowHandle (outputcontrol) ........... ... . i, windows integer
Window identifier.

Example

dev_close_window ()

read_image (For5, ’for5’)

get_image_pointerl (For5, Pointer, Type, Width, Height)
dev_open_window (0, O, Width, Height, ’black’, WindowHandle)
dev_display (For5)

dev_set_lut (’rainbow’)

dev_display (Forb)

stop O

dev_set_lut (’default’)

dev_display (For5)

stop O

dev_set_part (100, 100, 300, 300)

dev_display (Forb)

Result
If the values of the specified parameters are correet_open window returns 2
(H.MSG_TRUE). If necessary an exception handling is raised.

Parallelization Information
dev_open_window iS local and processedompletely exclusivelyithout parallelization.

Possible Successor Functions
dev_display, dev_set_lut, dev_set_color, dev_set_draw, dev_set_part

Alternatives
open_window
See Also
query_color
Module
System
dev_set_check ( : : Mode : )

Specify the error handling.
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dev_set_check specifies how HDevelop should react if an error occureidodt has the value
'give_error’ — which is the system default — HDevelop stops the program execution if an ex-
ception occures and displays an error message. If yotigise_error’ the exception will be
ignored and the program continuev_set_check is intended to be used in connection with
dev_error_var, which allows to check for the result state of an operator.

Attention
If dev_set_check should be used for exported Code (C++), please note the description of
set_check due to the different semantics in C++.

Parameter.
> Mode (INPULCONLIOl) ... o e e stringstring
Mode of error handling.
Default Value : 'give_error’
Example

dev_close_window ()
dev_open_window (0, 0, 512, 512, ’black’, WindowHandle)
dev_error_var (Error, 1)
dev_set_check (’“give_error’)
FileName := ’wrong_name’
read_image (Image, FileName)
dev_set_check (’give_error’)
ReadError := Error
if (ReadError # H_MSG_TRUE)
write_string (WindowHandle, ’wrong file name: ’+FileName)
endif
* Now the program will stop with an exception
read_image (Image, FileName)

Result
dev_set_check always returns 2 (HMSG_TRUE)

Parallelization Information
dev_set_check islocal and processecdompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_error_var

See Also
set_check

Module
System
dev_set_color ( : : ColorName : )
Set output color.

dev_set_color defines the color for region and line oriented output in the graphics windows.
The available colors can be queried with the operaigiry_color. The “colors” 'black’
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and 'white’ are available for all screens. If colors are used that are not displayable on the
screen, HALCON can choose a similar, displayable color of the output. Fors#tischeck
(’~color’) must be called.

The defined color is used unéibv_set_color or dev_set_colored is called.
Colors are defined for all graphics windows in contrast to the opesatorolor.

Attention
If dev_set_color should be used for exported Code (C++), please note the description of
set_color due to the different semantics in C++.

Parameter

> ColorName (INPULCONTIOl) . ... ..o e strirgrray) ~ string
Output color names.
Default Value : 'white’
Value Suggestions ColorName € {'white’, 'black’, 'gray’, red’, ‘'green’, 'blue’}

Example

read_image (Image, ’mreut’)
dev_set_draw(’fill’)
dev_set_color(’red’)
threshold(Image,Region, 180,255)
dev_set_color(’green’)
threshold(Image,Region,0,179)

Result
dev_set_color always returns 2 (HMSG_TRUE)

Parallelization Information
dev_set_color islocal and processedompletely exclusivelyithout parallelization.

Possible Predecessor Functians
dev_open_window, query_color, query_all_colors

Possible Successor Functions

dev_display

Alternatives
dev_set_colored
See Also
dev_set_draw, dev_set_line_width, set_color
Module
System
dev_set _colored ( : : NumColors : )

Set multiple output colors.

dev_set_colored allows the user to display a tuple of regions in different col@ditsnColors
defines the number of colors that are used. Valid valuesiaColors can be queried with
query_colored.
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Attention
If dev_set_colored should be used for exported Code (C++), please note the description of
set_colored due to the different semantics in C++.

Parameter

> NumColors (iInputcontrol) ... integer integer
Number of output colors.
Default Value : 6
Value List : NumColors € {3, 6,12

Example

read_image (Image, *monkey’)
threshold(Image,Region, 128,255)
dev_set_colored(6)
connection(Region,Regions)

Result
dev_set_colored always returns 2 (IMSG_TRUE)

Parallelization Information
dev_set_colored is local and processedompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_open_window

Possible Successor Functions

dev_display

Alternatives
dev_set_color
See Also
dev_set_draw, dev_set_line_width, set_colored
Module
System
dev_set draw ( : : DrawMode : )

Define the region fill mode.

dev_set_draw defines the region fill mode. frawMode is set to fill’, output regions are filled,
if set to 'margin’, only contours are displayed. It is used by region outputdikedisplay,
disp-region, disp_circle, disp_rectanglel, disp_rectangle2, disp_arrow, etc. If the
mode is 'margin’, the contour can be affecteddayr_set_line width, set_line approx and
set_line_style.

Attention
If dev_set_draw should be used for exported Code (C++), please note the description of
set_draw due to the different semantics in C++.
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Parameter

> DrawMode (INPULCONTION) . ..ot e string string
Fill mode for region output.
Default Value : "fill
Value List : DrawMode € {'fill', 'margin’ }

Example

read_image (Image, *monkey’)
threshold(Image,Region, 128,255)
dev_clear_window
dev_set_color(’red’)
dev_set_draw(’fill’)
dev_display(Region)
dev_set_color(’white’)
dev_set_draw(’margin’)
dev_display(Region)

Result
dev_set_draw always returns 2 (lIMSG_TRUE)

Parallelization Information
dev_set_draw is local and processecompletely exclusivelyithout parallelization.

Possible Successor Functions
dev_set_line_width, dev_display

See Also
set_draw

Module
System
dev_set_line width ( : : LineWidth : )

Define the line width for region contour output.
dev_set_line_width defines the line width (in pixel) in which a region contour or lines are
displayed (e.g. witldev_display, disp_region, disp_line, disp_polygon, €tc.).

Attention
If dev_set_line width should be used for exported Code (C++), please note the description
of set_line width due to the different semantics in C++.

Parameter

> LineWidth (inputcontrol) ...........c i i integer integer
Line width for region output in contour mode.
Default Value : 1
Restriction : LineWidth > 1

HDevelop, 2003-08-01



147

Example

read_image (Image, *monkey’)
threshold(Image,Region, 128,255)
dev_set_draw(’margin’)
dev_set_line_width(5)
dev_clear_window
dev_display(Region)

Result
dev_set_line_width always returns 2 (HMSG_TRUE)

Parallelization Information
dev_set_line_width islocal and processedompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_display

See Also
set_line_width, query_line_width

Module
System
dev_set_lut ( : : LutName : )

Set “look-up-table” (lut).

dev_set_lut sets look-up-table of the the output window. A look-up-table defines the transfor-
mation of a “gray value” within an image into a gray value or color on the screen. It describes
the screen gray value/color as a combination of red, green and blue for any image gray value
(0..255) (so it is a 'table’ to 'look up’ the screen gray value/color for each image gray value:
look-up-table). Transformation into screen-colors is performed in real-time at every time the
screen is displayed new (typically this happens about 60 - 70 times per second). So itis possible
to change the look-up-table to get a new look of images or regions. Please remind that not all
machines support changing the look-up-table (e.g. monochrome resp. truecolor).

For common monitors only one look-up-table can be loaded per screen. Wheveast _lut

can be activated separately for each window. There is the following solution for this problem:
It will always be activated the look-up-table that is assigned to the “active window” (a window
is set into the state “active” by placing the mouse inside the window).

look-up-tables can also be used with truecolor displays. In this case the look-up-table will be
simulated in software. This means, that the look-up-table will be used each time an image is
displayed.

query_lut lists the names of all look-up-tables.

Attention
If dev_set_1ut should be used for exported Code (C++), please note the descriptien.ait
due to the different semantics in C++.
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Parameter

> LutName (inputcontrol) ....... ... e string string
Name of look-up-table, values of look-up-table (RGB) or file name.
Default Value : 'default’
Value Suggestions LutName € {'default’, 'linear’, 'inverse’, 'sqr’, 'inv_sqr’, 'cube’,
'inv_cube’, 'sqgrt’, 'inv_sqrt’, ‘cubic_root’, ’inv_cubicroot’, 'colorl’, 'color2’, 'color3’,
‘colord’, 'three’, 'six’, 'twelfe’, 'twenty _four’, rainbow’, 'temperature’, 'cyclicgray’,
‘cyclic_temperature’, hsi’, ‘changel’, ‘change2’, 'changg3’

Example
read_image (Image, mreut’)
dev_set_lut(’inverse’)

* For true color only:
dev_display(Image)
Result

dev_set_lut always returns 2 (HMSG_TRUE)

Parallelization Information
dev_set_lut islocal and processecompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_display

See Also
set_lut

Module
System
dev_set_paint ( : : Mode : )

Define the grayvalue output mode.

dev_set_paint defines the output mode for grayvalue display in the graphics window. The
mode is used byev_display.

This page describes the different modes, that can be used for grayvalue output. It should be
noted, that the mode 'default’ is the most suitable.

A different way to display grayvalues is the histogram (mode: "histogram’). This mode has three
additional parameter values: Row (second value) and column (third value). They denote row
and column of the histogram center for positioning on the screen. The scale factor (fourth value)
determines the histogram size: a scale factor of 1 distinguishes 256 grayvalues, 2 distinguishes
128 grevalues, and so on. The four values are passed as a tuple, e.g. ['histogram’, 256,256,1]. If
only the first value is passed ('histogram’), the other values are set to defaults or the last values,
respectively. For histogram computation geey histo.

The modes ’line’ and 'column’ allow to display gray values along lines or columns, respecively.
The position (line- and columnindex) is passed with the second paramter value. The third
parameter value is the scale factor in percent (100 means 1 pixel per grayvalue, 50 means one
pixel per two grayvalues).
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Gray images can also be interpreted as 3d data, depending on the grayvalue. To view these 3d
plots, select the modes 'contourline’, '3D-plot’ or '3D-plbtdden’.

Paramters for modes that need more than one parameter can be passed the following ways:

e Only the name of the mode is passed: the defaults or the last values are used, respectively.
Example:dev_set_paint (’contourline’)

e All values are passed: all output characteristics can be set. Examiqpleset _paint
([’contourline’,10,1])

e Only the first n values are passed: only the passed values are changed. Example:
dev_set_paint ([’contourline’,10])

Attention
If dev_set_paint should be used for exported Code (C++), please note the description of
set_paint due to the different semantics in C++.

Parameter

> Mode (inputcontrol) ......... ... ... i striagray ~ string/ integer
Grevalue output name. Additional parameters possible.
Default Value : 'default’
Value List : Mode € {'default’, ’histogram’, ’line’, ‘column’, 'contourline’, '3D-plot’,
'3D-plot_hidden’, '3D-plotpoint’}

Example

read_image (Image,’fabrik’)
dev_set_paint(’3D-plot’)
dev_display(Image)

Parallelization Information
dev_set_paint islocal and processedompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_open_window

Possible Successor Functions

dev_set_color, dev_display

See Also
set_paint
Module
System
dev_set_part ( : : Rowl, Columnl, Row2, Column2 : )

Modify the displayed image patrt.

dev_set_part modifies the image part that is displayed in the graphics window.
(Row1,Columnl) denotes the upper left corner arkb§¢2,Column?) the lower right corner of
the image part to display.
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If Row1 is larger tharRow2 the zooming will be reset. That means that the last displayed image
will be completetly visible. Please note that this is not possible with the opesatapart
outside HDevelop.

Attention
If dev_set_part should be used for exported Code (C++), please note the description of
set_part due to the different semantics in C++.

Parameter

> Rowl (inputcontrol) ............ ... i rectangle.origin.y~ integer
Row of the upper left corner of the chosen image part.
Default Value : 0

> Columnl (inputcontrol) ......... .. ..ot rectangle.origin.x~ integer
Column of the upper left corner of the chosen image part.
Default Value : 0

> Row2 (INPULCONLIOl) ... ..o rectangle.corner.y~ integer
Row of the lower right corner of the chosen image part.
Default Value : 128

> Column2 (inputcontrol) ............ ... ..., rectangle.corner.x- integer
Column of the lower right corner of the chosen image part.
Default Value : 128

Example

read_image (Image, ’fabrik’)

for i := 1 to 240 by 10
dev_set_part (i, i, 511-i, 511-i)
dev_display (Image)

endfor

dev_set_part (1, 1, -1, -1)

dev_display (Image)

Result
dev_set_part always returns 2 (lIMSG_TRUE)

Parallelization Information
dev_set_part is local and processecompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_display

See Also
set_part
Module
System
dev_set_shape ( : : Shape : )

Define the region output shape.
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dev_set_shape defines the shape for region output. The output shape is useéevbyisplay
for regions. The available shapes can be queried quitlry_shape.

Available modes:

‘original’:  The shape is displayed unchanged. Nevertheless modifications via parameters like
dev_set_line_width can take place. This is also true for all other modes.

'outer_circle’: Each region is displayed by the smallest surrounding circle. (See
smallest_circle.)

'inner _circle’: Each region is displayed by the largest included circle. (S@er_circle.)

‘ellipse’: Each region is displayed by an ellipse with the same moments and orientation (See
elliptic_axis.)

'rectanglel’: Each region is displayed by the smallest surrounding rectangle parallel to the
coordinate axes. (Semallest_rectanglel.)

'rectangle2’: Each region is displayed by the smallest surrounding rectangle. (See
smallest_rectangle2.)

‘convex’: Each region is displayed by its convex hull (S#@pe_trans.)
'icon’ Each region is displayed by the icon set watt _icon in the center of gravity.

Attention
If dev_set_shape should be used for exported Code (C++), please note the description of
set_shape due to the different semantics in C++.

Parameter

> Shape (INnputcontrol) ... string string
Region output mode.
Default Value : ’original’
Value List : Shape € {’original’, ‘convex’, 'outer circle’, 'inner_circle’, rectanglel’,
rectangle2’, 'ellipse’, 'icon}

Example

read_image (Image, *monkey’)
threshold(Image,Region, 128,255)
connection(Region,Regions)
dev_set_shape(’rectanglel’)
dev_set_draw(’margin’)
dev_display(Regions)

Parallelization Information
dev_set_shape islocal and processedompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_display, dev_set_color
See Also

set_shape, dev_set_line width

Module

System
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dev_set _window ( : : WindowID : )

Activate a graphics window.

dev_set_window activates a graphics window. This is equivalent to pressingdthéve button
of the graphics window.

Attention
If dev_set_window should be used for exported Code (C++), please note the different handling
of windows in C++.

dev_set_window IS not supported for C++.
Parameter.

> WindowID (inputcontrol) ... window integer
Window.id.

Example

dev_open_window (1, 1, 200, 200, ’black’, WindowID1)
dev_open_window (1, 220, 200, 200, ’black’, WindowID2)
read_image (Image, *monkey’)

dev_set_window(WindowID1)

dev_display(Image)

dev_set_window(WindowID2)

dev_display(Image)

Parallelization Information
dev_set_window is local and processedompletely exclusivelyithout parallelization.

Possible Predecessor Functians

dev_open_window

Possible Successor Functions

dev_display
Module

Basic operators

dev_set_window_extents ( : : Row, Column, Width, Height : )

Change position and size of a graphics window.

dev_set_window_extents changes the position and/or the size of the currently active graphics
window.

The parameterBow andColumn specify the new position (upper left corner) of the window.

If one of both values is negative, the position will remain unchanged. The paramieteis
andHeight specify the new size of the window. This is the size of the inner part that actually
displayes the data. If one of the two values is negative, the size will remain unchanged.

Attention
Never useset_window_extents to change the size and position of an HDevelop graphics win-
dow. The operatodev_set_window_extents has to be used instead.
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Parameter

> Row (inputcontrol) ........ ... i rectangle.origin.y~ integer
Row index of upper left corner.
Default Value : 0
Typical Range of Values :0 < Row
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Row > 0) V (Row = -1)
> Column (inputcontrol) ..., rectangle.origin.x~ integer
Column index of upper left corner.
Default Value : 0
Typical Range of Values :0 < Column
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Column > 0) V (Column = -1)

> Width (inputcontrol) ........ ... i rectangle.extent.x-» integer
Width of the window.
Default Value : 256
Typical Range of Values :0 < Width
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Width > 0) V (Width = -1)
> Height (inputcontrol) ........... ... ... L. rectangle.extent.y~ integer
Height of the window.
Default Value : 256
Typical Range of Values :0 < Height
Minimal Value Step : 1
Recommended Value Step 1
Restriction : (Height > 0) V (Height = -1)
Example

dev_close_window ()

read_image (For5, ’forb5’)

get_image_pointerl (For5, Pointer, Type, Width, Height)
dev_open_window (0, O, Width, Height, ’black’, WindowHandle)
dev_display (For5)

stop O

dev_set_window_extents (-1,-1,Width/2,Height/2)

dev_display (Forb5)

stop O

dev_set_window_extents (200,200,-1,-1)

Result
If the values of the specified parameters are cortect set_window_extents returns 2
(H.MSG_TRUE). If necessary an exception handling is raised.

Parallelization Information
dev_set_window_extents IS local and processedompletely exclusivelyithout paralleliza-
tion.
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Possible Successor Functions
dev_display, dev_set_lut, dev_set_color, dev_set_draw, dev_set_part

See Also
set_window_extents

Module
System
dev_unmap.par ( : : : )

Hide the window for the graphic parameters.

dev_unmap_par hides the window for the graphic parameters so that it is no longer visible. It
can be mapped again using the operator map_par.

Attention
This operator is not supported for exported C++ code.

Result
dev_unmap_par always returns 2 (HMSG_TRUE)

Parallelization Information
dev_unmap_par islocal and processedompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_map_prog
See Also
dev_map_par, dev_map_prog, dev_map._var

Module

Basic operators

dev_unmap_prog ( : : : )

Hide the main window.

dev_unmap_prog hides the main window so that it is no longer visible. It can be mapped again
using the operataiev_map_prog.

Attention
This operator is not supported for exported C++ code.

Result
dev_unmap_prog always returns 2 (IMSG_TRUE)

Parallelization Information
dev_unmap_prog is local and processedompletely exclusivelyithout parallelization.

Possible Successor Functions

dev_map_prog, stop

See Also
dev_map_par, dev_map_prog, dev_map._var
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Module

Basic operators

dev_unmap.var ( : : : )

Hide the variable window.

dev_unmap_var hides the variable window so that it is no longer visible. It can be mapped again
using the operataiev_map_var.

Attention
This operator is not supported for exported C++ code.

Result
dev_unmap_var always returns 2 (tMSG_TRUE)

Parallelization Information
dev_unmap_var IS reentrant local, and processedithoutparallelization.

Possible Successor Functions

dev_map_var

See Also
dev_map_par, dev_map_prog
Module
Basic operators
dev_update_pc ( : : DisplayMode : )

Specify the behaviour of the PC during program execution.

dev_update_pc specifies the behaviour of the PC during program execution. In the mode 'on’

(default) the PC is always displayed in front of the current operator. In addition the program
text is scrolled — if necessary — so that the current operator is visible. In the mode 'off’ the PC
is not visible during program execution and the program text will not be scrolled automatically.

This option can also be controled by the dialog
File > Options > Update PC.

Attention
This operator is not supported for exported C++ code.
Parameter.
> DisplayMode (INPULCONLIOl) ... .o e string string

Mode for runtime behaviour.

Default Value : 'off’

Value List : DisplayMode € {’on’, 'off’ }
Result
dev_update_pc always returns 2 (HMSG_TRUE)

Parallelization Information
dev_update_pc IS reentrant local, and processedithoutparallelization.
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See Also
dev_update_time, dev_update_window, dev_update_var
Module
Basic operators
dev_update_time ( : : DisplayMode : )

Switch time measurement for operators on or off.
dev_update_time controls if the execution time of an operator has to be measured.
This option can also be controled by the dialog

File > Options > Show Processing Time.

Attention
This operator is not supported for exported C++ code.
Parameter.
> DisplayMode (INnputcontrol) ....... ... ... string string

Mode for graphic output.

Default Value : 'off’

Value List : DisplayMode € {'on’, 'off’ }
Result
dev_update_time always returns 2 (tMSG_TRUE)

Parallelization Information
dev_update_time is reentrant local, and processedithoutparallelization.

See Also
dev_update_pc, dev_update_window, dev_update_var
Module
Basic operators
dev_update_var ( : : DisplayMode : )

Specify the behaviour of the variable window during program execution.

dev_update_var specifies the behaviour of the variable window during program execution.
Using the mode 'on’ (default) the contents of the variable window (iconic and control variables)

is updated each time a variable is modified by the program. In the mode 'off’ the variables are
updated only when the execution is finished. Please not that update in this contents only means
the graphical representation of the internal values in the variable window.

This option can also be controled by the dialog
File > Options > Update Variables

Attention
This operator is not supported for exported C++ code.
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Parameter

> DisplayMode (INnputcontrol) ....... ... ... string string
Mode for graphic output.
Default Value : 'off’
Value List : DisplayMode € {’on’, 'off’ }

Result
dev_update_var always returns 2 (IMSG_TRUE)

Parallelization Information
dev_update_var is reentrant local, and processedithoutparallelization.

See Also
dev_update_pc, dev_update_window, dev_update_time
Module
Basic operators
dev_update_window ( : : DisplayMode : )

Specify the output behaviour during program execution.

dev_update_window Specifies the output behaviour during program execution. By default every
object (image, region, or XLD) is displayed in the active graphics window. This can be changed
by using the value 'off’ foDisplayMode. In this case objects are only displayed in single step
mode. Here one would use the operatev_display to output objects.

This option can also be controled by the dialog
File > Options > Update Window.

Attention
This operator is not supported for exported C++ code.
Parameter.
> DisplayMode (INPULCONLIOl) ... ... it e string string

Mode for graphic output.
Default Value : 'off’
Value List : DisplayMode € {’on’, 'off’ }

Result
dev_update_window always returns 2 (tMSG_TRUE)

Parallelization Information
dev_update_window IS reentrant local, and processedithoutparallelization.

Possible Successor Functions

dev_display

See Also
dev_update_pc, dev_update_var, dev_update_time

Module

Basic operators
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Appendix C

Glossary

Boolean is the type name for the truth valuesue andfalse as well as for the related boolean
expressions.

Body A body is part of a conditional instructionf) or a loop ¢hile or for) and consists of
a sequence of operator calls. If you considerfitee-loop, for instance, all operator calls,
that are located betweeinr andendfor form the body.

Button A button is part of a graphical user interface. With the mouse the user can press a
button to cause an action to be performed.

Control data Control data can be either numbefsfteger and Treal), character strings
(Tstring) and truth valuestpolean). This data can be used as atomic values (i.e.,
single values) or astuples (i.e., arrays of values).

Empty region An empty region contains no points at all, i.e., its area is zero.

Graphics window A graphics window is used itHDevelop for displayingimages, regions,
or TXLD.

HDevelop is an interactive program for the creation of HALCON applications.

Iconic data are image data, i.e., image arrays and data, which are described by coordinates and
are derived from image arrays, e.{regions,Jimage and XLD.

Image An image consists of one or more (multichannel image) image arrays drejesn
as the definition domain. All image arrays have the same dimension, but they can be of
different pixel types. The size of tHeegion is smaller or equal than the size of the image
arrays. Theregion determines all image points that should be processed.

Iconic object Generic implementation dficonic data in HALCON.

integer is the type name for integer numbers. Integers are implemented using the Geiygpe
(4 or 8 byte).

Operator data base The operator data base contains information about the HALCON opera-
tors. They are loaded at runtime from the binary file4HALCONROOT?%\help.

Program window In HDevelop the program window contains the program. It is used to edit
(copy, delete, and paste lines) and to run or debug the program.
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Operator window In the operator window of HDevelop the parameters of the selected opera-
tors can be entered or modified.

Real is the type name for floating point numbers. They are implemented using the C-type
double (8 bytes).

Region A region is a set of image points without gray values. A region can
be imagined as a binary image (mask). Regions are implemented using run-
length encoding. The region size is not limited to the image size (see also
set_system(’clip_region’,’true’/’false’) inthe HALCON reference manual.

String is the type name for character strings. A string starts and ends with a single quote; in
between any character can be used except single quote. The empty string consists of two
consecutive single quotes. The maximum length of a character string is limited to 1024
characters.

Tuple Atupleis an ordered multivalue set. In cas€ obntrol data a tuple can consist of a large
number of items with different data types. The term tuple is also used in conjunction with
Ticonic objects, if it is to be emphasized that sevérabnic objects will be used.

Type Ticonic variables can be assigned with data items of tjipeage, [region, and] XLD.
The types offcontrol data items can be onefafnteger, Treal, Tboolean, Or Jstring.

Variable window In HDevelop the variable window manages flo®ntrol andficonic data.

XLD is the short term forXtendedLine Description. It is used as a superclass for contours,
polygons, and lines (see also the HALCON Reference Manual).
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add_channels, 26, 29, 109
anisometry, 31
Applications,95
area_center, 29, 111
assign, 35, 37, 66, 67, 69, 123
Attributes,95

bin_threshold, 99
Boolean,159
Break,124

break, 35,81, 124
Break point22, 23, 48
Buffer, 140
Button,159

C, 1091

Compile,91

Export,1, 91

Link, 91
C++,1,12,83

Compile,84

Export,1, 83

Link, 84
Cleanup,16, 54
Clear,133
clear_obj, 121
Clearing,133
clip_region, 116
Closing,135
Code generatiorg83, 88, 91
Color,108
COM, 1, 88

Export,1
Comment125
comment, 23, 35, 38, 125
compactness, 30
concat_obj, 113
Condition,129
connect_and_holes, 30

Connected components)3 108

connection, 97, 103
contlength, 30

Control structures

ifelse, 80
Control datab4, 159
Control paramete61
Control structures35, 37, 79

break, 81

exit, 82

for, 80

if, 79

stop, 82

while, 80
Control-Variable 137
convexity, 30
cooc_feature_image, 31
cooc_feature_matrix, 31
Coordinate systen39
Coordinate-Systen, 40
count_obj, 103 113

Data structure$1, 62, 65
Database]l 33
dev_clear_obj, 40, 133
dev_clear_window, 39, 103 133
dev_close_inspect_ctrl, 40, 134
dev_close_window, 39
dev_close_window, 135
dev_display, 39, 136
dev_display, 93
dev_error_var, 41, 63, 86, 114, 136
dev_inspect_ctrl, 40, 137
dev_map_par, 40
dev_map_par, 138
dev_map_prog, 139
dev_map_prog, 40
dev_map_var, 40, 139
dev_open_window, 39
dev_open_window, 93
dev_open_window, 140
dev_set_check, 40, 63, 86, 114 142
dev_set_color, 39
dev_set_color, 143
dev_set_colored, 39, 144
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dev_set_draw, 39
dev_set_draw, 145
dev_set_line_width, 39
dev_set_line_width, 146
dev_set_lut, 39, 147
dev_set_paint, 39, 148
dev_set_part, 94
dev_set_part, 39, 149
dev_set_shape, 39, 150
dev_set_window, 39, 152
dev_set_window_extents, 39
dev_set_window_extents, 152
dev_unmap_par, 40, 154
dev_unmap_prog, 40, 154
dev_unmap_var, 155
dev_unmap_var, 40
dev_update_pc, 40, 155
dev_update_time, 40
dev_update_time, 156
dev_update_var, 40
dev_update_var, 156
dev_update_window, 40
dev_update_window, 157
Dilation, 108 115
Document analysi€5
dyn_threshold, 42
dyn_threshold, 101, 103

eccentricity, 30
Edit

Copy,19, 20

Cut, 19

Paste]19

Undo,19
Editor, 9
elliptic_axis, 30
elliptic_axis, 107
empty_obj, 113
Encapsulation115
entropy_gray, 30
Environment Variable

HALCONIMAGES, 15
Environment Variable

HALCONROOQT, 15
Error messagé€,20
Error-code 136
Example 61

Annual Rings,103

Board,107
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Calibration board106
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Devices, 107
Exception, 114
IC, 108
Medical,100
Region selectionl 12
Road scenel 14
Stamps95
Tissue particlesl00
Example sessior2,
Exception,136
Exception handling85, 90
Execute
Activate,23
Clear all break point®3
Clear break point23
Deactivate23
Reset progran®3, 65
Run,21-23
Set break point23
Step,22, 23
Stop,22, 23
Execution timel7
Exit, 125
exit, 35, 38,82 125

false, 63, 159
File, 111
Cleanup 16, 54
History, 18
Insert,12
Modules,18
New, 12, 13
Open,12 14
Options,12, 16
Print, 14
Print Selection14
Quit, 22
Read imagel5
Save,14
Save asl4, 17
fill up_shape, 105
Filter
Gaussian]101
Linear,98
Low pass]101
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Mean,101
Smoothing106
fnew_line, 111
for, 80
for, 35,92, 113 126 159
Frame Grabbe#0
fwrite_string, 111

gen grid region, 116
gen_region_line, 103
gen_tuple_const, 70
get_mbutton, 102
get_grayval, 114
get_image pointeri, 110
get_mposition, 114
get_system, 93
Gnuplot,111
Graphics 140, 152
Graphics window

Close,39

Position,39
Graphics windowg, 56, 93, 159

Activate, 39

Clear,25

Close,25

Color,32

Draw, 32

History, 58

Line width, 32

Look up table32, 35

Open,23, 38, 39

Paint,32, 33

Parameter38

Pen,33

Reset25

Size,31, 39

Zoom,31, 34
gray_histo, 27
gray_inside, 106

H_MSG_FAIL, 63, 85,114
H_MSG_FALSE, 63, 85
H_MSG_TRUE, 63, 85, 114
H_MSG_V0ID, 63, 85
Help,45

History, 58, 133 140

Iconic data,159
Iconic object54, 61, 112 159
Iconic-Object, 133
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if, 35,79, 128 159
ifelse, 35,80, 129
Image,54, 159
Image analysisf1
insert, 35, 37, 67, 69, 85, 129
Insertion cursor48
Inspection137
intensity, 30
Interaction,119
Internet Explorer120
Interpreter9
Intersection]110
intersection, 103

junctions_skeleton, 42

Keyboard shortcuts
<Ctrl> C, 20
<Ctrl> F, 20
<Ctrl> G, 20
<Ctrl> H, 21
<Ctrl> N, 12
<Ctrl> 0,12
<Ctrl> P, 14
<Ctrl> S, 14
<Ctrl> V, 19, 20
<Ctrl> Z,19
F5,21
F6, 22
F9, 22

Keycodes;119

Language definitiorg1

Laws filter,98

Loop, 37,126 131
Body, 159

Lut, 35

Main window,9, 10

Menu bar11

Title bar,11

Tool bar,47
mean_image, 99, 103
Memory managemen9,7
Menu bar,38
min_max_gray, 30
Miscellaneous]119
moments_gray_plane, 31
Mouse handling9

Netscape Navigatot,20
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Noise removal102

Notation
Decimal,62
Hexadecimal62
Octal,62

open_file, 111
Opening,102
Operation
Arithmetics,71
Boolean,75
Comparison75
String, 72
Trigonometric,76
Tuple,68
Operator
Data base]l59
Name field 50
Sequence43
Suggestions}2
Operator text field50

Operator window9, 47, 50, 52, 53, 160

Apply, 53

Cancel, 54

Enter, 53, 54

Help, 54

Input paramete1, 52

0K, 53, 54

Output parametefg1, 52
Optimization,84
orientation_region, 30

Output,16, 39

Paint mode33
Parallel HALCON,84, 91
Parameter displag0
Parameter expressiorgh
Parameter type$1
Preprocessingil
Program]12, 49
Counter,16, 22, 48
Execution21-23, 35
Termination 38
Program windowg, 48, 159
Programming95

Rapid prototyping9
read_image, 42
reduce_domain, 26, 29, 109 116
Region,54, 160
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Empty, 159
Region of interest] 09, 115
Reserved word<,9
reset_obj_db, 121
Restrictions82, 85, 89, 120
ROI, 116
Run, 2, 38
Run model7
Runtime error22, 86, 114

Segmentatiorf5, 97, 114

select_gray, 28

select_obj, 113

select_shape, 28, 97, 101, 103 107, 110,

112

Semantics6l

set_system, 93

Shell,2

skeleton, 42

smallest_rectanglel, 29

smallest_rectanglel, 97

smallest_rectangle2, 30

sobel _amp, 116

Status bar47

Step, 38

Stop,130

stop, 38

stop, 35, 82,130

String, 72, 160
Concatenatiorg6
Operationsy?2

Suggestion42
Alternative,43
Keyword,43
Predecessod2
See also43
Successo#3

Syntax,61

Termination,125

Texture,98

Texture energy99

texture_laws, 98

Threshold97, 99, 100 104, 106, 109 112,

115

threshold, 28,97, 109,116

true, 63, 159

Tuple,52, 56, 160
Arithmetic, 66
Concatenatiorg7, 68
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Type,54, 160
boolean, 63, 66, 75, 159
Control parametel, 62
Iconic object 61, 65
integer, 62
integer, 52, 65, 66, 72, 159
Numerical,62

real, 52,62, 65, 66, 72, 159, 160
string, 52, 62, 65, 66, 159 160

Tuple,52
UNIX, 2,14, 84,91

Variable,64
_, 64
Control,54, 56
Iconic, 40, 54, 55
Visualization,16
Variable window40
Variable window)9, 18, 54, 160
Visual Basic,12, 88
Export,88
Visualization
Line width, 39
Region,39
Regions 32
Segmentation result82
XLD, 32

watersheds, 42

while, 35,80, 93, 131, 159

Window, 133 135, 140, 152
Halcon,41
ID, 39

Window-size, 152

Windows 20002

Windows NT,2

Windows NT / 2000 / XP84, 91

XLD, 54,160
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